
HP Stitch S1000 126-in Printer

User Guide



© Copyright 2019–2021 HP Development 
Company, L.P.

Edition 4, July 2021

Legal notices

The information contained herein is subject to 
change without notice.

The only warranties for HP Products and 
services are set forth in the express warranty 
statement accompanying such products and 
services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not 
be liable for technical or editorial errors or 
omissions contained herein.

Safety notice

Read and follow the operating and safety 
instructions before starting the printer.

Trademarks

All products and company names are registered 
trademarks of their original owners. The use of 
any trademark is for identification and reference 
purposes only and does not imply any 
association between HP and the trademark 
owner or product brand.



Table of contents

1  Introduction ...............................................................................................................................................................................................  1

Welcome to your printer .........................................................................................................................................................  2

Documentation .........................................................................................................................................................................  2

Safety precautions ...................................................................................................................................................................  3

Disposal instructions .............................................................................................................................................................  12

General cleaning instructions ............................................................................................................................................... 12

Main components ................................................................................................................................................................... 14

Printer software .....................................................................................................................................................................  16

Turn on the printer for the first time ...................................................................................................................................  17

Turn the printer on and off ...................................................................................................................................................  17

Move the printer .....................................................................................................................................................................  18

Printer status beacon ............................................................................................................................................................  19

2  HP Internal Print Server ......................................................................................................................................................................... 20

Start the Internal Print Server ..............................................................................................................................................  21

Change the language of the Internal Print Server ............................................................................................................  22

Change the units of measurement in the Internal Print Server .....................................................................................  22

Set the Internal Print Server preferences ..........................................................................................................................  22

Internal Print Server menus .................................................................................................................................................  25

Printer status and alerts .......................................................................................................................................................  26

Update the firmware and the Internal Print Server ..........................................................................................................  27

3  RIP distribution ........................................................................................................................................................................................ 29

4  Printing workflows integration ............................................................................................................................................................. 30

Introduction to JDF ................................................................................................................................................................. 30

Working with JDF .................................................................................................................................................................... 30

5  Handle the substrate .............................................................................................................................................................................  36

Supported substrate types ................................................................................................................................................... 37

Supported HP substrates .....................................................................................................................................................  38

ENWW iii



Substrate tips .......................................................................................................................................................................... 39

Substrate configurations ......................................................................................................................................................  41

Prepare to print ......................................................................................................................................................................  42

The substrate edge holders .................................................................................................................................................  43

Load a roll onto the spindle ..................................................................................................................................................  45

Load a roll into the printer ....................................................................................................................................................  47

View information about the loaded substrate ..................................................................................................................  51

Unload a roll ............................................................................................................................................................................  51

Output platen light ................................................................................................................................................................. 52

Substrate presets ................................................................................................................................................................... 53

Export multiple presets ........................................................................................................................................................  53

Use a new substrate ..............................................................................................................................................................  55

Create a new substrate preset ............................................................................................................................................. 55

Edit a substrate preset ..........................................................................................................................................................  56

Remove a substrate preset ..................................................................................................................................................  60

Online substrate manager ....................................................................................................................................................  60

Set the carriage beam position ............................................................................................................................................ 63

6  Create and manage print jobs ..............................................................................................................................................................  64

Add a new print job ................................................................................................................................................................  65

Rotate a print job .................................................................................................................................................................... 69

Manage the print queue ........................................................................................................................................................  69

Delete a print job ....................................................................................................................................................................  70

Image composition ................................................................................................................................................................  71

7  Handle the ink system ...........................................................................................................................................................................  75

Ink system components ........................................................................................................................................................ 76

How to work with ink system components .......................................................................................................................  78

8  Printer calibration ...................................................................................................................................................................................  96

Align the printheads ............................................................................................................................................................... 97

Possible difficulties with printhead alignment ..................................................................................................................  99

Color calibration ...................................................................................................................................................................  101

Color consistency between different HP Stitch printers ................................................................................................ 103

Color emulation of other printer models .........................................................................................................................  103

Color profiles ........................................................................................................................................................................  105

Substrate-advance calibration ..........................................................................................................................................  107

Calibrations specific to one substrate preset ..................................................................................................................  109

Recommended calibrations after particular events ......................................................................................................  109

iv ENWW



9  HP Print Care ......................................................................................................................................................................................... 110

Print Care diagnostics .........................................................................................................................................................  111

10  Ink collector ........................................................................................................................................................................................  113

Use the ink collector ............................................................................................................................................................  114

Maintain the ink collector ...................................................................................................................................................  121

Troubleshooting for ink-collector-enabled substrates .................................................................................................  125

11  Dual-roll accessory ............................................................................................................................................................................ 126

12  Hardware maintenance ....................................................................................................................................................................  127

Safety precautions ..............................................................................................................................................................  128

Maintenance resources ....................................................................................................................................................... 128

Summary of maintenance operations and kits ..............................................................................................................  132

How to perform maintenance operations .......................................................................................................................  135

How to turn the printer off and on for maintenance operations .................................................................................  139

Weekly maintenance ........................................................................................................................................................... 141

80 liter maintenance ...........................................................................................................................................................  151

750 liter maintenance ......................................................................................................................................................... 173

1500 liter maintenance ......................................................................................................................................................  180

When required ...................................................................................................................................................................... 202

13  Troubleshoot substrate issues ........................................................................................................................................................ 240

Loading issues ...................................................................................................................................................................... 241

Printing issues ......................................................................................................................................................................  243

Print length issues ...............................................................................................................................................................  247

14  Troubleshoot print-quality issues ................................................................................................................................................... 249

General advice ......................................................................................................................................................................  250

What can affect print quality .............................................................................................................................................. 250

Print-quality troubleshooting ............................................................................................................................................  251

15  Troubleshoot ink cartridge and printhead issues ......................................................................................................................... 257

Ink cartridges ........................................................................................................................................................................ 258

Printheads ............................................................................................................................................................................. 258

Printhead cleaning roll errors ............................................................................................................................................  263

16  Troubleshoot other issues ...............................................................................................................................................................  264

The printer does not start ..................................................................................................................................................  265

The printer does not print ..................................................................................................................................................  265

ENWW v



The printer cannot be restarted from the Internal Print Server ................................................................................... 265

The printer seems slow ......................................................................................................................................................  265

Request to reinitialize the carriage ...................................................................................................................................  265

The Internal Print Server cannot detect the printer .......................................................................................................  266

Print Care spontaneously restarts ....................................................................................................................................  266

Color calibration fails ........................................................................................................................................................... 266

17  When you need help .........................................................................................................................................................................  267

HP Proactive Support ..........................................................................................................................................................  267

HP Customer Care ...............................................................................................................................................................  268

Service information .............................................................................................................................................................  268

18  Printer specifications ......................................................................................................................................................................... 270

Functional specifications ....................................................................................................................................................  271

Physical specifications ........................................................................................................................................................  271

Memory specifications for the Internal Print Server computer ....................................................................................  272

Power specifications ...........................................................................................................................................................  272

Air supply requirements (pneumatic spindle) .................................................................................................................  272

Ecological specifications .....................................................................................................................................................  273

Environmental specifications ............................................................................................................................................. 273

Acoustic specifications ........................................................................................................................................................  273

Appendix A  Printer messages ...............................................................................................................................................................  274

Appendix B  Summary of common sublimation problems ...............................................................................................................  278

Glossary .....................................................................................................................................................................................................  279

Index ...........................................................................................................................................................................................................  282

vi ENWW



1 Introduction

● Welcome to your printer

● Documentation

● Safety precautions

● Disposal instructions

● General cleaning instructions

● Main components

● Printer software

● Turn on the printer for the first time

● Turn the printer on and off

● Move the printer

● Printer status beacon

ENWW 1



Welcome to your printer
The HP Stitch S1000 126in Printer is a dye-sublimation inkjet printer designed for printing high-quality designs 
up to 3.2 m (126 in) wide. Some major features are:

● High quality output, with deep blacks and vivid colors, 1200 dpi native resolution, and 12 picoliter drop size

● Load either paper or fabric rolls up to 300 kg (661 lb)

● Accessible print-zone LED lighting and at-a-glance monitoring with beacon signals

● Long runs unattended with 10 L cartridges

● Prints completely dry and tightly wound, ready for calendering

● Prints on a wide range of paper (≥45 g/m²) and textiles (>90 g/m²)

● Consistent and repeatable print quality with the user-replaceable printheads and the smart nozzle 
compensation system

● Automatic maintenance to ensure nozzle health

● Optimal advance control with the new embedded substrate-advance sensor, capable of controlling even 
fabrics at high speed

● Unique drop-and-dry print-zone dryer to optimize paper control and drop placement

● Easy-to-use color management tools for enhanced color matching and consistency

● HP Print Care maintenance scheduler and proactive maintenance alerts

● Input and output spreader roller for unattended control of very-low-grammage paper tensioning

● Ink collector kit for reliable printing on porous fabrics such as flags

● Compatible with the dual-roll accessory

● Embedded smart aerosol-extraction channel to improve printer robustness

● It includes a contact heater to help dry the substrate.

Documentation
The following documents can be downloaded from http://www.hp.com/go/StitchS1000126in/manuals/:

● Site preparation guide

● Installation guide

● Introductory information

● User guide (this document)

● Legal information

● Limited warranty
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See the Solutions Web site for information about new substrates, at http://www.hp.com/go/StitchS1000126in/
support/. A new Web-based Media Solutions Locator (http://www.hp.com/go/mediasolutionslocator) has been 
developed to collect available substrate configurations for Stitch printers.

Safety precautions
Before using your printer, read the following safety precautions and operating instructions to make sure you use 
the equipment safely.

You are expected to have the appropriate technical training and experience necessary to be aware of hazards to 
which you may be exposed in performing a task, and to take appropriate measures to minimize the risks to 
yourself and to others.

Operations must be supervised at all times.

General safety guidelines

WARNING! The information provided by the printer status light is only for functional information purposes and 
is not related to any safety provision or safety states. Warning labels on the printer must be always considered 
when operating the printer and prevail against any of the status indicated by the printer status lights.

Turn off the printer, using the Branch Circuit Breakers located in the building’s Power Distribution Unit (PDU), and 
call your service representative (see HP Customer Care Centers on page 268) in any of the following cases:

● The power cord is damaged.

● The drying enclosure is damaged.

● The printer has been damaged by an impact.

● Liquid has entered the printer.

● There is smoke or an unusual smell coming from the printer.

● The printer's built-in Residual Current Circuit Breaker (Ground Fault Circuit Interrupter) has been repeatedly 
tripped.

● Fuses have blown.

● The printer is not operating normally.

● There is any mechanical or enclosure damage.

Turn off the printer using the Branch Circuit Breakers in either of the following cases:

● During a thunderstorm

● During a power failure

Take special care with zones marked with warning labels.

Electrical shock hazard

WARNING! The internal circuits and drying module operate at hazardous voltages capable of causing death or 
serious personal injury.

ENWW Safety precautions 3

http://www.hp.com/go/StitchS1000126in/support/
http://www.hp.com/go/StitchS1000126in/support/
http://www.hp.com/go/mediasolutionslocator


Turn off the printer using the Branch Circuit Breakers located in the building's Power Distribution Unit (PDU) 
before servicing the printer. The printer must be connected to earth at mains outlets only.

To avoid the risk of electric shock:

● Do not attempt to dismantle the drying module, contact heater, or e-cabinet during hardware maintenance 
tasks. In that case, follow the instructions strictly.

● Do not remove or open any other closed system covers or plugs.

● Do not insert objects through slots in the printer.

● Test the functionality of the Residual Circuit Breaker (RCCB) every year (refer to the procedure below).

NOTE: A blown fuse may indicate malfunctioning electrical circuits within the system. Call your service 
representative (see HP Customer Care Centers on page 268), and do not attempt to replace the fuse yourself.

Checking the functionality of the Residual Circuit Breakers (RCCBs)

Following standard Residual Current Circuit Breaker (RCCB) recommendations, it is recommended that the RCCBs 
are tested on a yearly basis. The procedure is as follows:

1. Turn off the built-in computer using the Internal Print Server’s Shutdown button (or, in Print Care, click 
Printer tools > Power options > Shutdown). Do not turn off the printer from the mains switch or the circuit 
breakers.

CAUTION: The shutdown process takes some time to complete. Wait until the green Power Enabled light 
is off before proceeding.

2. Once the computer is off, test that the RCCB works correctly by pressing the test button.

● If the RCCB does not trip when the test button is pressed, this indicates that it has failed. The RCCB 
must be replaced for safety reasons; call your service representative to remove and replace the RCCB.

● If the RCCB trips, this indicates it is working correctly; reset the RCCB to its normal on state.

Heat hazard

The drying system and the contact heater of the printer operate at high temperatures and can cause burns if 
touched. LED array supports, beam, and enclosures can reach high temperatures. To avoid the risk of burns, take 
the following precautions:

● Do not touch the contact heater during printer operation. Let the contact heater cool down before opening 
the vapors extraction channel / output cover.

● Take special care when accessing the substrate path.

● Take special care with zones marked with warning labels.

● Do not place objects covering LED arrays supports, beam, and enclosures.

● Do not attempt to modify LED array supports, beam, and enclosures;

● Remember to let the printer cool down before performing some maintenance operations.
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Fire hazard

The drying system and the contact heater of the printer operate at high temperatures. Call your service 
representative if the printer's built-in Residual Current Circuit Breaker (Ground Fault Circuit Interrupter) is 
repeatedly tripped.

To avoid the risk of fire, take the following precautions:

● Use the power supply voltage specified on the nameplate.

● Connect the power cords to dedicated lines, each protected by a branch circuit breaker as explained in the 
site preparation guide.

● Do not insert objects through slots in the printer.

● Take care not to spill liquid on the printer. After cleaning, make sure all components are dry before using 
the printer again.

● Do not use aerosol products that contain flammable gases inside or around the printer. Do not operate the 
printer in an explosive atmosphere.

● Do not block or cover the openings of the printer.

● Do not attempt to modify the drying module, contact heater, or e-cabinet.

● Ensure that the operating temperature of the substrate recommended by the manufacturer is not 
exceeded. If this information is not available, ask the manufacturer. Do not load substrates that cannot be 
used at an operating temperature above 125°C (257°F).

● Do not load substrates with auto-ignition temperatures below 250°C (482°F). See note below. No ignition 
sources are close to the substrate.

NOTE: Test method based on EN ISO 6942:2002; Evaluation of materials and material assemblies when 
exposed to a source of radiant heat, method B. The test conditions, to determine the temperature when 
the substrate starts ignition (either flame or glow) were: Heat flux density: 30 kW/m², Copper calorimeter, K 
type thermocouple.

● Proper maintenance and genuine HP consumables are required to ensure that the printer operates safely 
as designed. The use of non-HP consumibles (foams, filters, printhead cleaning roll, and inks) may present 
a risk of fire.

LED's array supports, beam and enclosures can reach high temperatures. To avoid the risk of fire, take the 
following precautions:

● Take special care with zones marked with warning labels.

● Do not place objects covering LED's arrays supports, beam and enclosures.

● Take care not to spill liquid on the accessory. After cleaning, make sure all components are dry before using 
the printer.

● Do not attempt to modify LED's array supports, beam and enclosures.
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Mechanical hazard

The printer has moving parts that could cause injury. To avoid personal injury, take the following precautions 
when working close to the printer:

● Keep your clothing and all parts of your body away from the printer's moving parts.

● Avoid wearing necklaces, bracelets and other hanging objects.

● If your hair is long, try to secure it so that it will not fall into the printer.

● Take care that sleeves or gloves do not get caught in the printer's moving parts.

● Avoid standing close to the fans, which could cause injury and could also affect print quality (by obstructing 
the air flow).

● Do not touch gears or moving rolls during printing.

● Do not operate the printer with covers bypassed.

● Take care when using the air gun. When used for cleaning purposes, make sure to use it according to the 
local regulations since additional safety provisions may apply.

● Take care when handling the vapors extraction channel / output cover: there is a risk of trapping your 
fingers. If you need to open or close it, handle it only from the center, hold it firmly, and move slowly.

WARNING! Be careful when you open the loading table, never leave it unattended with both latches in the open 
position: it may open inadvertently and cause serious injuries. Always check that both latches are properly 
closed.

WARNING! Wear protective gloves (PPE) when installing the ink collector.

Light radiation hazard

Light radiation is emitted from the illumination of the print zone. This illumination is in compliance with the 
requirements of the exempt group of IEC 62471:2006: Photobiological safety of lamps and lamp systems. 
However, you are recommended not to look directly at the LEDs while they are on. Do not modify the module.

Sound pressure level

Operating noise emissions measured in accordance with ISO 11202 at bystander positions do not exceed a 
sound pressure level of 70 dB(A).

Chemical hazard

See the safety data sheets available at http://www.hp.com/go/msds to identify the chemical ingredients of your 
consumables. Sufficient ventilation needs to be provided to ensure that potential airborne exposure to these 
substances is adequately controlled. Consult your usual air conditioning or EHS specialist for advice on the 
appropriate measures for your location.

For more detailed information, see the “Ventilation”, “Exhaust specifications” and “Air conditioning” sections in 
the site preparation guide, available at: http://www.hp.com/go/StitchS1000126in/manuals.
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Heavy substrate hazard

Special care must be taken to avoid personal injury when handling heavy substrates:

● Handling heavy substrate rolls always requires two people. Care must be taken to avoid back strain and/or 
injury.

● Always use a forklift, pallet truck, or other handling equipment to lift substrates. The printer has been 
designed to be compatible with many of these devices.

● Always wear personal protective equipment including boots and gloves.

Ink handling

HP recommends that you wear gloves when handling ink system components.

Ventilation

Fresh air ventilation is needed to maintain comfort levels. Ventilation should meet local environmental, health, 
and safety (EHS) guidelines and regulations. For some applications, a local exhaust is required as well. Please 
follow ventilation and local exhaust specifications defined in the Site Preparation Guide.

NOTE: The ventilation units should not blow air directly onto the printer.

Air conditioning

In addition to fresh air ventilation, to avoid health hazards, also consider maintaining workplace ambient levels 
by assuring the climatic operating conditions specified in this document (see Environmental specifications 
on page 273) to avoid operator's discomfort and equipment malfunction. Air conditioning in the work area 
should take into account that the equipment produces heat. Typically, the printer's power dissipation is 9.0 kW 
(30.7 kBTU/h).

Air conditioning should meet local environmental, health, and safety (EHS) guidelines and regulations.

NOTE: The air conditioning units should not blow air directly onto the printer.

Use of tools and keys

● Users: Daily operations including printer settings, printing, substrate loading, replacement of ink reservoirs, 
and daily checks. Do not require any tool or maintenance key.

● Maintenance personnel: Hardware maintenance tasks and replacement of printheads, filters, ink waste 
bottles, foams, and printhead cleaning roll. Require maintenance key, and flat screwdriver.

● Service personnel: Any repair or maintenance operation, running diagnostics, and troubleshooting. Require 
maintenance key, e-cabinet key, mains switch key, internal print server key, and Torx screwdriver set.
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Maintenance key E-cabinet key Mains switch key

Internal Print Server key Torx screwdriver set

 

NOTE: During the installation of the printer, the designated personnel receive training for the safe operation 
and maintenance of the printer. It is not allowed to use the printer without this training.

NOTE: After using the maintenance key to open a door, remember to lock it afterwards, and return the key to 
safe and secure storage.

Warnings and cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer 
from being damaged. Follow the instructions marked with these symbols.

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or 
death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or 
damage to the product.
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Warning labels

Label Explanation

Located on the e-cabinet.

Electric shock hazard

Heating modules operate at hazardous voltage. Disconnect power 
source before servicing.

Caution! Double pole. Neutral fusing. Refer servicing to qualified 
service personnel.

In case of operation of the fuse, parts of the printer that remain 
energized may represent a hazard during servicing. Turn off the 
printer using both Branch Circuit Breakers located in the building's 
Power Distribution Unit (PDU) before servicing.

Warning

High leakage current. Current leakage may exceed 3.5 mA. Earth 
connection essential before connecting supply. Equipment to be 
connected to earthed mains only.

See installation instructions before connecting to the supply. 
Ensure that the input voltage is within the printer's rated voltage 
range. The printer requires up to two dedicated lines, each 
protected by a branch circuit breaker according to site preparation 
requirements.

Read and follow the operating and safety instructions before 
starting the printer.

Located on each side of substrate path, close to PPS gear

Crush hazard. Do not touch PPS while moving. When substrate has 
been loaded, the carriage descends into its normal position, and 
could crush your hand or anything else left underneath it.

Located on each side of substrate path, and close to PPS gear

Risk of trapped fingers. Do not touch gears while moving. Danger 
that your hands may become trapped between gearwheels.

Located internally on substrate path, on printhead cleaning roll, and 
on vapors extraction channel / output cover; for maintenance/
service personnel only

Hazardous moving part. Keep away from moving carriage 
printhead. When printing, the printhead carriage travels back and 
forth across the substrate.
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Label Explanation

Located on the vapors extraction channel / output cover

Risk of burns.

Do not touch the internal enclosures of the contact heater and 
enclosures when accessing media path

Located on ink waste bottle and web wipe

You are recommended to wear gloves when handling ink cartridges, 
printhead cleaning cartridges and the printhead cleaning container.

Located internally on heating modules and electrical cabinets; for 
maintenance/service personnel only

Electric shock hazard. Disconnect power before servicing. Heating 
modules and electrical cabinets operate at hazardous voltage.

Located internally, close to vacuum fan blades and Dryer PCA 
cooling fan; for maintenance/service personnel only

Hazardous moving parts. Keep away from moving fan blades. 
Internal close to Vacuum Fan Blades and Dryer PCA cooling fan.

Located on the rear area of the carriage cover, below the hinges

Risk of cutting your fingers. Watch your fingers when closing the 
carriage cover.

Identifies the Protective Earth (PE) terminal for qualified electrician, 
and bonding terminals for maintenance/service personnel only. 
Earth connection essential before connecting supply.
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Label Explanation

Identifies the Protective Earth (PE) terminal for qualified electrician, 
and bonding terminals for maintenance/service personnel only. 
Earth connection essential before connecting supply.

Identifies the short-circuit breaking capacity of printer’s built-in 
supplementary circuit breakers beside mains input terminal, for 
qualified electrician and maintenance/service personnel only. Earth 
connection essential before connecting supply.

Emergency stop buttons

There are four emergency stop buttons distributed around the printer. If an emergency occurs, simply push one 
of the emergency stop buttons to stop all printing processes. A system error message is displayed, and the fans 
turn at maximum speed. Ensure that all emergency stop buttons are released before restarting the printer.

Two emergency stop buttons at the front

Two emergency stop buttons at the rear

For safety reasons, access to the print zone is not permitted while printing is in progress. Therefore, if the 
window or the loading table is opened, power to the carriage and to the drying module is disconnected. The print 
is cancelled and a system error may be displayed.

ENWW Safety precautions 11



Disposal instructions
HP provides many free and convenient ways to recycle your used original HP ink supplies. Additionally, HP 
provides a free program for business customers to return signage printed using selected recyclable HP large-
format substrates. For more information about these HP programs, see http://www.hp.com/recycle.

The following items for your printer can be recycled by the HP supplies recycling program:

● HP 618 Stitch S Series printheads

HP 638 10-liter Stitch Dye Sublimation Ink Cartridges for the HP Stitch S1000 printer should be disposed of 
following the instructions on the cartridge packaging. The ink back should be removed and disposed of in 
compliance with federal, state, and local regulations. The other ink-cartridge parts (plastic retainer and 
packaging box) can be recycled through commonly available recycling programs.

Dispose of the following in compliance with the federal, state, and local regulations:

● Aerosol filters

● Left spittoon

● Ink collector

● Printhead cleaning roll

● Waste bottle

● Extractor filter

Vapor Extraction Carbon filter

In order to provide a more comfortable working environment, this product includes a carbon filter with PN 
324P9A that should be replaced after a certain time to maintain optimal performance, refer to the product 
manual for more information. At end of life, the filter will be impregnated with vapors produced by the ink 
system. Disposal of the filter must be done according to local laws and regulations.

For correct disposal you can find useful information in the inks safety data sheet (SDS) at: 
http://www.hp.com/go/msds

General cleaning instructions
For general cleaning, a lint-free cloth dampened with distilled water is recommended. Then leave the cleaned 
part to dry or use a dry cloth to dry it more quickly.

Do not spray fluids directly onto the HP product. Spray the fluid onto the cloth used for cleaning.

To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral detergent, or a general-purpose 
industrial cleaner (such as the Simple Green industrial cleaner). Remove any remaining soap foam with a dry 
cloth.

For glass surfaces, HP recommends using a soft, lint-free cloth lightly moistened with a non-abrasive glass 
cleaner or with a general-purpose glass cleaner (such as the Simple Green glass cleaner). Remove any remaining 
soap foam with a lint-free cloth dampened with distilled water, and dry the glass with a dry cloth to prevent 
spotting.
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CAUTION: Do not use abrasives, acetone, benzene, sodium hydroxide, or carbon tetrachloride on glass: they 
can damage it. Do not place or spray liquid directly onto glass: the liquid could seep under the glass and damage 
the device.

HP recommends using a canister of compressed air to remove dust from electronic or electrical parts.

CAUTION: Do not use water-based cleaners on parts with electrical contacts: such cleaners could damage 
electrical circuits.

CAUTION: Do not use wax, alcohol, benzene, thinner, ammonia-based cleaners, or other chemical detergents, 
which could damage the product or the environment.

NOTE: In some locations the use of cleaning products is regulated. Ensure that your cleaning product follows 
federal, state, and local regulations.
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Main components
The following views of the printer illustrate the main components.

Front view

1. Ink cartridges

2. Emergency stop buttons

3. Front window for print-zone access

4. Built-in computer

5. Carriage cover

6. Printer status beacon

7. E-cabinet

8. Power switches, lights, and circuit breakers

9. Printhead cleaning roll door

10. Substrate output spindle

11. Vapors extraction channel / output cover

12. Spread roller

13. Aerosol extractor

14. Aerosol extractor exhaust

15. Contact heater

16. Vapor removal tube
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Rear view

1. Emergency stop buttons

2. Loading table latches, one on each side

3. Loading table

4. Drive roller

5. Substrate input spindle

6. Spread roller
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Carriage view

1. Aerosol filters

2. Printhead

3. Color printhead latch

Printer software
Your printer requires the following software:

● The HP Internal Print Server is provided with your printer and is already installed in the printer's built-in 
computer. It displays printer alerts and a summary of printer status, manages print jobs, and must be used 
to interact with the printer in various ways. See HP Internal Print Server on page 20.

● The HP Print Care program is provided with your printer and is already installed in the printer's built-in 
computer. It displays printer status and history in detail, and helps you to maintain the printer and solve any 
problems that may arise. See HP Print Care on page 110.

● A Raster Image Processor (RIP) should be run on a separate computer; it cannot be installed on the 
printer's built-in computer. It is not provided with the printer and should be obtained separately. The printer 
is JDF-enabled. If your RIP supports this interface, it can retrieve and display printer and job status.
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Turn on the printer for the first time
1. Make sure that the two bottom rows of circuit breakers at the front right of the printer are all in the up 

position.

2. Turn the main switch to the on position, and also turn on the computer switch beside it (labelled IPS).

3. Check that all three green lights are on. In normal operation these lights should always be on. If any of 
them are off, check the Internal Print Server in case there is a system error, and see Printer messages 
on page 274 or check with your electrician.

4. Wait for the Internal Print Server to tell you that the printer is waiting for rearm.

5. Perform a visual check of the printer.

6. Press the blue rearm button at the front right of the printer. This enables all of the printer's high-power 
subsystems.

7. Check that the printer-enabled green light turns on. In normal operation this light should always be on. If at 
any time you notice that this light is off, check the Internal Print Server in case there is a system error, and 
see Printer messages on page 274.

8. Wait for the Internal Print Server to indicate that the printer is ready. This can take several minutes. When 
initialization is complete, the Internal Print Server displays a Ready message. If a system error message is 
displayed, see Printer messages on page 274.

Turn the printer on and off
The printer has three power-off levels. Each of them goes deeper, until you reach complete shutdown at level 3.
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Level Turn off Turn on

1: Major power 
electronics and engine 
off.

Wait for the Internal Print Server to indicate that the 
printer is ready, then turn off the high-power 
subsystems by clicking the shutdown icon near the 
top left corner of the screen. Wait until the Internal 
Print Server reports that it has lost its connection to 
the printer.

NOTE: After the printer electronics have been 
turned off at the Internal Print Server, the fans turn at 
maximum speed for safety reasons. This is normal 
behavior and not a cause for concern.

Click the Wake Up button up in the top left corner of 
the Internal Print Server window, and wait for the 
printer to turn on the high-power systems.

When prompted, press the blue rearm button at the 
front right of the printer.

2: All printer systems off 
(recommended).

After completing level 1, turn off the main switch. The 
fans should stop.

After completing level 1, turn on the main switch, and 
ensure that the circuit breaker beside it is on.

When prompted, press the blue rearm button and 
wait for the Internal Print Server to announce that the 
printer is Ready.

3: All printer systems and 
Internal Print Server off.

After completing level 2, shut down the Internal Print 
Server from the Windows Start button, and wait until 
you see a black screen with the message No input 
signal.

CAUTION: The computer may be damaged if it is 
turned off incorrectly.

Once the Internal Print Server is completely off and 
you see No input signal on the screen, turn off the 
computer power switch.

After completing level 2, see Turn on the printer for 
the first time on page 17.

Move the printer
If you wish to move the printer a short distance on the same site, across a horizontal floor with no steps and no 
slopes of more than 3% inclination, see the following instructions. For more difficult movement operations, call 
your service representative (see HP Customer Care Centers on page 268).

CAUTION: Slopes steeper than 3% may cause serious damage to the printer.

1. Turn off the printer.

2. Disconnect all power and network cables from the printer.

3. Raise the feet gradually, applying two turns each time to each foot so that the wheels (A) touch the ground. 
To raise a foot:

a. Use a 24 mm (15/16 in) open end wrench to unlock the nut at the top of the foot.

b. Rotate the nut manually down the bolt. Leave about 2 cm (0.8 in) clearance at the bottom between 
nut and foot.

c. Use a 16 mm (5/8 in) open end wrench to rotate the foot upwards. Use the flat hexagonal faces at the 
bottom of the bolt to fit the wrench.

d. Raise the foot as far as the bolt allows.

e. Use the 24 mm (15/16 in) open end wrench to lock the nut again.
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CAUTION: Take care to raise the feet as high as you can. They may break if they touch the ground while 
the printer is in motion.

4. Push the printer from the outside corners of the main body. Remember to avoid slopes steeper than 3%.

5. Once the desired destination is reached, reverse the process described above to secure the printer in 
position.

After moving the printer, you may in some cases need an electrician to reconnect the power cables. You may 
also need to reconfigure the network, from the printer's built-in computer and from the RIP computer. See the 
Installation Guide for more details, including the minimum space required around the printer.

Printer status beacon
CAUTION: The information provided by the printer status beacon is for functional information purposes only, 
and is not related to any safety provision, or safety states. Warning labels on the printer must be always 
considered when operating the printer, and they prevail over any status indicated by the printer status beacon.

Printer status beacon colors mean:

Color Description

Red Unexpected printing interruption. A job that had started to print stopped unexpectedly and appears as Failed. 
Attention required.

An UI user confirmation appears in the IPS window. When attended to, the red color in the beacon changes to 
reflect the state of the printer.

Orange Warning alert present in the IPS

Green Idle

Printing
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2 HP Internal Print Server

● Start the Internal Print Server

● Change the language of the Internal Print Server

● Change the units of measurement in the Internal Print Server

● Set the Internal Print Server preferences

● Internal Print Server menus

● Printer status and alerts

● Update the firmware and the Internal Print Server
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Start the Internal Print Server
The Internal Print Server starts automatically with Windows, and runs continually, in the background if not in the 
foreground.

If for some reason it has stopped running, or its window is not visible, you can start it from the Windows Start 
menu or by double-clicking its icon on the desktop.

When it starts, the main screen appears.

In the main screen:

● You can shut down the printer by clicking the Shut down button at the top left.

● The top central pane shows the printer status and maintenance status. See Printer status and alerts 
on page 26.

● The warm-up button, marked with a red rectangle in the image above (below the thermometer icon), is 
used to manually turn on both the print zone dryers and the contact heater.

● The thermometer to the right of the status pane shows the temperature.

● To the right of the thermometer, you can see a summary of the status of the ink cartridges, the printheads, 
and the printhead cleaning roll.

● The Printing pane occupies most of the window, and includes:
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– The Print, Cancel, and Print adjustment buttons

– The job queue

– The print preview and job settings

● The Substrate pane includes the Substrate load/unload, Enable collector, and move carriage beam buttons; 
and information about how the current substrate is loaded.

Change the language of the Internal Print Server
When the Internal Print Server starts, it uses the language selected in the Windows Regional and Language 
Options. To change the selected language:

1. Open the Control Panel from the Start menu.

2. If you are using the Category View of the Control Panel, open the Clock, Language, and Region category.

3. Open the Regional and Language Options.

4. In the Formats tab, change the current format to correspond with the language you want.

5. Click the OK button.

The change takes effect when Windows is restarted.

Change the units of measurement in the Internal Print Server
To change the units of measurement in the Internal Print Server, click Tools > Preferences > Units. You can 
change the units of length and temperature.

Set the Internal Print Server preferences
To change the Internal Print Server's preferences, click Preferences from the Tools menu. In the Preferences 
window, you will see four tabs.
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General tab

● Units of length and temperature

● Remarks (to add as a footer to the printed file)

● Font of footer text

● Hot folder

● JMF connection url
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Queue Rules tab

● Action when job fails

● Action when job has been printed

● Action when job is removed from the queue

Additional Settings tab
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● Maximum roll length

● Gap between jobs

● Nesting gap between images

● Margins:

– RIP: Margins are set as defined in the RIP.

– Center: The image is horizontally centered on the loaded substrate.

– Default: The default margins are set to 5.0 mm (0.02 in). You can define the default left margin in the 
Job Properties window.

● Heating duration

Get QR code tab

Internal Print Server menus
The Internal Print Server provides the following menus.
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The File menu

● Add New Job

● Add Existing Job

● Edit Job

● Delete Job

● Exit

The Information menu

● Alerts

● Supplies

● Service information

The Printer menu

● Printing adjustments

● Printhead alignment

● Printhead cleaning

● Replace printheads

● Replace cleaning roll kit

● Advance calibration

● Enable/Disable collector

● Schedule printhead check and clean

The Substrate menu

● Load/Unload

● Settings

● Create

● Edit

● Clone

● Rename

● Remove

● Color calibration

● Presets management

● Search substrate online

● Substrate packages

The Tools menu

● Preferences

● HP Scitex Print Care

● HP Proactive Support

● Firmware update

● Wake up

● Shut down

● Reinitialize carriage

The Help menu

● About

● User's guide

● Contact HP

● HP remote control

Printer status and alerts
The Internal Print Server displays the general status of the printer, the maintenance status, the loaded substrate, 
and the ink system.

The printer can communicate the following types of alerts:

Printer status

● Errors: When the printer is unable to print.

● Warnings: When the printer needs attention for an adjustment, such as a calibration, preventive 
maintenance or ink cartridge replacement.

A summary list of printer alerts appears in the main window of the Internal Print Server. To display a more 
complete and detailed list, click Information > Alerts.

For more information about a particular alert, see Printer messages on page 274.
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Maintenance status

● Green light: No maintenance is needed.

● Yellow light: Maintenance procedure date is approaching. Click the yellow button to check Print Care for 
details. See HP Print Care on page 110.

● Orange light: Maintenance is required. Click the orange button to check Print Care for details.

● Red light: Maintenance is required urgently. Click the red button to check Print Care for details.

● Grayed out: Print Care is not running. Click the orange button.

Update the firmware and the Internal Print Server
TIP: When updating the firmware and the Internal Print Server, first update the firmware and then the Internal 
Print Server.

Update the firmware

From time to time firmware updates will be available from HP that increase the printer's functionality and 
enhance its features.

Firmware updates can be downloaded from the Internet and installed in your printer using the Internal Print 
Server: click Firmware update from the Tools menu.

Follow the instructions on your screen to download the firmware file and store it on your hard disk. Then select 
the downloaded file and click Update.

The firmware includes a set of the most commonly used substrate presets. Extra substrate presets can be 
downloaded separately; see Substrate presets on page 53.

Update the Internal Print Server

IMPORTANT: Remove the previous version of the Internal Print Server in the printer's built-in computer before 
installing the new version.

1. Remove the current version of the Internal Print Server through the control panel. Click Uninstall Internal 
Print Server Application (this deletes any current job in the queue, but not ripped files).

2. Download the file to the built-in computer's hard disk (but not to the desktop).
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3. Unzip/extract the files HPIPS.msi and Setup.exe.

4. Run the file Setup.exe and follow the onscreen instructions until the new software is installed.

Update the HP IPS Services

IMPORTANT: Remove the previous version of the Internal Print Server in the printer's built-in computer before 
installing the new version.

1. Remove the current version of the Internal Print Server through the control panel. Click Uninstall Internal 
Print Server Application.

2. Download the file to the built-in computer's hard disk (but not to the desktop).

3. Unzip/extract the files HPIPSServices.msi and Setup.exe.

4. Run the file Setup.exe and follow the onscreen instructions until the new software is installed.
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3 RIP distribution

HP RIP Certification differentiates the RIP partners who reach a specific and superior level of integration, 
compatibility, and performance with the printer.

HP has increased the functionalities and RIPs certified for the printer.

The compatibility support matrix below presents the certified RIP partners and versions. As well as the different 
functionalities supported by each specific RIP partner, all certified RIP partners support, at least, all the 
mandatory functionalities.

 Ergosoft Caldera 12+ Onyx 18.5+ Neostampa

HP Easy Color Profiling Yes Yes No Yes

HP Professional PANTONE Emulation Yes Yes Yes No

Configuration Center Web-based: not RIP-dependent
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4 Printing workflows integration

Introduction to JDF

What is JDF?

JDF is a software method by which devices from a variety of vendors and manufacturers can interoperate 
together. It uses a text-based language known as XML that is compliant with many devices and workflow 
controllers in varying vertical print markets.

JDF implementation is typically based upon an MIS system to be used for job scheduling, submission, 
accounting, and costing. An integrator typically interfaces an MIS system to the devices that are present in a 
workflow through JDF technology.

JMF is a communication protocol (based upon the JDF specification) that allows devices to communicate job 
status information and other real-time job metrics and parameters. It can be used to poll a device for status or to 
watch a device at regular intervals.

Benefits of working with JDF for file submission

JDF can be useful in providing an accurate MIS-driven way to know the job status of content as well as when a 
device has completed a job. Since the role of an MIS is to track, schedule and cost-account for a job, JDF/JMF 
allows for a simple way to interface devices to an MIS for this task.

JDF and JMF can be used to be able to analyze and later perform accounting principles upon work created in a 
JDF workflow. A detailed analysis can be performed after a day or series of jobs to see the profit margin of a job, 
the costs and materials consumed, as well as inventory control and stock consignment.

HP is a partner member of the CIP4 organization, and you can obtain many more details about JDF at the CIP4 
www site at http://www.cip4.org.

Working with JDF

Creating JDF job tickets

JDF Implementations typically use an MIS system to control and monitor a JDF/JMF workflow. The MIS can then 
monitor a device’s status, can track time and consumables and provide interfacing with counting and inventory 
control modules integrated into an MIS. An MIS is typically the origin of a JDF job and resultant ticket. JMF 
communication can be used to send that ticket information to production milestones. An MIS is typically the 
origin of a JDF job and resultant ticket. JMF communication can be used to send that ticket information to 
production milestones.
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What information is captured by the printer, and what can be communicated by JMF to 
an MIS?

The printer implements a subset of the JDF 1.5 specification, using JMF. This allows it to communicate printer-
status, and notifications together with job status, job ink, and substrate consumption to external applications.

NOTE: It is important to consider the fact that the RIP is capable of combining several jobs into one for the 
purpose of substrate optimization, and finishing. In this example, the printer sees the print as one job. In this 
situation, the MIS should query the RIP for the status of each individual job on the nest.

The RIP application can retrieve substrate and consumable tracking to report back to MIS.

Guidelines for integration

How to integrate the printer into the Caldera RIP

The Caldera RIP can take advantage of the JDF interface in the printer by selecting the option in the printer driver 
setup. Once the JDF interface is enabled, the RIP will display printer status and notifications together with job 
status, and job ink and substrate consumption.

In order to activate this functionality in the Caldera RIP, you need to enter the printer's JMF URL into the JDF area 
of the printer configuration dialog (IPS URL). Make sure you have the latest driver available from the Caldera 
website.

Once configured, you can display the printer status by opening the info window in the print client, and opening 
the spooler for the job status.
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To obtain the JMF URL: In the printer’s Internal Print Server, click Tools > Preferences > General.

If there are problems using the printer’s hostname, switch to the printer’s IP using the printer’s system 
configuration tool. For more details, see the service manual or talk to your network administrator to solve 
hostname resolution.

How to integrate the printer into the Onyx RIP

Onyx can take advantage of the JDF interface in the printer by selecting the option in the printer driver setup. 
Once the JDF interface is enabled, the RIP will display printer status and notifications together with job status 
and job ink and substrate consumption.

In order to activate this functionality in the Onyx RIP, you need to type the printer's JMF url in the JDF area of the 
printer configuration dialog (JDF URL). Ensure that you have the latest driver version from the Onyx Download 
manager.
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Once configured, you can display the printer and job status opening the info window in the RIP queue.

To obtain the JMF URL: In the printer’s Internal Print Server, click Tools > Preferences > General.
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If there are problems using the printer’s hostname, switch to the printer’s IP using the printer’s system 
configuration tool. For more details, see the service manual or talk to your network administrator to solve 
hostname resolution.

Job submission methods

The printer supports two file submission methods (in addition to open a file directly in HP IPS UI):

In the Internal Print Server, click Tools > Preferences > General, and select the submission method from the 
Submit method drop-down list.

● Hot folder: Select a shared folder on the computer’s hard disk; the RIP copies the output job there, and the 
Internal Print Server automatically loads jobs into the queue.
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NOTE: The shared folder should be the same as the one configured in the RIP.

● JMF: The RIP sends the location of the job via a JMF command and the IPS automatically looks for the files 
there and loads them directly into the printer queue.

● Not specify: Load the file manually in the IPS File > Open.

You can remove a job from the Internal Print Server or printer queue directly from the RIP interface, but only if it 
was submitted using the JMF method.

How to integrate the printer into an MIS system or production control software

Specific RIP/MIS implementations will require vendor specific configurations.

MIS or Production Control Software applications can retrieve printer status and notifications together with job 
status and job ink and substrate consumption, from the printer via the HP JDF/JMF Interface. It is also possible to 
remove a job in the printer queue via the HP JDF/JMF Interface.

As explained in the previous section, if the RIP combines several jobs into one before sending it to the printer, the 
recommendation is to connect the MIS or Production Control software to the RIP instead of the IPS in order to get 
the grouped jobs’ individual job status.

Be sure to assign unique names to each job in order to identify them in the information gathered from the 
printer.

If you are using the Caldera 12 RIP, the MIS can communicate using the Caldera Nexio module. Caldera Nexio is a 
tool that connects the Caldera RIP and other third-party software using standard JDF/JMF protocols, making it 
possible to produce automatic sequences of actions that speed up production and advanced reports to improve 
operations. Please contact Caldera for further information.

Onyx customers wishing to integrate with MIS solutions can use the Onyx Connect module to communicate via 
JDF. Onyx Connect does not currently support JMF. Please contact Onyx for further information.

If you are using another RIP solution, please contact your specific RIP vendor for JDF/JMF configuration and 
interface guidelines.

MIS vendors or customers that would like to integrate the printer with a solution directly, can obtain the HP 
specifically supported JDF Software Development Kit from the HP Solutions Portal: https://developers.hp.com/
lfp-enroll.
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5 Handle the substrate

● Supported substrate types

● Supported HP substrates

● Substrate tips

● Substrate configurations

● Prepare to print

● The substrate edge holders

● Load a roll onto the spindle

● Load a roll into the printer

● View information about the loaded substrate

● Unload a roll

● Output platen light

● Substrate presets

● Export multiple presets

● Use a new substrate

● Create a new substrate preset

● Edit a substrate preset

● Remove a substrate preset

● Online substrate manager

● Set the carriage beam position
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Supported substrate types
The following substrate types are compatible with your printer. For specific substrate settings and profiles, see 
Online substrate manager on page 60.

Paper

● Generic high ink density

● Generic high-weight paper

● Generic medium-weight paper

● Generic low-weight paper

● Generic backlit paper

● Generic >110 g/m² paper

● Generic 45–70 g/m² paper

Textile

To check the porosity of your substrate, see Check the porosity of your substrate on page 37.

● Generic backlit fabric

● Generic bleed-through fabric

● Generic frontlit fabric

Check the porosity of your substrate

1. If the printer has any substrate loaded, unload it.

2. Cut a piece of self-adhesive vinyl white gloss, 15 × 50 mm (0.6 × 2 in) in size.

3. Stick it to the platen, covering the substrate-advance sensor.

4. Load the substrate that you want to check.

5. Open your RIP software.

6. Obtain the test file from the printer’s built-in computer.

7. Print the test file using the number of passes and substrate preset that you intend to use in future with this 
substrate (or a similar profile in terms of ink limit).

8. Unload the substrate.

9. Remove the strip of self-adhesive vinyl from the platen.

10. Look at the self-adhesive vinyl you have taken from the platen.

If the strip is completely white (has no ink on it), the tested substrate is non-porous and may be used for 
printing as described in this guide.

11. Clean the print zone, see Clean the print zone and the substrate edge holders on page 143.
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Supported HP substrates
Portfolio summary for AMS

HP name Main characteristics
Product 
category Sizes Key vertical

HP Stitch S Series 70 g/m² 
Sublimation Paper

 

High ink coverage

Ideal for knitted and stretchy fabrics

70 g/m²

High speed

Medium weight

44 in × 575 ft

64 in × 575 ft

HP Stitch S Series 
Lightweight 56 g/m² 
Sublimation Paper

 

Low grammage for low transportation cost

Starting with 56 g/m², then new 45 g/m²

High speed

Light weight

64 in × 1640 ft (500 m) 
for S500

64 in × 656 ft (200 m) 
for S300

HP Stitch S Series Tacky 
95 g/m² Sublimation Paper

 

Tacky

High ink coverage

Ideal for sportswear

95 g/m²

Tacky

High weight

44 in × 500 ft

64 in × 500 ft

Portfolio summary for EMEA

HP name Main characteristics
Product 
category Sizes Key vertical

HP Stitch S Series 105 g/m² 
Sublimation Paper

 

High ink coverage

Ideal for knitted and stretchy fabrics

105 g/m²

High speed

High weight

1320 mm × 110 m

1620 mm × 110 m

HP Stitch S Series 
Lightweight 45 g/m² 
Sublimation Paper

 

Low grammage for low transportation cost

45 g/m²

High speed

Light weight

1620 mm × 500 m for 
S500

1620 mm × 250 m for 
S300

HP Stitch S Series Tacky 
105 g/m² Sublimation Paper

 

Tacky

High ink coverage

Ideal for sportswear

105 g/m²

Tacky

High weight

1320 mm × 120 m

1620 mm × 100 m
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Application categories

1. Sportswear (95 g/m² and 105 g/m² Tacky)

2. Fashion (45 and 56 g/m²)

3. Soft signage (70 and 95 g/m², and 105 g/m² soft signage)

4. Household (70 g/m²)

HP trademark code FSC CO17543. See http://fsc.org.

Some recyclable HP substrates can be recycled through commonly available recycling programs. 
Recycling programs may not exist in your area. See http://www.hp.com/recycle/ for details.

Substrate tips

Maintain the substrates

Keep substrates in their sealed wrapping material while they are in storage, and store rolls vertically to avoid the 
migration of plasticizers in some materials.

Move substrates from the storage area to the print production area at least 24 hours before use, so that they 
can adapt to its temperature and humidity.

General tips

Handle unprinted and printed substrates with care, and preferably with cotton gloves, to avoid fingerprints. For 
heavy rolls, use a forklift, and two people wearing security shoes.

Before loading a roll:

● Check that temperature and humidity in the room are within the recommended ranges for the printer. See 
Environmental specifications on page 273.

● Check that neither the roll nor its core are bent or deformed, which may cause the substrate to jam in the 
printer.

● If the roll has been stored in a place not offering the recommended environmental conditions, allow some 
time for it to adapt to the temperature and humidity of the printer's environment.

● Check which is the correct side for printing, by reading the label inside the core or the note inserted into the 
package.

● Check that the substrate is correctly attached to the input core. Otherwise, the Internal Print Server will 
report an error.

● Check the substrate thickness:

ENWW Substrate tips 39

http://fsc.org
http://www.hp.com/recycle/


– Up to 0.4 mm (0.016 in): Print normally.

– 0.4 to 2 mm (0.016 to 0.079 in): Raise the carriage beam to a custom position. Edge holders are not 
needed and should not be used.

– More than 2 mm (0.079 in): Not supported.

While loading a roll, ensure that the leading edge is parallel and straight across the output core, and attached 
evenly (start taping the substrate to the core at the center, then move towards the edges).

Also ensure that the side edges of the input and output roll are properly aligned. An incorrectly loaded roll may 
cause waves or cockles in the substrate, leading to ink smearing and printhead crashes.

After you have loaded a roll:

● If you intend to use substrate edge holders, do not use edge holders from another printer, use only the 
edge holders that came with your printer.

● Check the correct carriage beam position for printing: customized position for thick substrates, printing 
position for others. See Set the carriage beam position on page 63.

● Check that you are using the correct substrate preset in the Internal Print Server and the correct ICC profile 
and other settings in the RIP.

● HP substrates are optimized to provide the best out-of-the-box printing experience with your printer.

● Use the Internal Print Server to check that any calibrations appropriate for your substrate have been done: 
printhead alignment, color calibration. See Printer calibration on page 96.

● Do not cut off pieces of substrate while the substrate is loaded into the printer. This may cause the 
remaining substrate to jam.

For the latest ICC profiles and substrate presets, see http://www.hp.com/go/mediasolutionslocator.

Color consistency

Your printer has been designed to provide an excellent experience in terms of color consistency and 
repeatability. This allows large jobs such as fleet graphics and wall coverings to be printed in tiles or panels, with 
confidence that, when the finished panels are placed edge to edge, the colors will match at the joins.

The color variation within a printed job has been measured to be within this limit:

Maximum color difference (95% of colors) <= 2 dE 2000

NOTE: This is based on reflective measurements on a 943 color target under CIE standard illuminant D50, and 
according to the standard CIEDE 2000 as per CIE Draft Standard DS 014-6/E:2012. 5% of colors may experience 
variations above 2 dE 2000. Backlit substrates measured in transmission mode may yield different results.

Color matching is dependent on many external factors. Take the following points into account to achieve this 
level of consistency:

● If a large job is being printed in panels, more than one roll may be required. All rolls should be from the 
same batch, and stored under correct conditions according to the manufacturer’s specifications.

● Operating conditions (temperature and humidity) should be kept constant during the printing of the entire 
job.

● Ensure that a printhead check and clean routine has been run prior to starting the job. If any printhead 
changes are required during the job, printhead alignment and color calibration should be done.
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See also Color calibration on page 101.

Substrate configurations
The substrate can be loaded in a variety of different configurations to suit your different needs. Before loading, 
you must go to the Internal Print Server and click Substrate load/unload, then select the configuration you intend 
to use.

You can also start to load the substrate and start the load process by pressing the corresponding button at the 
input side of the printer.

Once the substrate is loaded and the substrate has been selected, the contact heater and the printing zone dryer 
will begin to heat up automatically until the standby temperature is reached. The standby temperature will be 
maintained for a default time of 30 minutes before switching off automatically if there is no printer activity. This 
time can be modified in the printer preferences.

The physical button is permitted when its light is on.
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The basic printer configuration is roll-to-roll.

Prepare to print
The following steps must be followed before the printer can print:

1. Go to the Internal Print Server and click Substrate Load/Unload to open the Printer Configuration window or 
start the loading process by pressing the physical button.
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2. Select the printer configuration that you intend to use; the on-screen help will appear on the left.

NOTE: The Reload substrate check box should be checked only if the printer has just previously had the 
same configuration (the same substrate and same profile), and because of a severe system error, you had 
to restart the printer.

3. Load the substrate. Substrate loading instructions are displayed in the Internal Print Server window. For 
more detailed instructions, see Load a roll onto the spindle on page 45 and Load a roll into the printer 
on page 47.

4. Select the substrate type.

5. Click the Finish button in the Internal Print Server to start the substrate check, then enter the substrate 
type in the Loaded Substrate window.

TIP: If the printer has been idle overnight with substrate loaded, and exposed to high or low temperatures, 
advance the substrate 13 to 25 cm (5 to 10 in) before printing, to avoid printhead crashes or ink smears on the 
substrate.

The substrate edge holders
The purpose of the substrate edge holders is to prevent the substrate edges from lifting up and jamming while 
printing. If you experience this kind of problem while printing, you can try using the edge holders to overcome it.

IMPORTANT: There are some textiles that should not be used with edge holders; check before using.

NOTE: The edge holders are not recommended when printing on substrate that is more than 0.4 mm (0.016 in) 
thick.
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TIP: The edge holders may be easier to deploy if you raise the carriage beam (see Set the carriage beam 
position on page 63); however, they can be deployed without raising the carriage beam.

The correct position is illustrated below. The substrate should be free to move, and should not touch the ends of 
the edge holder.

CAUTION: Wrongly positioned edge holders could severely damage the printheads and carriage.

NOTE: If the substrate is loaded with the right edge outside the 161 cm position on the spindle ruler, or the left 
edge outside the −162 cm position, the edge holders cannot be used because there is not enough space for 
them.

Install an edge holder

1. Standing in front of the printer, place the magnetic side of the edge holder onto the far side of the platen 
and cover the edge of the substrate.
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2. Attach other side of the edge holder in the space between the platen and the top diverter profile, cover the 
edge of the substrate with it. Make sure that each edge holder is properly positioned and not bent as this 
could cause a carriage crash.

3. Turn the screw at the front part of the edge holder to fix it in place.

4. Ensure that the substrate is aligned with the edge holder.

CAUTION: Place the edge holder carefully. It should remain perfectly straight, otherwise it could damage the 
printheads and carriage.

TIP: Once installed, an edge holder cannot be slid sideways. If you want to move it sideways, you must remove 
it and reinstall it in the new position.

Replace an edge holder strip

Replacement edge holder strips come with the printer cleaning kit. Replace the strip if it is broken (for example, 
by an impact) or deteriorated (for example, by accumulated ink).

1. If it is installed in the printer, remove the edge holder from the platen.

2. Remove the old strip and insert the new one.

3. Replace the edge holder on the platen, if you intend to use it.

Load a roll onto the spindle
NOTE: Contact HP to know the recommended third party solutions for substrate lifter and core adaptors.
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Single-roll printing

The spindle has a pneumatic connector at one end and a gear at the other.

1. Check that the gear is on the correct side.

2. Insert the spindle into the roll taking into consideration the winding direction.

TIP: The spindle is quite heavy in order to ensure stiffness and so avoid skew and wrinkles, so two people 
are recommended for this operation.

3. Note the position of the end of the roll on the scale marked on both sides from the center of the spindle. 
The input and output rolls should be positioned identically on their respective spindles.

TIP: The rolls should be centered to reduce the risk of skew, wrinkles, and telescoping.

4. Connect the air gun to the pneumatic connector on the spindle, and inflate the spindle so that it cannot 
move inside the roll.

TIP: Before inflating, use the pneumatic gun to blow air around the valve area to remove any dirt.

WARNING! The air gun provided with the printer is only intended to inflate the spindle. When 
recommended to use for cleaning purposes, make sure to do so according to local regulations since 
additional safety provisions may apply.

TIP: If the substrate is telescoped on the input roll, there is a risk of substrate jams and damage to the 
printheads. Try to straighten the edges of the substrate to minimize telescoping on the input roll before loading 
it into the printer.

TIP: Check that the substrate is attached to the input core.
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The roll is now ready to be loaded into the printer.

TIP: If you are a regular user of different substrate types, you can change rolls more quickly if you preload rolls 
of different substrate types on different spindles. Extra spindles are available for purchase.

Load a roll into the printer
The objective when loading substrate is to get a uniform tension across its width and length to minimize the risk 
of skew, wrinkles, and telescoping.

Load a roll (roll-to-roll configuration)

The substrate roll is mounted on the input spindle and will be collected on the output spindle. The substrate 
goes from the input spindle over the input spread roller, over the main roller, over the platen, over the output 
spread roller, and then to the output spindle.

The above illustration shows the substrate loaded with the printed face inwards on both input and output rolls. 
You can also load substrate with the printed face outwards on either or both rolls, in which case the spindle will 
turn in the opposite direction. The printer asks you for the winding direction if it cannot detect it automatically.

NOTE: For direct to fabric printing we recommend loading the media facing outwards on the output roll.

Each of the spindles has its own motor. The motors maintain tension on the substrate. Some vacuum is applied 
at the level of the platen to keep the substrate flat. The substrate is moved forwards by the drive roller motor, 
on which there is a pinch mechanism to prevent the substrate from slipping.

Before loading a roll into the printer, you must have a roll loaded onto a spindle (the input roll) and an empty 
core loaded onto another spindle (the output roll). See Load a roll onto the spindle on page 45.

NOTE: For the output roll, use a single empty core the same length as the input core. Do not place two or more 
shorter cores on the same spindle, which could cause substrate-advance problems.
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TIP: The spindle and a roll of substrate can be heavy. You are recommended to use a forklift or some other 
equipment to move it into position; otherwise, lift one end into the printer, and then the other end.

1. Go to the Internal Print Server and click Substrate Load/Unload, then select the correct configuration.

2. In the Internal Print Server, choose from the list of substrate types the type that you have loaded.

3. If they are installed, remove the substrate edge holders from the print platen so that they do not get in the 
way while loading the substrate.

CAUTION: Loading the substrate on top of the edge holders could severely damage the printheads and 
carriage.

4. Bring the new roll on its spindle to the rear of the printer, with the geared end of the spindle on the left.

5. Rest the ends of the spindle on the platforms provided at the rear of the printer; plastic pads are provided 
to absorb the impacts.

6. In the same way, load the spindle with the empty core into the front of the printer. In this case, the geared 
end of the spindle should be on the right.

Loading substrate

1. Use the internal print server to raise the carriage beam to its loading position or start the loading process 
using the substrate load button.
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2. Open the window.

3. Open the loading table latches.

4. Open the loading table.
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5. Unwind a length of substrate.

6. Place it in the print zone.

7. If necessary, push the substrate through the printer until it reaches the output spindle.

NOTE: This may be necessary if the substrate gets stuck below the vapors extraction channel / output 
cover during manual loading; in this case, you should open the vapors extraction channel / output cover in 
order to clear the jam and route the substrate correctly.
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8. Align the substrate by checking that the substrate edge is in the same position on the input and output 
spindles. This can be done by using the rulers on the spindles or by measuring the distance between the 
right edge and the side plate.

9. When the substrate is evenly tensioned and flat (no wrinkles or bumps), attach it to the empty core with 
adhesive tape. Tape it first in the center, and then at the left and right sides, making sure not to pull the 
substrate excessively or leave it wrinkled.

10. Close the window.

11. If you are using the substrate edge holders, place them on the platen before closing the window.

12. Use the Internal Print Server to lower the carriage beam to its printing position.

13. Go to the Internal Print Server and click the Finish button. The printer rotates both rolls to check their 
diameters, and it also checks the width of the roll, the winding direction, the vacuum, and the substrate 
advance calibration (this takes about a minute).

NOTE: Some substrates (such as transparent substrates) cannot be measured by the printer in this way. 
In such cases, you will be asked to enter the Left Edge and Width fields yourself into the Internal Print 
Server. Use the ruler on the spindle to check these values.

14. An alert about substrate-advance tracking may appear at this point. For more information on when you 
might want to turn off automatic tracking, see Substrate-advance calibration on page 107.

The printer is now ready to print.

View information about the loaded substrate
Information about the loaded substrate is displayed at the bottom of the main screen of the Internal Print Server.

To see more information, click Substrate > Settings.

Unload a roll
NOTE: Contact HP to know the recommended third party solutions for substrate lifter and core adaptors.

1. Check that the printing is not printing.

2. Go to the Internal Print Server and click Substrate Load/Unload.

3. Lift the loading table latches at the rear of the printer.
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4. If you need to raise the carriage beam, go to the Internal Print Server and click Carriage beam position > 
Move to substrate load position. The printer raises the carriage.

TIP: This step is optional. It may be feasible to unload some substrates without raising the carriage beam.

5. When the carriage has been raised, cut the substrate

6. Wind the substrate manually onto the output roll.

7. Open the two latches at each side of the spindles.

8. Remove the output roll from the printer.

9. Press the valve to deflate the spindle and remove it from the roll.

IMPORTANT: When you press the spindle valve, make sure nobody else is touching the spindle/roll to 
minimize the risk of trapping a finger between any spindle component and the roll.

10. Rewind the substrate manually onto the input roll.

11. Open the two latches at each side of the spindles.

12. Remove the input roll from the printer.

13. Press the valve to deflate the spindle and remove it from the roll.

IMPORTANT: When you press the spindle valve, make sure nobody else is touching the spindle/roll to 
minimize the risk of trapping a finger between any spindle component and the roll.

The printer is now ready for new input and output rolls to be loaded.

Output platen light

The output platen light illuminates both the platen and the job that is being printed. It can be switched on and off 
manually
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Substrate presets
Each supported substrate type has its own characteristics. For optimum print quality, the printer changes the 
way it prints on each different substrate type. For example, some may need more ink and some may require 
higher temperatures for drying. So the printer must be given a description of the requirements of each substrate 
type. This description is called a substrate preset. The printer is supplied with substrate presets for some specific 
substrate types, and also with presets for some generic types.

As it is inconvenient to scroll through a list of all substrate types available, your printer contains substrate 
presets for only the most commonly used substrate types.

You can check substrate availability from the Online substrate manager on page 60.

To install a new substrate preset without .oms, go to the Internal Print Server and click Substrate > Search 
substrate online, then search for your specific substrate file and click the Down arrow of the Status column.

To install a new substrate preset that you have downloaded, go to the Internal Print Server and click Substrate > 
Presets management > Import label, then search for your .oms file and click Update. You can also export 
substrate presets using Export label.

Export multiple presets
Multiple substrate presets can be exported together in a single .oms substrate file.

How to export multiple substrate presets

1. In the Internal Print Server, click Substrate > Preset management.
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2. Go to the Export tab, select all the substrates to export, and click Export.

NOTE: This functionality allows up to 120 substrate presets to be exported at once.

3. A window pops up asking to save the generated .oms file. Click Save to continue.

How to import the generated .oms file

1. In the Internal Print Server, click Substrate > Preset management > Import.

2. Browse to select the .oms file (in this case ‘1_paperpresets.oms’) and click Update.
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3. When the .oms file has been imported, the following information is displayed:

Use a new substrate
Whenever you load a new substrate type into your printer, you must choose a substrate preset for it.

1. If no specific preset for that substrate appears in the list, check the Online substrate manager on page 60
in case a preset for your substrate is available there. Alternatively, get the specific preset from your 
substrate reseller or the substrate manufacturer.

2. If no specific preset is available, try using a generic preset in the same substrate category.

3. If you are not satisfied with the results, you can create a new preset for your substrate. See Create a new 
substrate preset on page 55.

4. For full control of your preset, clone a generic preset (or the preset obtained from the Add New Substrate 
wizard) and adjust the settings manually. See Edit a substrate preset on page 56. This is recommended 
for advanced users only.

Create a new substrate preset
To create a new substrate preset, you must clone an existing one and then edit it. In the Internal Print Server, 
click Substrate > Clone.

In the Clone substrate window, choose the substrate you want to clone, and choose a new name for the clone.

NOTE: Only generic substrates can be cloned. You cannot clone a clone.
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You can then proceed to edit the new preset that you have created: see Edit a substrate preset on page 56.

If you want to create a new substrate preset using the same transfer paper but with a different fabric, select the 
category paper and select the transfer paper substrate you are using. We recommend that you don't change the 
transfer paper name. If you change it, the substrate properties will not be shared.

If you want to create a new substrate preset with a different transfer paper, change the name of the transfer 
paper when cloning, so that substrate properties are not shared.

NOTE: If you create a new substrate preset for a new transfer paper or for a new direct-to-fabric, make sure to 
perform substrate-advance calibration (see Substrate-advance calibration on page 107).

The generic presets for direct-to-fabric have an average temperature set for the contact heater. As with other 
settings, this temperature can be adjusted.

Edit a substrate preset
Editing a preset has several purposes:

● You can assign a name of your own choice to a particular substrate.

● You can adjust the preset to suit the precise characteristics of your substrate.

● You can adjust the preset to your intended use of the substrate, which may range from highest-quality 
printing to fast production output.

To edit the technical characteristics of a custom substrate type, go to the Internal Print Server and click Substrate 
> Edit. This allows you to change all the important settings in the substrate preset. It is recommended for 
advanced users only.

NOTE: You can change only the presets that you have created yourself. The presets supplied by HP cannot be 
changed.

You can also create new paper modes among the large variety of print modes listed for each substrate. Thus, 
you can change the throughput or ink level if you like.
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1. In the upper part of the Edit Substrate window, select the substrate category and the name of the specific 
substrate preset that you want to edit.

NOTE: Generic presets cannot be edited.

2. In the central part of the window, select the number of passes, number of colors, and ink density; and 
name the combination to make it visible in the Print dialog.

3. Under the print-mode table, change the substrate settings.

4. Click Update substrate if you want to change the settings.

5. In the lower part of the window, change the settings for your named combination. Click Update print mode 
if you want to change an already-existing named combination.

To achieve a highly optimized preset for one specific purpose and substrate, you may need to adjust other 
settings to compensate. To achieve a balanced preset, you are recommended to use the Add New Substrate 
wizard or a generic preset.

When you have edited the substrate preset, you can change the loaded substrate as usual: Substrate > Settings.

On-the-fly adjustments

You can modify the substrate settings while printing. In the Internal Print Server main window, click the Print 
adjustment button, and a dialog box opens.

The dialog box is divided into sections for the substrate advance (see Substrate-advance calibration 
on page 107), the drying temperature, and the substrate tension.
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1. Adjust the vacuum level up or down. The input and output tensions are adjusted automatically, depending 
on the vacuum level.

2. Illustrations of the possible effects of not enough, too much, and correct tension respectively.

To apply and save the values, click the Apply button in the dialog box before closing it. The new settings are 
saved for that particular substrate type for the current and future prints. They are not applied to all substrate 
types.

NOTE: On-the-fly adjustments only can be done with cloned substrates. With generic substrates, this dialog 
box is disabled.

Optimize the preset for higher print speed

Action

Reduce the number of passes.

Optimize for ink consumption

Action

Reduce ink density.

Considerations

● Reducing the ink density usually reduces the gamut and color saturation.

● A lower ink density may permit a lower number of passes.

Recommended print modes for each substrate type

Green: Recommended print mode for this substrate type

Yellow: Available print mode for this substrate type
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Adjust the printing workflow for optimum color performance

1. Check your substrate's color calibration status and calibrate it if recommended, by clicking Substrate > 
Color calibration in the Internal Print Server. See Printer calibration on page 96.

2. Create ICC profiles for your substrate; see your RIP documentation for instructions.
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Remove a substrate preset
To remove a substrate preset from your printer, go to the Internal Print Server and click Substrate > Remove. 
Then select the category and type of the substrate you wish to remove from a list of removable substrates.

Online substrate manager
From the menu click Substrate > Search substrate online, or click the Search online button in the Load printer 
configuration dialog. This screen is shown:

Sorting

To sort, click on the column title or place the mouse cursor over the column title and click on the drop down 
arrow.

Structured search

There are several structured search fields. You can use a single search field or a combination of fields.

● There are several search options:

– Select a manufacturer to find substrates from a specific manufacturer.

– Select a category and grade to find specific substrate types.

– Select applications to find optimized and certified substrates.

● Application Remote Media searches automatically.

● Click Clear filters to display the full list.
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Free text search

The free text search locates substrates by checking the substrate name, supplier name, the comments and 
technical note, for the presence of the specified text string.

● Type a text string.

● Application Remote Media searches automatically if search text contains more than one character.

● Click Clear filters to display the full list.

Install new substrate

To install a new substrate preset, go to the Internal Print Server and click Substrate > Search substrate online, 
then search for the specific substrate file and click the. Down arrow in the status column.

This agreement dialog is shown:

The agreement dialog must be accepted to continue with the installation.

If installation is successful a check icon is shown in the status column.
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Update existing substrate

The substrate update option is shown when a new substrate version is available on the server. To update a 
substrate, go to Internal Print Server and click Substrate > Search substrate online, then click on the substrate 
update icon in the status column.

Substrate synchronization

In order to make sure that the RIP has the latest substrates available, check the RIP help section: Substrate 
synchronization.

In order to retrieve the new substrates installed in the printer from the RIP:

● Open the Easy Media component and select the printer.

● Once in the printer dialog, click AutoSync.

● Choose between "Missing presets only" or "Full reset".
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NOTE: Take into account that only substrates downloaded from the HP Media Locator will include an ICC profile. 
For custom substrates, an ICC profile needs to be created in, or imported to the RIP.

Set the carriage beam position
The carriage beam position determines the vertical distance between the printheads and the platen. If it is too 
great, print quality will be impaired. If it is too small, there is a risk that the printheads will come into contact with 
the substrate, causing smears or damage.

● The substrate-load position is not used for printing: it may be used for loading thick substrates or for 
maintenance tasks.

● The printing position is a fixed height suitable for unwrinkled substrates up to 0.4 mm (0.016 in) thick.

● A custom position is used for substrates thicker than 0.4 mm (0.016 in), or for substrates that wrinkle 
slightly due to heating. We recommend setting the custom position as follows:

– The thickness of the substrate plus 1.9 mm for substrates that do not wrinkle.

– The thickness of the substrate plus 2 to 3 mm for substrates that wrinkle.

You cannot exceed the maximum height permitted by the Internal Print Server.

TIP: Try to avoid wrinkling by using substrates that do not wrinkle, or by using a slower print mode that 
will allow you to lower the drying power.

To set the carriage beam position, go to the Internal Print Server and select the appropriate position from the 
drop-down list.

WARNING! Keep away from the printer's moving parts until the carriage beam has reached its new position.

CAUTION: Do not change the carriage beam position while the printhead cleaning roll is out of place.
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6 Create and manage print jobs

● Add a new print job

● Rotate a print job

● Manage the print queue

● Delete a print job

● Image composition
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Add a new print job
Each print job must be created in your Raster Image Processor (RIP) and then added to the Internal Print Server.

When the RIP has generated a print job, its output folder will contain at least three files:

● An XML or JDF file containing job settings

● A low-resolution TIFF file for use in previews

● At least one high-resolution TIFF file containing the image to be printed

The output folder should be the shared folder on the Internal Print Server computer that was created during 
printer installation. The Internal Print Server cannot take files directly from the network because access would 
not be fast enough.

1. Go to the Internal Print Server.
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2. Click the Add New Job icon  or File > Add New Job. Navigate to the folder containing the print job files, 
and click Open to import the job into the Internal Print Server.

TIP: You can sort the list by any column.

3. The next dialog box displays information about the job.

You can change the default job name the first time you open its properties window. Once you save the job 
name, it cannot be changed. Use the Save As button to create a copy of an existing job with a different 
name.

This dialog has the following options:

● Number of copies: the total number of copies to print

● Number of columns: the number of copies to print horizontally, across the width of the substrate

● Max: if this option is checked, the number of steps will be set to the maximum that will fit into the 
substrate width
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In the Spacing section, this dialog gives the opportunity to define a horizontal margin that will be left blank, 
or to center your jobs on the substrate so that there is an equal amount of white space on both sides. If the 
number of copies is more than one, then it will apply these properties:

● Horizontal Space: the horizontal gap between copies

● Vertical Space: the vertical gap between copies

Although the substrate and print mode can be changed from this dialog window using the change button, it 
is recommended not to do so because it may adversely affect print quality. It is better to make such 
changes from the RIP.

The drop-down list at the top of the preview field allows to choose all sections or just one of the sections to 
be printed, and with the other drop-down list, can select the roll preference where the job will be queued.
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4. To see more job options, click the Advanced settings button in the Job Properties dialog.

In this dialog, although the substrate and print mode can be changed from this window by using the 
Change button, it is recommended not to do so, because it may adversely affect print quality. It is better to 
make such changes from the RIP.

The Job Info paragraph can be used to select annotations and special marks to be printed alongside the 
image. The Job Notes field can be used to add some text to be printed in the bottom of each copy with the 
annotations, if any.

The Partial Job Printing section appears only when the number of copies is one, the job is not double sided, 
contains one whole image, and can be used to select the job printing offset. The hatched area will not print.

The Easy Printing resume can be useful to resume a job after an unexpected interruption.

Click the Save button to store the advanced settings, or Cancel to discard them and return to the previous 
main dialog.
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5. Click the Save button to store the job in the Internal Print Server for further processing in the main job 
dialog.

NOTE: The Internal Print Server gives you a warning if you select layout changes that are not compatible 
with your selections in the RIP software.

6. Click the Save button to store the job in the Internal Print Server for further processing.

NOTE: The Internal Print Server gives you a warning if you select layout changes that are not compatible 
with your selections in the RIP software.

Rotate a print job
A job can be rotated by 90 degrees in either direction by using the rotation icons at the top right of the Job 
Properties window of the dialog that appears when clicking the Image composition button.

NOTE: Rotation is available only when the printer is not printing.

Click the Save button to store the current image rotation or Cancel to discard the changes and return to main 
dialog of the properties of the job.

The rotation effect is shown in the preview. After you click the Save or Save As button in the Job Properties 
window, the actual rotation of the job takes place. This could take a few minutes, depending on the image size 
and resolution, during which time the job can neither be printed nor edited, and the job status is shown as 
Rotating.

Manage the print queue
The main screen of the Internal Print Server displays the queue of print jobs and various icons that can be used 
to manage the queue.
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Above the print queue are the following icons:

● Add New Job icon : See Add a new print job on page 65.

● Add Existing Job icon : Return a job to the queue that has been printed already. Printed jobs remain 
available unless deleted manually.

● Edit Job icon : Edit the properties of a job in the queue.

● Proof icon : Proof a job in the queue (not available for nested jobs). This can be used to crop the image 
before printing.

● Lock Job icon : Lock a job in the queue.

● Up icon : Select the next job upwards in the queue.

● Down icon : Select the next job downwards in the queue.

● Remove icon : Delete the selected job from the queue.

You can check the boxes of the jobs you want to print, and click the Print button to print them.

You can cancel all jobs in the queue by clicking the Cancel button.

The Print adjustment button displays the substrate-advance calibration (which can be changed).

Delete a print job
This is the correct procedure to delete a job.

1. Remove the job from the queue by using the Remove icon  or by ticking the job in the queue and clicking 
Remove. When deleting a job in this way, the files may or may not be left on the printer's hard disk, and the 
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file may or may not still be available from the list in the Add Existing Job window, depending on the settings 
in Tools > Preferences > Queue Rules, in the section “When removing jobs from the queue”.

2. Remove the job with File > Delete job, select the job and click the Delete button. Now the file cannot be 
retrieved from the Add existing job window.

Image composition
The Job Properties window is displayed when you import a job into the Internal Print Server, or when you right-
click the job queue in the Internal Print Server.

This window contains an Image composition button that allows you to choose among the following alternatives:

● Nesting (Multi-image): The selected jobs are printed one after the other, across the width of the substrate if 
there is room. You can use the Advanced Nesting Arrangement window to alter the layout manually. See 
Introduction to JDF on page 30.

● Double Sided: Block out.

Nesting

Nesting is a layout method that allows you to choose the layout of your printed jobs on the substrate, relative to 
one another, instead of simply printing them one after another as usual. Jobs can be printed side by side if there 
is room.

TIP: Printing jobs side by side on the substrate gives you faster throughput and uses less substrate.

You can use nesting in the Internal Print Server, from the Choose Image File window or the Job Properties 
window.

The Choose Image File window

From the Internal Print Server's main window, click the Add New Job icon  to open the Choose Image File 
window. You will see the Nesting check box on the bottom left of the window. If you select only one job, nesting 
is impossible and the box is grayed out. If you select more than one job, you can click the box to enable nesting.
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NOTE: To be nested together, jobs must be of the same resolution and printed on the same substrate. Any 
incompatible job is added to the queue as a separate, non-nested job, and an explanatory message is displayed.

When you click the Open button with nesting enabled, the Advanced Nesting Arrangement window opens (see 
The Advanced Nesting Arrangement window on page 73).

The Job Properties window

From the Internal Print Server's main window, right-click the print queue to open the Job Properties window. In 
this window, you can click the Add New Job icon  to add more jobs, in which case you will see a Nesting section 
in the Layout pane.

Nested jobs must all be printed with the same number of passes. Therefore, the number of passes used for all 
jobs will be copied from the first job.

From the current dialog, click the Image composition button to access another dialog where the Arrange button 
can be selected.
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If you click the Arrange button in this section, the Advanced Nesting Arrangement window opens. If you use 
advanced nesting, the number of passes used for all jobs will be copied from the job with the highest number of 
passes specified.

The best location for the next added image is selected automatically.

The Advanced Nesting Arrangement window

The Advanced Nesting Arrangement window displays a preview of your jobs and their layout on the substrate.

● You can alter the layout by selecting a job in the preview and changing the Left and Top values, or by 
dragging with the mouse.

● You can zoom and scroll the preview.

● You can rotate images at any stage.

The Arrange button automatically optimizes the positions of the images, keeping the established margin.

When you are satisfied with the layout, click the OK button.

Mirror functionality

The mirror functionality allows you to flip images horizontally. From the Internal Print Server’s main window, 
right-click the print queue to open the Job Properties window. In this window, click on the Image Composition 

button to access another dialogue in which you will find the Mirror button .
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7 Handle the ink system

● Ink system components

● How to work with ink system components
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Ink system components

Ink cartridges

Ink cartridges store the ink and are connected to the printheads, which deposit the ink on the substrate.

Each cartridge contains HP Dye Sublimation Ink, and consists of a bag within a recyclable cardboard box.

CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the 
Glossary on page 279). Avoid touching pins, leads, and circuitry.

If pressure is put on a cartridge while it is connected to the printer, the pressure is transmitted to the ink 
pressure sensor, which may break; in which case ink may leak from the cartridge. To avoid such ink leaks, avoid 
putting any pressure on cartridges while they are connected to the printer. In particular:

● Always disconnect cartridges from the printer before handling them.

● Never place anything heavy—more than 1 kg (2.2 lb)—on top of a cartridge.

● Take care not to drop a cartridge.

● Do not try to force the last of the ink out of an almost-empty cartridge by pressing the ink bag inside the 
cartridge.

Printheads

The printheads take ink from the ink cartridges and deposit it on the substrate.

CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices (see the 
Glossary on page 279). Avoid touching pins, leads and circuitry.
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The printer's four-color writing system uses four dual-color printheads with a total of 41,420 nozzles.

WARNING! Printheads should be stored vertically: if boxed, with the box arrows pointing up; if out of the box, 
with the nozzle cap up.

Printhead cleaning roll

The printhead cleaning roll is a roll of absorbent material used in the normal operation of the printer to clean the 
printheads periodically (at the beginning and end of printing, on printhead check and clean, and so on). This helps 
the printheads to deliver continuous ink and maintain print quality.

The roll should be replaced whenever it is used up, to avoid damaging the printheads. The frequency of 
replacement depends on your use of the printer. A single roll will last approximately 80 liters; this may take 
about a month, at a usage level of 10,000 m²/month (100,000 ft²/month).

An alert is displayed when 75% of the roll has been used, and again when 95% of it has been used. You can 
choose to replace the roll at any time. The printer will not print when the roll has been 100% used.

If there is not enough of the roll to start a new job, the printer cancels the job.

To change the printhead cleaning roll, see Replace the printhead cleaning roll on page 90. The printhead 
cleaning kit can be ordered in the normal way.

TIP: You should not touch the printhead cleaning roll except when you need to replace it. Any interference with 
the roll may prevent the printer from keeping track of roll usage, in which case you may see spurious error 
messages, and a printing job may be cancelled unnecessarily.

Aerosol filters

The printheads produce many fine droplets of ink, most of which are placed accurately on the substrate. 
However, a small proportion of these droplets escape sideways; the two aerosol filters are placed on either side 
of the printhead carriage to intercept them.

The filters should be changed every time the printhead cleaning roll is replaced. They are provided with the 
printhead cleaning kit.

Left spittoon

The left spittoon is a rectangular piece of foam that allows the printhead nozzles to be refreshed at the left side, 
before printing a pass from left to right.

Change one or two foams from the left spittoon every time the cleaning roll is replaced. The foam is provided 
with the printhead cleaning kit.

Ink deposits

The printer can check the firing capacity of each single nozzle. Doing so causes small amounts of ink to 
accumulate close to the drop detector. This ink gradually forms ink deposits that need to be cleaned.
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How to work with ink system components

Ink cartridges

Remove an ink cartridge

An ink cartridge should be removed and replaced when it is empty or past its expiry date. An empty cartridge is 
indicated in the Internal Print Server and by an orange blinking light beside the cartridge itself. You may also 
decide to remove a cartridge if it contains little ink and you want to provide for a long period of unattended 
printing.

The printer can continue printing without any ink cartridges for at least 10 minutes, depending on the print mode 
and the job being printed. Therefore, cartridges can be replaced while printing continues. A functional ink 
cartridge is required in order to start a new job.

1. Go to the cartridge that you intend to remove. The cartridges are arranged as shown below.

2. Disconnect the cartridge connector by pressing the tabs on each side of it and pulling it gently away from 
the cartridge.

3. Remove the empty cartridge from the printer.

NOTE: Some residual ink can be expected in the cartridge, ranging from 2% to 5% of the original content.

Insert an ink cartridge

NOTE: The ink cartridge is supplied in an insulating bag; do not open it until you are ready to use the cartridge.

1. Check that the new cartridge is of the correct color.
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2. Place the cartridge on a flat surface and turn it (rotating it through 360 degrees) as many times as 
indicated on the label, to ensure that the ink is well mixed before use.

3. Tear off the square and fold it inside the handle.

4. Put the new cartridge into its correct place on the printer.

TIP: Use both hands: the cartridge is quite heavy.

5. Check that the rubber part around the needle in the cartridge connector is clean. Clean gently if necessary.

6. Connect the cartridge connector to the cartridge.

NOTE: The cartridge connectors will refuse connection to the wrong type or color of cartridge. If you 
cannot connect the connector easily to the cartridge, check that you have the correct cartridge.

7. Ensure that the tabs on each side of the cartridge connector are opened but in place, showing successful 
connection. You will hear a click.

8. A few seconds after you have connected the cartridge, the white LED should be lit. If it is not lit after 10 
seconds, reconnect the cartridge. The LED will turn red if the cartridge is expired or not valid; see the 
Internal Print Server for further details and corrective action.

Although it is possible to use non-HP ink cartridges, this choice has several serious disadvantages. It may not be 
possible to determine with enough accuracy the ink level or status of used, refilled, or counterfeit ink cartridges. 
Any service or repair required as a result is not covered under the warranty. System ink flushing, color 
calibration, and printhead alignment are recommended. If you experience print-quality problems, HP 
recommends changing to Original HP inks.

ENWW How to work with ink system components 79



Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required, except for the black cartridge. In 
order to maintain the best print quality, the black cartridge should be disconnected and rotated every week. 
Follow the instructions in the section Remove an ink cartridge on page 78, and as many times as indicated on the 
cartridge label. You will have a weekly notification in Print Care reminding you of this maintenance. Please also 
note that the cartridges should be replaced when they reach their expiration dates. An alert will notify you when 
any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Printer status and alerts on page 26.

Check the status of the ink cartridges

The Internal Print Server provides information about the status of the ink cartridges. Additional information can 
be obtained from the status lights below each ink cartridge (on the left side).

● White steady light: no problems

● White slowly blinking light: cartridge in use, do not touch

● Orange blinking light: cartridge is empty

● Red steady light: there is a problem, check the Internal Print Server for more information

● All lights off: no cartridge, cartridge not connected, or unknown problem

The level of ink remaining in each color is displayed at the top right of the Internal Print Server's main screen. You 
can see more details of ink cartridge and printhead status by clicking Information > Supplies.

NOTE: The ink level estimates are not guaranteed to be accurate.

NOTE: If the warranty status is See warranty note, this indicates that expired ink is being used. If the warranty 
status is Out of warranty, this indicates that non-HP ink is being used. See the limited warranty document 
provided with your printer for details of the warranty implications.

NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip. 
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More 
information is available on the HP website at the following link: http://www.hp.com/go/learnaboutsupplies.

Printheads

Remove a printhead

WARNING! This operation is limited to trained personnel only!

80 Chapter 7   Handle the ink system ENWW

http://www.hp.com/go/learnaboutsupplies


NOTE: During the installation of the printer, the designated personnel received training for safe operation and 
maintenance of the printer. It is not allowed to use the printer without this training.

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

If a printhead develops an electrical fault or overheats, the Internal Print Server will indicate that it should be 
reseated or replaced. In addition, you may wish to replace a printhead if its warranty has expired or if you feel 
that its performance is not adequate.

1. Ensure that the printer is not trying to print: stop the job queue.

2. In the Internal Print Server, click Printer > Replace printheads.

3. If the window is open, you are asked to close it.

4. The carriage moves automatically to service position. Open the carriage cover.

5. The Internal Print Server tells you which printhead to remove. Release the latch that secures the printhead, 
and lift it.
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6. Lift the blue handle provided with the printhead, and pull the handle gently upwards to disconnect and 
extract the printhead from the carriage.

7. Remove the printhead from the printer. The original packaging materials can be used to discard the old 
printhead or in case there is a need to return it to HP.

NOTE: Remember which printhead came from which slot; the printer will report an error if you later replace a 
printhead in a different slot.

Insert a printhead

1. Check that the new printhead is of the correct colors.

NOTE: Each printhead has a unique shape and cannot be inserted into the wrong slot. Do not try to force 
it.

2. Shake the printhead according to the instructions on the packaging.
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3. Remove its packaging and protective caps.

TIP: You may wish to keep the protective caps for later reuse, in case you ever want to remove a 
printhead from the printer.

4. Put the new printhead into its correct place in the printer, and lower its handle.

CAUTION: Insert the printhead slowly. It is recommended to insert it as vertically as possible without 
hitting any parts of the carriage or the sides of the slot. It may be damaged if you insert it too fast, or if you 
hit something.

5. Lower the latch until it lies on the printhead but do not close it yet.

6. Press with two fingers on the primer to ensure the primer ports are well inserted.
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7. Secure the latch.

8. Close the window and click OK. The printer checks that the new printhead has been correctly inserted (the 
status is shown in the Internal Print Server), and recommends printhead alignment, which is optional.

9. Restart the job queue.

Maintain the printheads

You should perform an automatic printhead check and clean every morning, before starting to print. While the 
printer is idle, the components of the ink can precipitate inside the printhead and block the nozzles. The check 
and clean process pre-cleans the printheads, checks them with the drop detectors, and cleans them further if 
necessary. It takes between 10 and 30 minutes, depending on the condition of the printheads.

To maintain the best print quality, replace a printhead when it reaches its expiration date. An alert notifies you 
when any printhead reaches its expiration date.

You can also check a printhead's expiration date at any time: see Printer status and alerts on page 26.

Printheads should be aligned from time to time: see Align the printheads on page 97.

TIP: If you remove an unexpired printhead from the printer, planning to reuse it later, the best way to protect it 
is by replacing the protective caps that you removed before inserting it into the printer.

Check and clean the printheads

This procedure should be followed daily.

1. Go to the Internal Print Server and click Printer > Printhead cleaning.
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2. Click the Check button to perform routine cleaning automatically.

3. Information on the last Check and clean carried out will appear in the window.

Safe mode

Under certain conditions, including printer operation outside of environmental specifications, and when a used, 
refilled, or counterfeit ink cartridge has been detected, the printer will operate in ‘safe’ mode. HP is unable to 
warrant the performance of the printing system when operated outside of environmental specifications or when 
a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect the printer and the 

printheads from damage due to unexpected conditions, and is in operation when the  icon is displayed on 

the printer’s computer. For optimal performance, use Original HP ink cartridges. HP Stitch printing systems, 
including Original HP inks and printheads, are designed and engineered together to provide uncompromising 
print quality, consistency, performance, durability, and value—with every print.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the continuous 
ink system and install genuine HP (or compatible) cartridges.

NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to 
depletion might cause the printer to fail. If this happens, insert a new cartridge (either genuine HP or compatible) 
to continue printing.

Replace the printhead cleaning roll, filters, and spittoon

WARNING! This operation is limited to trained personnel only!

NOTE: During the installation of the printer, the designated personnel received training for safe operation and 
maintenance of the printer. It is not allowed to use the printer without this training.
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Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

When the cleaning roll reaches its end, it must be replaced, together with the aerosol filters and left spittoon. All 
these parts are supplied together with the printhead cleaning kit.

1. Aerosol filters

2. Left spittoon

3. Printhead cleaning roll

The Internal Print Server provides instructions for all replacements. Go to the Internal Print Server and click 
Printer > Replace cleaner roll. A wizard appears summarizing all the operations to be done:

● Replace the aerosol filters.

● Replace the left spittoon.

● Empty the printhead cleaning waste bottle.

● Replace the printhead cleaning roll.

TIP: You are recommended to wear gloves.

Click Next at the bottom of the wizard window to start the replacement of the aerosol filters.
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Replace the aerosol filters

1. Ensure that the printer is not printing.

2. Ensure that all windows, covers, and doors are closed and remain in their original position.

3. Open the carriage cover.

4. Open one latch on the right side of each aerosol filter module.
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5. Open the lid of each filter.

6. Extract the frame from the aerosol container and remove the filter from the frame.

7. Clean the frame nozzle with the brush from the printer maintenance kit.

8. Wipe off all the wet ink from the aerosol nozzle plate and frame.
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9. Insert the two new filters into each frame. There is only one way to insert the frames that works. If you feel 
resistance, try to insert the frame the other way round.

10. Close the lids.

11. Close the latches.

12. Click Next at the bottom of the wizard window to start the replacement of the left spittoon.

Replace the left spittoon

1. Open the window.

2. Locate the left spittoon at the left side of the print area.

3. Slide out the left spittoon foam.
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4. Insert the left spittoon into the left spittoon housing. Ensure that it is flat.

5. Click Next at the bottom of the wizard window to start the replacement of the printhead cleaning roll.

Replace the printhead cleaning roll

1. Any unused portion of the roll is wound on to the takeup roll at this time. You will be warned if the unused 
portion is more than 5% of the whole roll.

2. Unlock and open the printhead cleaning roll door on the front right of the printer.

3. Open the carriage cover.
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4. Pull the black knob on the upper left and move the pinch mechanism aside.

5. Remove the end of the roll and use it to remove all ink waste, dry ink, and fiber particles from the following 
components:

● Orange printhead cleaning blade

● Middle diverter (clean the whole surface)

● Sloping surfaces

● Left diverter

● Left latch

● Drive roller

● Pinch driver

● Pinch roller

IMPORTANT: Clean the pinch roller carefully with a sponge. Errors may occur if it is not clean. See also 
General cleaning instructions on page 12.

Also clean the tray under the pinch driver.

Make sure the drainage gap is unblocked.

6. Slide both rolls off their axles and dispose of the roll with the used cleaning material according to the 
instructions provided with the new roll. Also consult your local authorities to determine the correct manner 
in which to dispose of wastes.
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7. Keep the empty core to use as a takeup core.

8. Slide the new roll onto the upper axle, by pressing on the plastic core, not on the roll.
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9. Insert the end cap on the upper axle, and slide it all together until you hear a click, in order to position the 
roll correctly.

10. Pass the leading edge of the cleaning roll over the side diverters but below the central diverter, and thread 
the cleaning material through the pinchwheel on the left.

11. There is a strip of polyester film on the leading edge of the cleaning material. Insert it into the hole in the 
takeup core, which takes hold of it.

12. Slide the takeup core onto the lower axle.
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NOTE: If the cleaner roll has not been properly installed, you may see a message about clearing a 
printhead cleaning roll jam. Open the door, wind a little of the roll forward, then close the door. The printer 
will check the roll again. You will need to click Reinitialize to clear status errors.
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13. Restore the pinch mechanism by moving the black knob back into place. If you feel resistance because the 
cleaning roll is too tight, turn the roll slightly counter-clockwise.

TIP: There is a blue ring on the far side of the black knob, which should not be visible if the knob has been 
correctly placed. If it is visible, try again.

14. Empty the waste bottle.

15. Close and lock the door.

16. Click Finish.

The printhead cleaning roll length tracking is now reset to 100%.

NOTE: If you tamper with half-used rolls, the usage shown in the Internal Print Server will not be accurate, and 
control of the roll may be impaired.
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8 Printer calibration

● Align the printheads

● Possible difficulties with printhead alignment

● Color calibration

● Color consistency between different HP Stitch printers

● Color emulation of other printer models

● Color profiles

● Substrate-advance calibration

● Calibrations specific to one substrate preset

● Recommended calibrations after particular events
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Align the printheads
Precise alignment between printheads is essential for color accuracy, smooth color transitions, and sharp edges 
in graphical elements.

Printhead alignment is recommended in these situations:

● After replacing or reseating a printhead.

● When a new substrate is loaded and the printhead-to-paper spacing changes significantly.

● When there are print-quality problems that could be caused by printhead misalignment.

To align the printheads, go to the Internal Print Server and click Printer > Printhead alignment.

Printhead alignment can be affected by wrinkles or other substrate deformations in the print zone. Therefore, if 
the printer has recently been printing, you should wait for some minutes while it cools down. Just in case, the 
printer advances the substrate before aligning the printheads.

Manual alignment procedure

To launch manual alignment, go to the Internal Print Server and click Printer > Printhead alignment > Manual > 
Print.

The printer prints 21 series of patterns, each one named with a letter (A–V). You must choose the best result 
from each of the series (for example, number 10 in the picture below).
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The alignment procedure takes about 10 minutes. It consumes printed substrate of 75 cm width × 55 cm height 
(29.5 × 21.7 in).

NOTE: Depending on the firmware version, this pattern could be slightly different.

The diagram below shows the distribution of printheads in the carriage. It also shows the correspondence 
between printhead and patterns, with guidance on the direction of the corrections (0–40) applied.

The following table summarizes the correction type controlled by each pattern:
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Pattern Affected printhead Correction type

A C0 Scan axis, Color to Black

B M0 Scan axis, Color to Black

C Y0 Scan axis, Color to Black

D K1 Scan axis, Color to Color

E C1 Scan axisC0, Color to Color

F M1 Scan axis, Color to Color

G Y1 Scan axis, Color to Color

H C1 Paper axis, Color to Black

I M1 Paper axis, Color to Black

J Y1 Paper axis, Color to Black

K K1 Paper axis, Color to Color

L C1 Paper axis, Color to Color

M M1 Paper axis, Color to Color

N Y1 Paper axis, Color to Color

O K0 Scan axis, bidirectional, 60 ISP

P C0 Scan axis, bidirectional, 60 ISP

Q M0 Scan axis, bidirectional, 60 ISP

R Y0 Scan axis, bidirectional, 60 ISP

S K1 Scan axis, bidirectional, 60 ISP

T C1 Scan axis, bidirectional, 60 ISP

U M1 Scan axis, bidirectional, 60 ISP

V Y1 Scan axis, bidirectional, 60 ISP

Take this into account when trying to compensate for any misalignment observed in the printhead alignment 
diagnostics plot.

The central correction is 20 (15 for A), being the default value for each pattern in the Internal Print Server.

Possible difficulties with printhead alignment

A pattern shows more than one good correction

Occasionally you may find that a pattern has two or more possible good corrections, separated by two or more 
steps. This could be due to wrinkles on the substrate that change the printhead-to-paper spacing along the scan 
axis. To avoid this, ensure that the substrate is cold before starting the alignment, and advance it at least 70 cm 
(28 in) to ensure that it is not deformed by the previous job.
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Printhead alignment diagnostics plot

The printer offers a printhead alignment diagnostics plot, to assess the quality of the current printhead 
alignment. To print it, in the Internal Print Server click Printer > Printhead alignment > Verify alignment > Print.

NOTE: You can use the diagnostics plot to check printhead alignment, then fine-tune the values by following 
the instructions on the diagnostics plot. Also, if the substrate is similar to one that you already use, you can print 
only the diagnostic plot (much faster than printhead alignment) and fine-tune the values in the Internal Print 
Server.

IMPORTANT: The diagnostic plot is not designed to fine-tune automatic printhead alignment; in that case, the 
diagnostic plot is only used to check printhead alignment.

The manual printhead alignment plot is used to verify the correct alignment of printheads and apply fine-tune 
corrections where needed.

The image contains build-in pointers showing how to apply corrections. The arrows indicate in which direction 
the pattern will move when a correction is applied.

To apply corrections, modify the manual alignment value for the indicated letter. In the example below the A 
value is slightly misaligned and can be corrected by increasing the value in order to move the cyan line towards 
the right. Execute corrections in alphabetical order (from A to V)

The following picture shows an example of the diagnostics plot. Each part is described following the terminology 
of the manual alignment.
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Color calibration
Color calibration enables your printer to produce consistent colors with a particular substrate type, even if 
printheads and ink cartridges change.

Color calibration sets the ink restriction and linearization, which varies with the drop weight of the printhead. This 
calibration has been designed to provide consistency as the printhead ages (drop-weight degradation) and from 
one printer to another. For example, to reach a maximum cyan density of 0.6, one printhead may require 3 drops 
while another one may require 3.5 drops (lower drop weight).

The first calibration for each new substrate sets the color reference for future calibrations. The future 
calibrations will therefore try to match the colors at the time of the first calibration. In this way you maintain 
consistency as the printhead ages.

HP substrates loaded from HP Substrate On-line Search contain color reference files.

Good nozzle health is important, and the printheads should also be as new as possible for best performance 
when you make the first calibration.

It is also important to have the printheads well aligned (see Align the printheads on page 97), and to make sure 
the substrate is advancing correctly (see Substrate-advance calibration on page 107), otherwise the color 
pattern may appear blurry or with slightly different colors.

To start color calibration from the Internal Print Server, click Substrate > Color calibration, then click the Calibrate 
button.

NOTE: If you are printing on transfer paper, take into account that substrates of less than 45 g/m² cannot be 
calibrated.

NOTE: If you are printing direct to fabric, only frontlit fabrics can be calibrated.
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NOTE: Color calibration is not recommended when the carriage beam is in a higher position than normal.

The calibration process is fully automatic and can be performed unattended after you have loaded substrate of 
the type you wish to calibrate. Bear in mind that generic substrates cannot be calibrated; only newly created or 
downloaded substrates can be calibrated. The process takes about 15 minutes and consists of the following 
steps:

1. The color calibration test chart is printed, which contains patches of different densities of each ink used in 
your printer.

2. The test chart is scanned and color-measured using the embedded spectrophotometer. If the scan cannot 
be completed successfully, a message is displayed by the Internal Print Server; see Color calibration fails 
on page 266.

3. From the measurements made by the spectrophotometer, the printer calculates the necessary correction 
tables to apply to your print jobs for consistent color printing on that substrate type—except in the case of 
the first calibration, which sets the reference for later ones.

Calibration should be done in any of the following circumstances:

● Whenever a new non-generic substrate type is loaded that has not yet been calibrated: to set the 
reference.

● Whenever you notice excessive color differences between prints. Such color differences can be caused by 
aging and wear of the printheads, installing new printheads, changes in substrate characteristics between 
one roll and another, changing environmental conditions, and so on.

You can check the color calibration status of your substrates with the Internal Print Server: click Substrate > Color 
calibration > Show all.
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● Default status indicates that this substrate has never been calibrated, and therefore no reference state is 
defined.

● Done status indicates that a color calibration has been performed successfully on this substrate, the 
reference state is defined and still up to date.

● Obsolete status indicates that the printer status has changed since the reference was defined, so a new 
calibration must be done in order to maintain color consistency.

Color calibration is based on the color measurement of printed color patches, using the embedded 
spectrophotometer. Some characteristics of substrates, such as surface roughness or transparency, may make 
reflective color measurement of some substrate types very inaccurate. Color calibration of these substrates may 
fail or produce unacceptable printing results.

TIP: If color calibration fails at the first attempt, it is worth trying again.

To delete the reference for a given substrate, so that you can create a new reference for that substrate, you 
must reset the color calibration. In the Internal Print Server, click Substrate > Color calibration > Reset.

Color consistency between different HP Stitch printers
It is possible to cross-calibrate color between two or more printers for particular substrates. After cross-
calibrating a given substrate, you can expect to get very similar prints from either printer when using the same 
substrate.

1. Choose printer A to be the reference printer, and use it to perform color calibration on the substrate in 
question. See Color calibration on page 101.

2. Export the calibrated substrate preset. See Substrate presets on page 53.

3. Import the substrate preset of step 2 into printer B. See Substrate presets on page 53.

4. Color-calibrate the preset with printer B.

5. Colors printed with printer A and printer B, on that substrate, should now be very similar.

6. To add more printers (C, D, and so on), proceed as you did with printer B.

Color emulation of other printer models
An HP Stitch S500 64in printer can be set up to emulate colors printed by an HP Stitch S1000 126in printer.

The emulation process is done by importing a source (S1000) substrate preset into the destination (S500) 
printer, that was created, color-calibrated, and ICC-profiled in the source printer. The original or source substrate 
preset contains a number of paper modes and a color-calibration reference.

A new substrate preset is then added to the destination substrate library that keeps the same name as the 
source substrate preset. This destination preset contains the paper modes that are the closest equivalent to the 
source ones in terms of ink density and number of passes. Color emulation between source and destination, for 
the given substrate material, can then be achieved by performing color calibration of the destination substrate 
preset.

If the source substrate preset has not been color-calibrated, it can still be imported into the destination printer. A 
translated set of paper modes will still be created, but color emulation of the source printer cannot be optimized.
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Color emulation between printers of different models is based on the same principle as color consistency 
between printers of the same model; that is, exporting a source color-calibrated substrate preset and then 
importing it and color-calibrating it in a destination printer. When the printer model is the same, most printing 
settings and color resources are implicitly matched, such as printing engine, mechanical settings, paper mode 
and associated ICC profiles. However, when emulating the colors of a different printer model, you are advised to 
follow these recommendations:

● Use the same substrate type in both source and destination printer (this is also recommended between 
printers of the same model).

● Choose a paper mode in the destination substrate preset that is as close as possible to the active paper 
mode in the source substrate preset.

● Use the same workflow in your RIP software to print to the source and destination printers.

TIP: The best color emulation can be achieved by setting relative colorimetric rendering intent in the RIP 
for printing to both source and destination printers.

● Choose ICC profiles in the source and destination paper modes that are both made with the same type of 
spectrophotometer and profiling software.

Emulating an HP Stitch S1000 on an HP Stitch S300 or S500 printer

To set up a new substrate preset in an HP Stitch S300/S500 printer that provides color emulation of a source 
substrate preset in an HP Stitch S1000 printer:

1. Using the HP Stitch S1000 printer, select the desired substrate preset.

2. Perform color calibration.

3. Use the Internal Print Server to export the calibrated substrate preset.

4. Using the destination HP Stitch S300/S500 printer, import the new substrate preset.

5. After a successful import, a confirmation popup window appears in the front panel. Click OK to continue.

6. Go to the substrate library, and select the just-created emulation substrate preset by clicking the Select 
button.

7. Click the Modify button to see the color emulation status of the preset. The initial color emulation status is 
Not ready.

104 Chapter 8   Printer calibration ENWW



8. Click Done to finish the process.

9. Perform color calibration on the S300/S500 printer.

Color profiles
Color calibration provides consistent colors, but consistent colors are not necessarily accurate. For instance, if 
your printer prints all colors as black, its colors may be consistent but they are not accurate.

In order to print accurate colors, it is necessary to convert the color values in your files to the color values that 
will produce the correct colors from your printer, your inks, your substrate, and your sublimation process. An ICC 
color profile is a description of a printer, ink, substrate, and sublimation process combination that contains all the 
information needed for these color conversions.

These color conversions are performed by your Raster Image Processor (RIP), not by the printer. For further 
information on the use of ICC profiles, see the documentation for your application software and for your RIP.

HP substrates loaded from HP Substrate On-line Search usually contain color profiles that can be used 
(downloaded) by the RIP.

Easy profiling

1. Click Substrate > Profile substrate. It will open a window in which you can choose the number of passes. 
The drying temperature and drying pressure will be the ones set already by default in the loaded substrate 
and that you can modify.

ENWW Color profiles 105



2. Click Print test plot. If the media does not have an updated color calibration reference, it will perform one 
automatically. The test plot will print all available ink densities for the selected number of passes.

Each ink density will be composed of 3 groups: on one you have the bleed check, color saturation check, 
and the instructions, and on the other two the profile target chart. These two profile target charts are to be 
scanned with a spectrophotometer.

3. Once the plot is finished, evaluate substrate dryness. If it is acceptable pass to the next step, if it is not 
acceptable, increase air temperature, drying settings, and number of passes, and click Print test plot again. 
Repeat this step in case of not being satisfied with the plot result.

4. Take the plot to the calender and follow the instructions included in the plot.

5. Go back to the printer’s IPS, to the substrate profile window, and choose the combination of number of 
passes, ink density, and drying settings that best fits your application and press continue. If the new print 
mode does not exist it will open a window to set its name. If it is already created it will inform you to click 
finish and move to the next step.
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6. To create the ICC profile, measure the profile target of the selected ink density with the external 
spectrophotometer connected to your RIP. Only supported by Ergosoft.

7. Once the ICC profile is created, it can be assigned to the print mode that was just created. It can also be 
used as any other ICC profile that you already have in your library.

Substrate-advance calibration
Accurate substrate advance is important to print quality because it is part of controlling the proper placement of 
dots on the substrate. If the substrate does not advance the proper distance between printhead passes, light or 
dark bands appear on the print, and there may be an increase in graininess.

The printer has a substrate-advance sensor and is calibrated to advance correctly with most of the substrates 
that appear in the Internal Print Server. When the substrate is loaded, the substrate-advance sensor checks the 
substrate and decides whether it can be adjusted automatically or not. If not, the automatic adjustment is 
disabled.

The printer is configured from the factory with a generic preset for the sensor, calibrated for generic substrates. 
To improve substrate-advance performance for each substrate, HP recommends adjusting the substrate 
advance for each specific preset. If you want to adjust several substrates, this must be done for each preset.

Substrate-advance calibration can help you to adjust the substrate advance more accurately. In the Internal Print 
Server, click Substrate > Advance calibration. The printer prints several repetitions of a special numbered pattern 
that help you to apply the correct substrate-advance adjustment.

NOTE: The printheads should be correctly aligned before calibration, and the substrate-advance sensor should 
be clean. Otherwise, you may need to repeat the calibration after cleaning the sensor and aligning the 
printheads. See Clean the substrate-advance sensor on page 145 and Align the printheads on page 97.

Calibration procedure

NOTE: Substrate-advance calibration is not available for generic substrates. If you want to calibrate such a 
substrate, you will have to clone the generic preset and then calibrate the clone.

1. Load the substrate that you intend to calibrate.

2. In the Internal Print Server, click Substrate > Advance calibration.

3. Click Print calibration plot. The printer starts to print.

4. Enter the last eight values from the diagnostic plot. Select the lightest column and enter the corresponding 
value. Follow the instructions on the screen.
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TIP: If the plot shows two possible values (two continuous columns), the value to use is the average of 
the two. For example, if the plot indicates that the value could be +2.0 or +3.0, you can use +2.5.

5. Click Save to complete the calibration. Every time this preset is loaded, the printer will apply this calibration 
result.

NOTE: The calibration obtained is only usable with the loaded substrate type.

IMPORTANT: The calibration value cannot be used on another printer. If you intend to use the same substrate 
on multiple printers (even of the same model), you should go through the complete process on each printer.

Manual substrate-advance calibration

While printing, you can view and change the substrate-advance calibration of the currently loaded substrate at 
any time from the Internal Print Server by selecting the print job and then the Printing Adj. button, or by clicking 
Printer > Printing adjustments.

Alternatively, you can use the Print adjustment button in the Internal Print Server main window. This opens a 
dialog box with an advance calibration section, in which there are three main areas:

1. Check the box to enable the substrate-advance sensor. If it is disabled automatically while loading, you 
cannot enable it. However, if you disable it yourself, you can re-enable it.

2. If the substrate-advance sensor is disabled, you can increase or decrease the substrate-advance 
calibration.

3. Three images of possible defects due to substrate-advance issues, to help to you decide whether the 
substrate-advance calibration should be increased or decreased.

In order to apply and save the values, click the Apply button in the dialog box before closing it. Then the 
substrate-advance calibration value is saved for that particular substrate. Other substrates are not affected.

If you are using a generic substrate preset, you are recommended to clone the preset (Substrate > Clone) and 
work with that before adjusting the substrate-advance calibration, as the print adjustment is not available for 
generic presets. See Edit a substrate preset on page 56.
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Calibrations specific to one substrate preset
Some calibrations that the printer performs are specific to the substrate preset in use at the time the calibration 
was performed and some are not. The calibrations that are specific to one substrate must be performed again if 
the substrate or preset is changed. Shown below are the calibrations showing which ones are specific to one 
preset and which ones are not:

● Printhead alignment: This is applied to all presets and print modes. Usually, when switching from one 
substrate to another, there is no need to realign the printheads. However, if the printhead-to-paper 
spacing has changed significantly (different thickness, for example), then the printheads should be 
realigned.

● Substrate-advance calibration: This is specific to each substrate preset.

● Color calibration: This is specific to each substrate preset.

Recommended calibrations after particular events

 
Printhead 
replacement

New substrate 
created

New substrate 
imported

New substrate 
loaded

Print mode 
changed Poor print quality

Printhead 
alignment

Recommended Not needed 
unless new 
substrate has 
different 
thickness

Not needed Not needed 
unless carriage 
beam has moved

Not needed Recommended if 
relevant

Substrate-advance 
calibration

Not needed Recommended Recommended Not needed Not needed Not needed

Color calibration Recommended Recommended Recommended Not needed, 
unless never 
done before

Not needed Recommended if 
relevant
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9 HP Print Care

Print Care is a program that helps you to maintain your printer in optimal condition and advises you how to solve 
any problems that occur. It can also give you full information about the current status and past history of the 
printer.

The program is already installed in the printer's built-in computer; you can run it by clicking its icon in the 
Windows Quick Launch toolbar, or by double-clicking some parts of the Internal Print Server (for instance, Print 
Care status).

Its functions are divided into the following categories:

● Production Information displays information about printer status and printing history (paper usage, ink 
usage, jobs). The information can be displayed in graphical charts or text reports, all of which you can filter 
to select different subsets of information.

● Maintenance prompts you to perform maintenance tasks, and provides instructions on how to perform 
them. It can also list the maintenance tasks that have been performed in the past, and the printer 
messages that have been displayed in the past.

● Diagnostics can run functional tests on printer systems and components to check for failures and 
malfunctions. Each diagnostics run generates a report that provides detailed results and troubleshooting 
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instructions. It can also list the tests that have been run in the past. See Print Care diagnostics on page 111
for more details.

NOTE: Individual tests are not selectable: the whole series of tests is run automatically.

● Printer Tools help you to perform maintenance operations without an Internet connection.

The Print Care program has online help that explains all its functions in detail.

To change the units of measurement in Print Care, click Edit > Preferences > Units.

Print Care uses the language selected in the Windows Regional and Language Options; to change the language, 
see Change the language of the Internal Print Server on page 22.

Print Care diagnostics
The Print Care diagnostics help you to minimize downtime. When you call your support representative to report 
an issue, pass on the results of any diagnostics that you ran.

Most of these diagnostics can be run with the printer started normally. However, if you experience a severe error 
in the start-up progress that prevents you from running the diagnostics, an extra start-up mode has been 
provided for this situation. To use it, go to Print Care and click Printer Tools > Power options > Reboot in 
diagnostic mode. Then the printer will start only a minimal set of components, so the progress bar in the Internal 
Print Server will stop at around 20% and display Diagnostic mode. You can then go to the Diagnostics section 
and run the diagnostic you need.

NOTE: Read the descriptions of the diagnostics and follow the instructions.

IMPORTANT: When the printer is started in diagnostic mode, it is unable to print.

When you have finished the diagnostics, click Printer Tools > Power options > Reboot to restart the printer 
normally.
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When you get a message from the printer with a numerical code in the form XX.XX.XX.XX:, we recommend 
locating the first two digits in the following table to identify the correct diagnostic.

Number Subsystem

01 E-box

10 E-cabinet

11 Printhead control link

17 Drying

22 Ink distribution system

41 Substrate path mechanics

43 Substrate path vacuum system

46 Printhead primers

47 Printhead cleaning roll

48 Scan beam

49 Carriage aerosol

50 Substrate-advance sensor

51 Safety interlocks

52 Drop detector

55 Carriage sensors

58 Carriage sensors

86 Scan axis

89 Illumination and buttons

NOTE: Some of these subsystems may be available only to service engineers, because they require specific 
knowledge or for safety reasons.

NOTE: In any case we recommend running the Safety Interlocks diagnostic to ensure that printing is not 
disabled by a safety interlock.
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10 Ink collector

● Use the ink collector

– Kit components

– Recommended solution space

– Install the kit

– Uninstall the kit

● Maintain the ink collector

– Summary of maintenance operations

– Clean the aerosol nozzle plate and filters

– Clean the output platen

– Wipe the ink-collector modules

– Printer maintenance

– Clean the print zone

– Replace the ink-collector foams

– Replace the aerosol extractor filters

● Troubleshooting for ink-collector-enabled substrates

– There are marks on ink collector enabled substrate

– Grain and text sharpness

– Color consistency
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Use the ink collector
Before printing on porous substrates (textile mesh, flag, and voile), you must install the ink collector kit available 
as an accessory, to protect the printer from the ink that falls through the substrate. The kit should be removed 
before printing on non-porous substrates.

CAUTION: Ensure that the operating temperature of the substrate recommended by the manufacturer is not 
exceeded. If this information is not available, ask the manufacturer.

CAUTION: Proper maintenance and genuine HP consumables are required to ensure that the printer operates 
safely as designed. The use of non-HP consumables (foams, filters, printhead cleaner roll, and inks) may present 
a risk of fire.

CAUTION: Do not load substrates with auto-ignition temperatures below 250°C (482°F). Ensure that no ignition 
sources are close to the substrate.

Kit components

Ink collector with blue latches Ink collector with magnetic connections

1. Ink collector container

2. Ink collector with replaceable foam

NOTE: Keep the ink-collector container to protect and store the ink-collector parts when not in use.

Recommended solution space

Always use the default print-mode settings as a starting point for your substrate. The following settings provide 
good quality at nominal printing conditions for generic materials.

Green: Recommended print mode for this substrate type

Yellow: Available print mode for this substrate type
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Install the kit

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

CAUTION: Take care to store the ink-collector modules in the box with the blue latches / magnetic connections 
upwards. Let them fall gently into the box tray.

When manipulating the ink collector modules, do not hold them by the blue latches / magnetic connections. Use 
the blue latches / magnetic connections only to secure the modules once installed on the print platen.

NOTE: Depending on your printer model, the ink collector design may vary. In any case, the front side of the 
modules is the same, the only feature that can vary is the rear part to assemble.
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TIP: You are advised to wear gloves.

Install the six ink-collector modules

1. Ensure that the printer is not printing.

2. If any substrate is loaded, unload it. Then remove the edge holders from the substrate path.

3. To facilitate module installation, HP recommends raising the carriage beam to the installation position, by 
clicking the Raise carriage beam to install position button.

4. Ensure that all windows, covers and doors are closed and remain in their original position.

5. Open the ink collector container and check that the ink collector foams are dry and clean enough to be 
used.

Also check that the foams fit into the spaces provided for them. If they have expanded and no longer fit, 
replace them.

NOTE: Ensure that you dispose of the used foams correctly. Consult the guidelines from your local 
authority.

6. Go to the Internal Print Server and click the Install ink collector button on the main screen.

7. Follow the instructions in the Internal Print Server to complete the installation. If you need further 
information, read the steps below.

CAUTION: If you install the kit incorrectly, some parts of the printer may be damaged.

8. Ensure that the module latches are open (turned to the left).

NOTE: This step only applies for the design with blue latches. The design with magnetic connections does 
not need to be opened.

9. To facilitate module installation, we recommend raising the carriage beam to the installation position.
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10. Open the window.

11. Ensure that the label under the first module that you place is clean.

12. From the front on the right side, install the first module and insert it into the guide.

NOTE: At this point, you will have better access if you have raised the carriage beam.

With blue latches

With magnetic connectors
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13. Slide the module to the middle until it reaches the stop.

14. Insert all the ink collector modules on either side of the central one.

15. Attach each one inserted to a module that is already in place.
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16. Check that all the ink collector modules are aligned with each other and that there are no gaps between 
them.

17. For the blue latches: Close the latches of all modules (turn to the left).

For the magnetic connection, ensure that the rear side of the modules with the magnets is pressed down 
firmly to ensure the modules have been placed at the proper height.

18. Optionally, install the edge holders onto the ink collector modules. See Install an edge holder on page 44.

19. Close the window.

20. Click Finish to complete the ink collector installation. The carriage beam will adjust to the height of the ink 
collector.
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Uninstall the kit

TIP: You are advised to wear gloves.

Unload the substrate and remove the output spindle.

To facilitate module uninstallation, we recommend raising the carriage beam to the installation position, by 
clicking the Raise carriage beam to install position button.

Uninstall the six ink-collector modules

1. Open the three latches of each module.

NOTE: Depending on your printer model, this step may be skipped.

2. From the front of the printer, remove each module.

3. Click Finish to complete the removal process. The carriage beam moves down and the carriage moves 
along the platen for checking.

4. Check whether the foams need to be replaced; if so, replace them. Store them in the ink collector container, 
keeping the latches on top.

5. Perform the maintenance operations recommended after uninstalling the kit (see Summary of 
maintenance operations on page 121).
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Maintain the ink collector

Summary of maintenance operations

Frequency Maintenance operation Part number and description

Every 80 liters of ink Replace the ink-collector foams on page 122  

Every 160 liters of ink Replace the aerosol extractor filters on page 123  

After uninstalling the ink 
collector kit, or at the end of 
each roll

Clean the aerosol nozzle plate and filters on page 147  

Wipe the ink-collector modules on page 121  

Clean the platen on page 144  

After uninstalling the ink 
collector kit

Printer maintenance on page 121  

Clean the print zone and the substrate edge holders on page 143  

Clean the substrate-advance sensor on page 145  

Clean the aerosol nozzle plate and filters

See Clean the aerosol nozzle plate and filters on page 147.

Clean the output platen

See Clean the platen on page 144.

Wipe the ink-collector modules

Wipe all dirty surfaces, especially the ribs that are in contact with the substrate (see Clean the ink-collector ribs 
on page 149). If necessary, replace the foams (see Replace the ink-collector foams on page 122).

CAUTION: Proper maintenance and genuine HP consumables are required to ensure that the printer operates 
safely as designed. The use of non-HP consumables (foams, filters, printhead cleaner roll, or inks) may present a 
risk of fire.

Printer maintenance

First ensure that you have turned the printer off, and be careful to follow the appropriate safety precautions.

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

After using the ink collector kit, the following parts of the printer may be dirty. Check them as follows.
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Bottom plate

1. Open the vapors extraction channel / output cover so that you can access the bottom plate.

2. Wipe the bottom plate with a lint-free cloth dampened with distilled water, and make sure that the platen 
is dry before printing. See also General cleaning instructions on page 12.

WARNING! Although the contact heater turns off automatically when the covers are opened, check the 
temperature to avoid burns. It is recommended that this process is carried out with the contact heater at 
room temperature and, if necessary, use protective gloves.

Top diverter profile

1. Wipe the top diverter profile with a lint-free cloth dampened with distilled water, and make sure that the 
platen is dry before printing. See also General cleaning instructions on page 12.

2. Close the window.

Clean the print zone

See Clean the print zone and the substrate edge holders on page 143.

Replace the ink-collector foams

TIP: Do this away from the printer to avoid ink dripping on the printer.

1. Slide out the dirty old foams.
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NOTE: Consult your local authorities to determine the correct manner in which to dispose of them.

2. Slide in the new foams.

CAUTION: Proper maintenance and genuine HP consumables are required to ensure that the printer 
operates safely as designed. The use of non-HP consumables (foams, filters, printhead cleaner roll, or inks) 
may present a risk of fire.

Replace the aerosol extractor filters

1. HP recommends wearing gloves for this task.

2. Open the main window to access the aerosol extractor filters.
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3. Remove the dirty filters.

NOTE: Consult your local authorities to determine the correct manner in which to dispose of them.

4. Insert new filters. Ensure that the new filters are kept within the frame of the extractor, and be careful not 
to leave gaps between them.
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Troubleshooting for ink-collector-enabled substrates

There are marks on ink collector enabled substrate

This problem can occur if any component in contact with the substrate is dirty or damages the substrate or its 
coating. Verify the pressure of the pinchwheels is correct, check for excessive dirt in the diverters, print platen, 
and especially the ink collector foams, and clean them if necessary.

If marks are continuous along the advance of the plot, verify substrate condition looking for unevenness in the 
coating of the material in the input side of the printer.

Grain and text sharpness

This problem mainly occurs when printhead calibration or substrate advance are not correct.

Printhead alignment on porous substrate may be difficult because alignment plot lines can be printed in the 
mesh and therefore not visible. In such cases it is recommended to run printhead alignment on a self adhesive 
vinyl or a substrate with a similar width to the substrate to be printed on.

With substrate advance when using the ink collector, OMAS is automatically disabled and therefore substrate 
advance is controlled by the drive roller encoder. Manual advance calibration adjustment can be used while 
printing in order to correct the advance factor for best results with the material used. If experiencing problems 
with substrate advance, pay special attention to substrate deformation as textile materials can be easily 
stretched when applying incorrect tensions, and produce advance problems. Refer to the default settings for you 
material.

Color consistency

Due to the porosity and unevenness of textile and mesh materials, color calibration is not enabled, and color 
consistency between rolls, printheads, or printers is not assured. In order to improve color consistency for long 
runs, make sure that substrates from the same batch are used. In order to ensure color consistency between 
printers, external profiling of the material is required.

Below is an example of color differences from using the same material from different batches:
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11 Dual-roll accessory

This printer is compatible with the dual-roll accessory. For information on using the accessory, see its own user 
guide or maintenance and troubleshooting guide.
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12 Hardware maintenance

WARNING! Hardware maintenance may be performed by trained personnel only. During printer installation, the 
designated personnel received training for safe operation and maintenance of the printer. It is not allowed to use 
the printer without this training.

● Safety precautions

● Maintenance resources

● Summary of maintenance operations and kits

● How to perform maintenance operations

● How to turn the printer off and on for maintenance operations

● Weekly maintenance

● 80 liter maintenance

● 750 liter maintenance

● 1500 liter maintenance

● When required
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Safety precautions
Read and follow the safety precautions section to make sure you use the equipment safely: see Safety 
precautions on page 3.

You are expected to have the appropriate technical training and experience necessary to be aware of hazards to 
which you may be exposed in performing a task, and to take appropriate measures to minimize the risks to 
yourself and to others.

Maintenance resources

Maintenance kits and tools

User maintenance operations and their timing are described in the following chart.

The printer comes with a cleaning kit, in-box material, and printer maintenance kit (PMK). These cover all 
maintenance operations during the first months, and consist mainly of printer requested cleaning operations via 
Print-Care.

The SMK (service maintenance kit) is also requested by the printer and needs to be acquired. The service team or 
technical support should perform SMK operations.

Kits and parts required for maintenance operations are shown below:

Name Part number Purpose How to order

Printer cleaning kit K4T88-67255 
(inside printer)

User maintenance

For daily and weekly maintenance 
checks and cleaning

Provided with the printer and included in 
the printer maintenance kit. Covers all 
required maintenance up to 900 L.

Printer maintenance kit 4DC17-67115 
(inside printer)

User maintenance

For 1500 liter maintenance. Printer life, 
approx. 1.5M carriage cycles*

The first PMK is provided with the 
printer; it covers all required 
maintenances up to 2250 liters, and 
includes 750 liter maintenance material 
up to 3 maintenances and one cleaning 
kit.

Service maintenance kit K4T88-67260 
(order/buy when 
required)

SMK1 for 5 million carriage-cycle 
maintenance routine

SMK2 for 10 million carriage-cycle 
maintenance routine*

Through the usual channel

NOTE: For the latest information on kits available for your printer and their contents, see http://hp.com.

*Frequencies are approximate and will depend on print mode usage.
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Up-time user spare parts kits

Name Part number Purpose How to order

Basic uptime kit (optional) 4DC17-67112 Set of spare parts that can be replaced 
by customers and resolve the most 
common failures

Provided with your printer in most 
locations worldwide. If necessary, you 
can purchase the kit through the usual 
channel.

Expert user kit (optional) 4DC17-67113 Set of spare parts that due to their 
technical complexity, can be replaced 
only by trained customers

Through the usual channel. Requires 2 
days training.

Basic uptime kit contents

● Two substrate edge holders and 24 straps

● E-cabinet fuses

● Service station caps

● Ink supply module intermediate tank

● Printhead cleaning rubber

● Printhead cleaning rubber free hub

● Prime and latch

● Spectrophotometer shutter

Expert user kit contents

● Spindle air valve

● Scan-axis bump

● Impelling belt

● Impelling tensioner

● Spectrophotometer

● Printhead interconnect

● Ink delivery system air pump and valve

● Drying diffusor

● Drying heater/fan

● Drying PCA

● Carriage oiling felts

● ISM pressure sensor

ENWW Maintenance resources 129



Printer cleaning kit contents

Part Quantity  

Flex cleaner and 12 flex sponges 1  

Cleaning Brush 1  

Cotton swabs 100  

SAX Lubricant oil 4 bottles  

Cleaning sponges 12  

Plastic gloves 24  

Grease for substrate advance worm 1  

Grease syringe 1 3 ml bottle  

Filters (e-cabinet, e-box) 6  

Filters for drying EE fan 2  

Key for carriage bearings wicks/felts replacement 1  

Printer maintenance kit contents

Content Quantity  

Printer cleaning kit 1  

Carriage oiling felts 1 kit  

Printhead cleaning blades 3  

Intermediate tanks 4  

Service station cap assembly 1  

NOTE: The contents of the kit may vary.

NOTE: Some keys are provided with the printer. See Safety precautions on page 3 to identify the one you may 
require for maintenance operations.

Use the keys only for accessing the intended doors and keep them always under your control. Store them in a 
safe and secure place.
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Maintenance tools recommended but not provided

Spiral brushes, for Clean the bottom of the 
carriage and the line sensor on page 152

Absorbent all-purpose cloth, for cleaning 
covers, sensors, and delicate parts

Distilled water for general cleaning

Vacuum cleaner, handy or normal, with 
nozzle accessories; for Clean the scan-axis 
beam on page 204

Flashlight, for general use Folding steps, for general use

A flat screwdriver Allen keys Torx screwdriver set
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Summary of maintenance operations and kits
Periodical maintenance operations

Frequency Maintenance operation Cross-reference Part number and description

Weekly Check and clean the printer, print 
zone, and output platen

Check and clean the printer, print 
zone, and output platen on page 143

Printer cleaning kit, provided with 
your printer

Recommended when using the ink 
collector: every roll switch, or when 
uninstalling the ink collector.

Clean the aerosol nozzle plate and 
filters

Clean the aerosol nozzle plate and 
filters on page 147

 

Clean ink-collector ribs Clean the ink-collector ribs 
on page 149

Printer cleaning kit, provided with 
your printer

Recommended when using the ink 
collector: every roll switch, or when 
uninstalling the ink collector.

Extract and rotate the black ink 
cartridge

Insert an ink cartridge on page 78

Every 80 liters of 
ink

Check and clean the printer, print 
zone, and output platen

Check and clean the printer, print 
zone, and output platen on page 143

Printer cleaning kit, provided with 
your printer

Clean the bottom of the carriage and 
the line sensor

Clean the bottom of the carriage and 
the line sensor on page 152

Printer cleaning kit, provided with 
your printer

Clean the drop detector and the 
capping station

Clean the drop detector and the 
capping station on page 154

 

Clean the e-box fan filter and the 
right dryer-PCA fan filter

Clean the e-box fan filter and the 
right dryer fan filter on page 156

Printer cleaning kit, included in your 
printer

Clean the e-cabinet fan filters Clean the e-cabinet fan filters 
on page 160

Printer cleaning kit, included in your 
printer

Clean the vapors extraction channel / 
output cover

Clean the vapors extraction channel / 
output cover on page 161

 

Clean the carriage cooling fan Clean the carriage cooling fan 
on page 166

Printer cleaning kit, included in your 
printer

Clean the left dryer-PCA fan filters Clean the left dryer fan filter 
on page 167

 

Empty printhead waste bottle Empty the printhead cleaning waste 
bottle on page 169

 

Every 750 liters 
of ink

Clean the substrate drive 
transmission

Clean the substrate drive 
transmission on page 174

 

Clean the pinchwheels and drive 
roller

Clean the pinchwheels and drive 
roller on page 175

 

Clean and lubricate the scan axis and 
mechanical transmissions

Clean and lubricate the scan axis and 
mechanical transmissions 
on page 176

 

Clean and lubricate the drop-detector 
rods

Clean and lubricate the drop-detector 
rods on page 178
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Periodical maintenance operations (continued)

Frequency Maintenance operation Cross-reference Part number and description

Clean the scan-axis encoder Clean the scan-axis encoder 
on page 178

Every 1500 liters 
of ink

(Preventive 
Maintenance Kit, 
service included 
in some 
contractual 
modes)

Grease the printhead primers Grease the printhead primers 
on page 181

Clean impelling dust in scan axis 
chain

Clean impelling dust in scan-axis 
chain on page 182

 

Clean the drying fans and diffuser Clean the drying fans and diffuser 
on page 183

 

Clean the drop-detector encoder strip Clean the drop-detector encoder strip 
on page 185

Replace the carriage felts and clean 
and oil the scan axis and rods

Replace the carriage oil felts and 
wicks on page 186

Replace the intermediate tanks Replace the intermediate tanks 
on page 187

 

Replace the e-cabinet fan filters Replace the e-cabinet fan filters 
on page 188

Replace e-box fan filter Replace e-box fan filter on page 190

Replace dryer fan filter Replace the dryer fan filters 
on page 192

Replace a service station cap Replace a service station cap 
on page 194

K4T88-67073: SVS Caps Kit, included 
in the basic uptime kit

Replace the aerosol extractor filters Replace the aerosol extractor filters 
on page 195

 

Replace the printhead cleaning blade Replace the printhead cleaning blade 
on page 199

 

Every 3000 liters 
of ink (or 5 
million scan-axis 
cycles)

To be done by a service engineer. Call 
your service representative (see 
HP Customer Care Centers 
on page 268).

Every 6000 liters 
of ink (or 10 
million scan-axis 
cycles)

To be done by a service engineer. Call 
your service representative (see 
HP Customer Care Centers 
on page 268).

When-required maintenance operations

Frequency Maintenance operation Cross-reference Part number and description

When required Printer safety check Printer safety check on page 203  

Check and clean printheads Check and clean the printheads 
on page 84

 

Clean the scan-axis beam Clean the scan-axis beam 
on page 204

 

Clean the printhead contacts Clean the printhead contacts 
on page 207
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When-required maintenance operations (continued)

Frequency Maintenance operation Cross-reference Part number and description

Clean the carriage rails manually Clean the carriage rails manually 
on page 211

 

Check and clean dirt from scan axis 
and mechanical transmissions

Check and clean dirt from scan axis 
and mechanical transmissions 
on page 213

 

Replace a pinchwheel submodule Replace a pinchwheel submodule 
on page 214

 

Replace a primer and latch Replace a primer and latch 
on page 216

K4T88-67013: Primer and latch, 
included in the basic uptime kit

Replace the aerosol fan module 
(trained expert users only)

Replace the aerosol fan module 
(trained expert users only) 
on page 220

K4T88-67003: Aerosol top case 
assembly, included in the basic 
uptime kit

Replace an intermediate tank Replace an intermediate tank (trained 
users only) on page 224

CZ056-67073: ISM intermediate 
tank, included in the basic uptime kit

Replace an e-cabinet fuse Replace an e-cabinet fuse 
on page 224

K4T88-67209: E-cabinet PCA Fuses 
Kit, included in the basic uptime kit

Replace a spindle valve Replace a spindle valve on page 227  

Replace pinch clamp Replace the pinch clamp 
on page 227

 

Replace spindle gear and end cap Replace spindle gear and end cap 
on page 228

 

Replace the drying fan and resistor 
module

Replace the drying fan and resistor 
module on page 233

 

Replace the spectrophotometer 
shutter

Replace the spectrophotometer 
shutter on page 237

The table below includes cleaning or replacement of basic parts. The tools are included in kits.

On demand oiling and greasing operations

Clean and grease operations Cross-reference Part number and description

Grease the printhead primers Grease the printhead primers on page 181 Printer cleaning kit, provided with your 
printer
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ON demand operations and customer replaceable parts (CSR)

Frequency Maintenance operation Cross-reference Part number and description

Operations and 
parts to be 
replaced as 
required, on 
demand in case 
of breaks or low 
performance

Clean the printhead pocket and 
electrical contacts

Clean the printhead contacts 
on page 207

Printer cleaning kit, provided with 
your printer

Clean the pinchwheels and drive 
roller

Clean the pinchwheels and drive 
roller on page 175

 

Clean and check substrate advance 
sensor

Clean the substrate-advance sensor 
on page 145

 

Grease the printhead primers Grease the printhead primers 
on page 181

 

Replace a primer and latch Replace a primer and latch 
on page 216

K4T88-67013: Primer and latch, 
included in the basic uptime kit

Replace the aerosol module fans Replace the aerosol fan module 
(trained expert users only) 
on page 220

K4T88-67003: Aerosol top case 
assembly, included in the basic 
uptime kit

Replace a service station cap Replace a service station cap 
on page 194

K4T88-67073: SVS Caps Kit, included 
in the basic uptime kit

Replace an intermediate tank Replace an intermediate tank (trained 
users only) on page 224

CZ056-67073: ISM intermediate 
tank, included in the basic uptime kit

Replace an e-cabinet fuse Replace an e-cabinet fuse 
on page 224

K4T88-67209: E-cabinet PCA Fuses 
Kit, included in the basic uptime kit

Replace an edge holder strip Replace an edge holder strip 
on page 45

 

Replace the spectrophotometer 
shutter

Replace the spectrophotometer 
shutter on page 237

 

Pinch clamp replacement Replace the pinch clamp 
on page 227

 

Replace a pinchwheel submodule Replace a pinchwheel submodule 
on page 214

 

Replace spindle valve Replace a spindle valve on page 227 K4G10-67094: Spindle air valve, 
included in the basic uptime kit

Replace the printhead cleaning blade Replace the printhead cleaning blade 
on page 199

 

Replace spindle gear and end cap Replace spindle gear and end cap 
on page 228

 

Replace a spindle valve Replace a spindle valve on page 227  

How to perform maintenance operations
The Maintenance section of the Print Care program (see HP Print Care on page 110) reminds you when routine 
hardware maintenance should be done.
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Perform maintenance with Print Care wizards

If your printer is connected to the Internet, Print Care provides guidance (wizards) to help you to perform the 
maintenance operations correctly. Click the maintenance operation and the wizard will appear; then follow its 
instructions.

IMPORTANT: Strictly follow all the recommended steps for safety reasons. For example, switching the printer 
off protects you from electric shock and hazardous moving parts, among other risks; it may also be required for 
other reasons.

IMPORTANT: Follow the wizard to the end so that the appropriate alert is reset automatically.

The wizard has the necessary buttons so that all printer actions, such as moving the carriage beam, can be done 
directly from the wizard when they are needed.

It also provides instructions to replace parts and resolve the most common failures.

Because this information is in the HP cloud, HP can update and improve it so that Print Care will always show the 
latest version.
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Perform maintenance without Print Care wizards

IMPORTANT: If your printer is not connected to the Internet, you must perform maintenance operations 
manually with the help of this guide. Without a connection:

● The alerts are never reset. Both the Internal Print Server and Print Care always show a red alert for 
maintenance status.

● Tracking the maintenances must be done manually, according to the time and ink usage thresholds shown 
in the Summary of maintenance operations and kits on page 132.

● This guide appears in the Print Care window, for reference, instead of the list of maintenances.

HP strongly recommends an Internet connection as it makes it much easier to deal with the maintenance tasks 
of the printer, in addition to providing auto-update of the maintenance procedure and automatic notification of 
firmware upgrades. Contact your service representative for more information.

IMPORTANT: Strictly follow all the recommended steps for safety reasons. For example, switching the printer 
off protects you from electric shock and hazardous moving parts, among other risks; it may also be required for 
other reasons.

The following printer-system movements and processes are required during maintenance operations. The 
Printer tools menu in Print Care can be used when the printer is not connected to the Internet. Remember to 
follow all the safety precautions.

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3
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● To move the carriage beam, click Printer tools > Move the carriage beam.

– Move up

– Move down

 

● To move the printhead carriage, click Printer tools > Move the printhead carriage.

– Move to the service position

– Move to the leftmost position

– Move to the normal position

 

● To move the drive roller, click Printer tools > Move the drive roller.

– Move (backwards)

– Move (forwards)

– Stop
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Other warnings

– Keep your clothing and all parts of your body away from the printer's moving parts.

– Avoid wearing necklaces, bracelets, and other hanging objects.

– If your hair is long, try to secure it so that it will not fall into the printer.

– Do not touch gears or moving rolls during printing.

● To move the rubber blade, click Printer tools > Move the rubber blade.

– Move to service position

– Move to normal position

How to turn the printer off and on for maintenance operations
IMPORTANT: When performing maintenance operations, always turn the printer off and on as described below. 
Do not use the normal procedure.

IMPORTANT: Strictly follow all the recommended steps, for safety reasons.

NOTE: If your printer is connected to the Internet, you do not need to remember these instructions, because 
they are included in the maintenance wizards.

Turn the printer off

1. In Print Care, click Printer tools > Power options > Shutdown.
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CAUTION: The shutdown process takes some time to complete. Wait until the green power light is off 
before proceeding.

2. Turn off the printer using the main switch at the front right of the printer.

CAUTION: With this procedure, the printhead carriage will not return to the normal position, and therefore 
the printheads will remain uncapped. Make sure the maintenance operation is done quickly to minimize the 
time in which the printheads are uncapped.

Turn the printer on

1. Turn on the printer using the main switch at the front right of the printer.
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2. Pay attention to the Internal Print Server and rearm the printer when requested, as usual.

CAUTION: In some maintenance procedures, the carriage beam is up when you turn on the printer, and the 
carriage moves during initialization. Avoid putting any part of your body in the print area.

Weekly maintenance
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the 
appropriate safety precautions.

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

The following maintenance procedures are required weekly:

● Prepare for the weekly maintenance

● Check and clean the printer, print zone, and output platen

● Clean the aerosol nozzle plate and filters

● Clean the ink-collector ribs

● Extract and rotate the black ink cartridge

● Complete the weekly maintenance

Prepare for the weekly maintenance

1. Ensure that the printer is not printing.

2. Unload the substrate.
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3. Ensure that all windows, covers, and doors are closed and remain in their original positions.

4. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.
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Check and clean the printer, print zone, and output platen

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

Check and clean the printer

1. Check the printer for dust and aerosol on the covers, windows, computer screen etc.

2. If condensation is seen on the inside of the window over the middle of the printer, wipe it with a dry cloth. 
Use folding steps to reach the inside of the window.

*Some cleaning operations are on demand depending on your print duty cycle, substrates or print modes 
used, and environment.

Clean the print zone and the substrate edge holders

The platen should be cleaned whenever it is visibly dirty, or when you notice marks on the back of the substrate.

If you sometimes print with very small side margins and with substrate edge holders, ink may accumulate on the 
edge holders, which can cause smears on your prints and blocked nozzles in the printheads.

Clean the substrate edge holders (if they are in use)

1. Open the window.
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2. Remove the two substrate edge holders from the platen.

3. Check the substrate edge holder strips for dried ink or any other defect. Clean the ink with a lint-free cloth 
dampened with distilled water.

4. If necessary, replace the edge holder strips. See Replace an edge holder strip on page 45.

Clean the platen

1. Clean the platen with a clean cloth dampened with distilled water. Be very careful not to touch the 
printheads

2. Check the print zone and remove any dirt, aerosol, or ink from the platen. Check and clean the substrate 
paths, focusing on the bottom-plate zone. Check the print output areas for ink drops, aerosol, or 
condensation.

See also General cleaning instructions on page 12.

Clean the vapors extraction channel / output cover

▲ Follow the steps in the section Clean the vapors extraction channel / output cover on page 161.

Clean the output platen lights

▲ Clean the output platen lights with a clean cloth or a piece of cellulose paper dampened with distilled water. 
See also General cleaning instructions on page 12.
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Clean the bottom plate

1. In order to clean the bottom plate, access it from the top of the vapors extraction channel / output cover. 
See General cleaning instructions on page 12.

2. After cleaning, ensure that the cleaned parts are completely dry and all vapor has completely evaporated.

Clean the substrate-advance sensor

Remember that porous substrates, or substrates with porous liners, are not supported without the ink collector 
accessory and should not be used with your printer. However, under normal printing conditions with non-porous 
substrates, some dirt, dust, and ink aerosol can reach the substrate-advance sensor window and impair the 
performance of the sensor.

1. Open the window.
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2. Find the sensor in the middle of the platen.

3. Clean the platen area around the sensor thoroughly with a lint-free cloth dampened with distilled water. 
See General cleaning instructions on page 12.

4. Wipe the sensor window with a cotton swab. If the sensor window is heavily coated with dry ink, you may 
need to apply some pressure while wiping, helping the cotton to absorb the ink. See also General cleaning 
instructions on page 12.

5. Continue cleaning with fresh swabs until the cotton stays clean and the sensor window looks clean.

TIP: When reflecting ambient light, a clean sensor window shows a blue-colored reflection that should 
extend uniformly across its whole surface. You can see this reflection by moving closer and slightly 
changing your angle of view.

6. Close the window.
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Clean the aerosol nozzle plate and filters

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

The aerosol nozzle plate and fliters should be kept clean for optimal performance and reliability. In some 
printing situations, with high scan beam or textile materials, more aerosol is generated, which can block the 
aerosol removal system nozzle or filter.

1. Open the carriage cover.
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2. Open one latch on the right side of each aerosol filter module.

3. Open the lid of each filter.

4. Remove both aerosol filters, using their handles.
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5. Use a flat screwdriver to remove the dry aerosol and then a brush to remove any remaining dirt. Try to 
avoid loose dirt falling into the filter.

TIP: It is recommended to remove the filter from the frame, for better access to the nozzle plate.

IMPORTANT: Be sure to reinstall the filter on the frame before you reinstall it on the printer.

6. Wipe off all wet ink from the aerosol nozzle plate and frame.

7. Reinsert both filters. There is only one way to insert them that works. If you feel resistance, try to insert the 
filter the other way round.

8. Close the lids.

9. Close the latches.

10. Manually move the printhead carriage to the right, on top of the capping station.

11. Close the carriage cover.

Clean the ink-collector ribs

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3
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The ribs should be cleaned whenever they are visibly dirty, or when you notice marks on the back of the 
substrate.

Clean the ribs

▲ Clean the ribs with a clean cloth dampened with distilled water. See also General cleaning instructions 
on page 12.

CAUTION: Take care with the dryer outlets to avoid cutting your fingers.

Extract and rotate the black ink cartridge

In order to maintain the best print quality, the black cartridge should be disconnected and rotated every week. 
For further information see the following instructions:

See the instructions in the section Insert an ink cartridge on page 78.

See also the instructions in the section Maintain the ink cartridges on page 80.

Complete the weekly maintenance

1. Ensure that the cleaned parts are completely dry and that all moisture has evaporated.

2. Ensure that all windows, covers, and doors are closed and remain in their original positions.

3. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.

4. Click Next to run a diagnostic test to check that the substrate-advance sensor is working correctly.
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80 liter maintenance
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the 
appropriate safety precautions.

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

The following maintenance procedures are required every 80 liters:

● Prepare for the 80 liter maintenance

● Clean the bottom of the carriage and the line sensor

● Clean the drop detector and the capping station

● Clean the e-box fan filter and the right dryer fan filter

● Clean the e-cabinet fan filters

● Clean the vapors extraction channel / output cover

● Clean the carriage cooling fan

● Clean the left dryer fan filter

● Check the substrate drive transmission

● Empty the printhead cleaning waste bottle

● Carbon filter replacement

● Complete the 80 liter maintenance

Prepare for the 80 liter maintenance

1. Ensure that the printer is not printing.

2. Unload the substrate.

3. Ensure that all windows, covers, and doors are closed and remain in their original positions.

4. In Print Care, click Printer tools > Move carriage beam > Move up to move the carriage beam to its highest 
position.

5. Click Next to run the diagnostic to move the drop detector and carriage to the service position.
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Clean the bottom of the carriage and the line sensor

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

Tools required:

Clean the carriage bottom

1. Open the window.
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2. Open the carriage cover.

3. Manually move the printhead carriage and place it above the printhead cleaning roll.

4. Unlock and open the printhead cleaning roll door.

5. Clean the carriage bottom with a lint-free cloth dampened with distilled water. Be very careful not to touch 
the printhead nozzles. See also General cleaning instructions on page 12.

Clean the sensors

▲ Wipe both line sensors and the spectrophotometer with one of the cotton swabs provided in the Printer 
Cleaning Kit, slightly dampened (see General cleaning instructions on page 12).
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Finish off cleaning the carriage bottom

▲ Manually move the carriage to the right, on top of the capping station.

Clean the drop detector and the capping station

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

Clean the drop detector

1. Open the carriage cover.

2. Put on gloves to protect your hands.
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3. Clean the top surface of the service station with a dampened lint-free cloth. See General cleaning 
instructions on page 12.

4. Take special care when cleaning the metallic plates close to the drop-detector module.

Clean the capping station

1. Manually move the printhead carriage to the left to access the capping station.

2. Clean the top part of the capping station modules using a lint-free cloth dampened with distilled water.

3. Manually move the carriage to the right, on top of the capping station.
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Clean the e-box fan filter and the right dryer fan filter

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Moving fan blades

For more safety information, see Safety precautions on page 3

Clean the e-box fan filter

1. Locate the rear right panel assembly.

2. Remove the two T-20 screws that attach the rear right panel assembly.

3. Remove the rear right panel assembly.

4. Remove the T-20 screw from the e-box support and pull it out carefully.
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5. Pull off the plastic fan filter cover.

6. Take the fan filter and clean it by blowing it with the air gun. Be careful to put it back correctly: it must cover 
the fan’s square surface.

WARNING! The air gun provided with the printer is intended only to inflate the spindle. When 
recommended to use it for cleaning purposes, make sure to do so according to local regulations, as 
additional safety provisions may apply.

7. Put back the fan cover.
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8. Return the e-box to the vertical position; insert and tighten the T-20 screw.

Clean the right dryer fan filter

1. Remove the two T-20 screws that attach the rear right panel assembly.
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2. Remove the rear right panel assembly and locate the first dryer fan filter.

3. Pull off the plastic fan filter cover.

4. Take the fan filter and clean it by blowing it with the air gun.

WARNING! The air gun provided with the printer is intended only to inflate the spindle. When 
recommended to use it for cleaning purposes, make sure to do so according to local regulations, as 
additional safety provisions may apply.

5. Put back the fan cover. Be careful to put it back correctly: it must cover the fan’s square surface.
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6. Put back the rear right panel assembly and attach it with the two T-20 screws.

Clean the e-cabinet fan filters

1. Locate the fan filters on the printer.

2. Pull off the plastic fan filter cover.

3. For each fan, take the fan filter and clean it by blowing it with the air gun. Be careful to put it back correctly: 
it must cover the fan’s square surface.

WARNING! The air gun provided with the printer is intended only to inflate the spindle. When 
recommended to use it for cleaning purposes, make sure to do so according to local regulations, as 
additional safety provisions may apply.
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4. Put back the fan cover.

Clean the vapors extraction channel / output cover

Hazardous moving part Heat hazard

For more safety information, see Safety precautions on page 3

WARNING! Depending on the use incurred since the last maintenance, some drops of condensation may fall on 
top of the contact heater when you open the output cover. We highly recommend covering the contact heater, as 
well as the spreader roller, with a leftover piece of media (as a first step) so that you do not have to perform any 
extra cleaning steps in this procedure.

1. Remove the stopper, using a flat screwdriver.
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2. Open the output cover. Leave the output cover opened for at least 10 minutes. We recommend that you 
proceed with other steps of the weekly maintenance while the output cover is open to save you time. Once 
finished with the other steps of the weekly maintenance, proceed to step 3.

3. Remove the leftover material from the contact heater and use a dry cloth to remove the aerosol from the 
different internal surfaces of the vapors extraction channel / output cover: the window as well as the 
perforated metal sheet in the lower part.
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4. Use a clean cloth dampened with distilled water to remove the aerosol from the surface of the contact 
heater.

5. Close the output cover.

6. Attach the stopper using a flat screwdriver.

7. Go to the back of the printer and open the right back panel (on the ink system side), removing the two 
screws.

8. With a dry cloth, clean the two trays (#1 & #2) that are in the extraction system (at the end of each blower 
and the exit nozzle), as well as the base of the exhaust pipe (#3).
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9. Put the left panel back in place, re-installing the two screws.
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Clean the carriage cooling fan

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

1. Open the carriage cover.

2. Move the carriage manually to the left if necessary to access the carriage cooling fan.

3. Clean the carriage cooling fan with a lint-free cloth dampened with distilled water. See also General 
cleaning instructions on page 12.

4. Ensure that the cleaned parts are completely dry and all vapor has evaporated.

5. Manually move the carriage to the right, on top of the capping station.

6. Close the carriage cover.
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Clean the left dryer fan filter

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Moving fan blades

For more safety information, see Safety precautions on page 3

1. Locate the rear right panel assembly.

2. Remove the seven screws that attach the top left perforated metal sheet.

3. Locate the fan and pull off the plastic fan filter cover.
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4. Take the fan filter and clean it by blowing it with the air gun.

WARNING! The air gun provided with the printer is intended only to inflate the spindle. When 
recommended to use it for cleaning purposes, make sure to do so according to local regulations, as 
additional safety provisions may apply.

5. Put back the fan cover. Be careful to put it back correctly: it must cover the fan’s square surface.
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Check the substrate drive transmission

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Risk of cutting fingers

For more safety information, see Safety precautions on page 3

NOTE: Open the window and check visually the status of the of the drive roller gear.

If it is lacking grease, follow the next steps. This maintenance is expected to be more recurrent with higher 
production volumes.

1. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

2. Open the loading table.

3. Carefully raise the plastic cover.

4. Clean the bronze gear through the space created, taking care not to damage the encoder.

5. Grease the transmission through the gap.

Empty the printhead cleaning waste bottle

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

1. Unlock and open the printhead cleaning roll door.
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2. Remove the waste bottle.

TIP: You are recommended to wear gloves for this operation.

3. Empty the waste bottle.

NOTE: The bottle contains a mixture of ink additives and water. Dispose of this mixture according to local 
regulations. You can find the Safety Data Sheets (SDS) for the ink at http://www.hp.com/go/msds.

4. Put the emptied bottle back in place. Take care that the mouth of the bottle is well positioned to receive the 
liquid falling from above.

5. Close and lock the printhead cleaning roll door.
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Carbon filter replacement

The carbon filter has an average life span corresponding to 80 liters of ink consumption. We highly recommend 
that you replace it as soon as Print Care notifies you (first front panel advisory). Once the carbon filter has arrived 
to the end of its life (second advisory) it will no longer work properly, and it will be your responsibility to replace 
it. Follow these instructions to replace it.

Replacement procedure

1. To remove the old filter, rotate it anti-clockwise until reaching the limit and take it out.

2. After removing the old filter, place the adaptor on top of the exhaust.

3. Press it down to ensure that it is in the right position touching the cover.
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4. Place the filter on top of the adaptor making sure to insert the three pins.

5. Once the pins are inserted, rotate the filter clockwise to guide it to the final position.

Complete the 80 liter maintenance

1. Ensure that the cleaned parts are completely dry and that all moisture has evaporated.

2. Ensure that all windows, covers, and doors are closed and remain in their original positions.

3. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.

4. Finish the drop-detector diagnostic. Click Next even if the diagnostic fails, as the cleaning has already been 
completed.
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750 liter maintenance
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the 
appropriate safety precautions.

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

The following maintenance procedures are required every 750 liters:

● Clean the substrate drive transmission

● Clean the pinchwheels and drive roller

● Clean and lubricate the scan axis and mechanical transmissions

● Clean and lubricate the drop-detector rods

● Clean the scan-axis encoder

● Complete the 750 liter maintenance
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Clean the substrate drive transmission

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Risk of cutting fingers

For more safety information, see Safety precautions on page 3

1. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

2. Open the loading table.

3. Carefully raise the plastic cover.

4. Clean the bronze gear through the space created, taking care not to damage the encoder.

5. Grease the transmission through the gap.
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Clean the pinchwheels and drive roller

Crush hazard Risk of trapped fingers Hazardous moving part

For more safety information, see Safety precautions on page 3

The drive roller should be cleaned whenever it is visibly dirty, or when you notice that substrate advance is no 
longer smooth and regular.

Prepare to clean the pinchwheels and drive roller

1. Ensure that the printer is not printing.

2. Unload the substrate.

Clean the pinchwheels

1. Open the latches.

2. Pull the pinchwheel module to its lowest position.
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3. Clean the pinchwheels carefully with a cloth dampened with water; do not use petroleum-based cleaning 
liquids.

Clean the drive roller

1. In Print Care, click Printer tools > Move the drive roller > Move (backwards) to start the drive roller moving 
slowly backwards.

2. Clean the roller with a clean cloth dampened with water; do not use petroleum-based cleaning liquids.

CAUTION: Take care not to allow the roller to trap your hands while cleaning (this is less likely if it is 
moving backwards).

3. Stop the drive roller.

4. Wait until the roller is dry.

5. Return the pinchwheel module to its original position and close the latches.

Clean and lubricate the scan axis and mechanical transmissions

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Risk of cutting fingers

For more safety information, see Safety precautions on page 3
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1. Ensure that the printer is not printing.

2. Unload the substrate.

3. Ensure that all windows, covers, and doors are closed and remain in their original positions.

4. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

5. Open the carriage cover.

6. Clean the carriage rails with a wipe. Take special care to clean the sides.

7. Lubricate the carriage rails with a few drops of oil.
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Clean and lubricate the drop-detector rods

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

1. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

2. Open the carriage cover.

3. Put on gloves to protect your hands.

4. Clean both rods with a dampened lint-free cloth. See General cleaning instructions on page 12.

5. Put a few oil drops along the drop-detector rods.

6. Close the carriage cover.

Clean the scan-axis encoder

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Moving fan blades

For more safety information, see Safety precautions on page 3

1. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.
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2. Open the window.

3. Check whether the encoder strip needs to be cleaned. If so, gently clean it with a dry lint-free cloth. Take 
special care, as the strip is weak and easy to break. Clean the dirty areas only.

Complete the 750 liter maintenance

1. Ensure that the cleaned parts are completely dry and that all moisture has evaporated.

2. Ensure that all windows, covers, and doors are closed and remain in their original positions.

3. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.

4. Run the scan-axis-length diagnostic test.

5. HP also recommends running the carriage-rail-cleaning diagnostic test.
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1500 liter maintenance
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the 
appropriate safety precautions.

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

The following maintenance procedures are required every 1500 liters:

● Prepare for the 1500 liter maintenance

● Grease the printhead primers

● Clean impelling dust in scan-axis chain

● Clean the drying fans and diffuser

● Clean the drop-detector encoder strip

● Replace the carriage oil felts and wicks

● Replace the intermediate tanks

● Replace the e-cabinet fan filters

● Replace e-box fan filter

● Replace the dryer fan filters

● Replace a service station cap

● Replace the aerosol extractor filters

● Replace the printhead cleaning blade

● Complete the 1500 liter maintenance

Prepare for the 1500 liter maintenance

1. Ensure that the printer is not printing.

2. Unload the substrate.

3. Ensure that all windows, covers, and doors are closed and remain in their original positions.

4. In Print Care, click Printer tools > Move carriage beam > Move up to move the carriage beam to its highest 
position.

5. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.
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Grease the printhead primers

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

NOTE: Perform this procedure when the system error 46.02.0Y:06 appears.

1. Open the carriage cover.

2. Manually move the printhead carriage to the left.

3. After lifting the printhead covers, two 'O' rings can be seen that seal the joints between the printhead cover 
and printhead.
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4. With a finger, apply a little grease to the 'O' rings to improve their performance.

The grease should be applied to the black rubber part only. If grease gets into the central hole, remove it 
with a toothpick or similar tool.

5. Close the printhead cover, the carriage cover, and the printhead access door.

Clean impelling dust in scan-axis chain

Crush hazard Risk of trapped fingers Hazardous moving 
part

Electric shock hazard Moving fan blades Heat hazard

For more safety information, see Safety precautions on page 3  

1. Open the window.
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2. Visually check the carriage chain for dust, debris, pieces of rubber, aerosol, and so on.

3. If any of the above are present, clean the chain with a handheld home vacuum cleaner.

Clean the drying fans and diffuser

Crush hazard Risk of trapped fingers Hazardous moving part Heat hazard

For more safety information, see Safety precautions on page 3

1. Open the latches.
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2. Pull the pinchwheel module to its lowest position.

3. Remove any dust from the drying fans with a lint-free cloth dampened with distilled water. See General 
cleaning instructions on page 12.

4. Wait until the drying fans are dry.

5. Return the pinchwheel module to its original position and close the latches.

6. Open the window.
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7. Remove any dust from the drying diffuser, clean with a brush and vacuum the outlet nozzle of the heater 
diffusers. Uninstall if not needed.

8. Close the window.

Clean the drop-detector encoder strip

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

1. Open the carriage cover.

2. Put on gloves to protect your hands.

3. If it looks dirty, clean the drop-detector encoder strip with a lint-free cloth dampened with distilled water (3 
in figure below). See General cleaning instructions on page 12.

ENWW 1500 liter maintenance 185



4. Ensure that the cleaned strip is completely dry.

5. Close the carriage cover.

Replace the carriage oil felts and wicks

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Moving fan blades

For more safety information, see Safety precautions on page 3

1. Open the carriage cover.

2. Manually move the carriage to the left; but do not leave the carriage out of its home position too long.
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3. Unscrew the felts and wicks retainers as indicated.

4. Replace the required parts (foams and/or wicks).

5. Manually move the carriage to the right, on top of the capping station.

6. Close the carriage cover.

Replace the intermediate tanks

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Moving fan blades

For more safety information, see Safety precautions on page 3

1. Ensure that you have the intermediate tank kit, which is included in the basic uptime kit.

2. Remove the screws and the cover to access the intermediate tanks.
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3. Remove all the intermediate tanks.

4. Reinstall all the intermediate tanks.

5. Replace the cover and fix with the screws.

Replace the e-cabinet fan filters

E-cabinet fan filters are provided with your printer in the printer cleaning kit. The necessary sets of two filters are 
provided; only one set is needed for this operation.

1. Locate the fan filters on the printer.
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2. Pull off the plastic fan filter cover.

3. For each fan, exchange the old fan filter for the new one provided. Be careful to place it correctly: it must 
cover the fan’s square surface.

4. Put back the fan cover.
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Replace e-box fan filter

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Moving fan blades

For more safety information, see Safety precautions on page 3

The e-box fan filter is provided with your printer in the printer cleaning kit.

1. Locate the rear right panel assembly.

2. Remove the two T-20 screws that attach the rear right panel assembly.
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3. Remove the rear right panel assembly.

4. Remove the two T-20 screws from the e-box support and pull it out carefully.

5. Pull off the plastic fan filter cover.

6. Exchange the old fan filter for the new one provided. Be careful to place it correctly: it must cover the fan’s 
square surface.

7. Put back the fan cover.
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Replace the dryer fan filters

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

CAUTION: Be careful not to damage your hands.

CAUTION: Be careful not to transfer dirt to other printer parts.

Replace the right dryer fan filter

1. Remove the two T-20 screws that attach the rear right panel assembly.
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2. Remove the rear right panel assembly and locate the first dryer fan filter.

3. Pull off the plastic fan filter cover.

4. Exchange the old fan filter for the new one provided in the printer maintenance kit. Be careful to place it 
correctly: it must cover the fan’s square surface.

5. Put back the rear right panel assembly and attach it with the two T-20 screws.

Replace the left dryer fan filter

1. Remaining with the rear right panel assembly, remove the seven screws that attach the top left perforated 
metal sheet.
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2. Locate the fan and pull off the plastic fan filter cover.

3. Exchange the old fan filter for the new one provided in the printer maintenance kit. Be careful to place it 
correctly: it must cover the fan’s square surface.

Replace a service station cap
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Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

1. Ensure that you have the service station caps kit, which is included in the basic uptime kit.

2. Open the carriage cover.

3. Manually move the printhead carriage to the left.

4. Remove the service station cap by pressing on the four lateral fixings (two each side), and pulling up.

5. Take the new service station cap and install it by pressing the fixings to lock it into position.

IMPORTANT: When in place, make sure that the rubber surface that covers the service station cap is well 
located on the four pins.

Repeat this replacement process for all service station caps that have to be replaced.

6. Manually move the carriage to the right, on top of the capping station.

7. Close the carriage cover.

Replace the aerosol extractor filters

1. HP recommends wearing gloves for this task.
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2. Open the window.

3. Remove the four dirty filters from the front side.
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4. Remove the four dirty filters from the bottom side.

NOTE: Consult your local authorities to determine the correct manner in which to dispose of the filters.

ENWW 1500 liter maintenance 197



5. Install a new set of filters: four units in the front side and four units in the bottom side.

Ensure that the new filters are kept within the frame of the extractor, and be careful not to leave gaps 
between them.
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Replace the printhead cleaning blade

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

1. Ensure that you have the printhead cleaning roll rubber blade kit, which is included in the printer 
maintenance kit but can also be purchased separately.

2. Open the carriage cover.

3. Put on gloves to protect your hands.

4. Open the pinchwheel (pull out and rotate the black plastic knob).
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5. Move the printhead cleaning material aside in order to uncover the rubber blade.

6. Move the rubber blade to the replacement position and remove it.

7. Place the new one in position.

NOTE: The black element has to stay firmly in place on the corresponding printer support.

IMPORTANT: Be careful not to damage the printhead cleaning material when replacing the rubber blade.

8. Push the printhead cleaning material back into place and close the pinchwheel (using the black plastic 
knob).

9. Close the carriage cover.
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Complete the 1500 liter maintenance

1. Ensure that the cleaned parts are completely dry and that all moisture has evaporated.

2. Ensure that all windows, covers, and doors are closed and remain in their original positions.

3. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.

4. Click Next to run the diagnostic tests that are needed.

IMPORTANT: The black element has to stay firmly in place on the corresponding printer support.
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When required
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the 
appropriate safety precautions.

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Heat hazard

For more safety information, see Safety precautions on page 3

Apart from the periodic cycle- and ink-consumption-based maintenance procedures, there are other 
maintenance tasks that have to be carried out when required:

● Printer safety check

● Check and clean the printheads

● Clean the scan-axis beam

● Clean the printhead contacts

● Clean the carriage rails manually

● Check and clean dirt from scan axis and mechanical transmissions

● Replace a pinchwheel submodule

● Replace a primer and latch

● Replace the aerosol fan module (trained expert users only)

● Replace an intermediate tank (trained users only)

● Replace an e-cabinet fuse

● Replace a spindle valve

● Replace the pinch clamp

● Replace spindle gear and end cap

● Replace the drying fan and resistor module

● Replace the spectrophotometer shutter
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Printer safety check

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

Check the status of the alarms in the IPS. Check that the beacon works and there are no critical errors. Check the 
status of door and covers, make sure they are all closed before you start to print. Make sure the carriage beam is 
in the right position, and the loading table well closed.

1. Check that all doors and covers are closed before you start to print.

2. Check that the beacon is indicating Ready.

3. Check that the carriage beam is in the right position for the task you are going to perform, see Set the 
carriage beam position on page 63 for more information. Make sure there is nothing left on the printzone 
that should not be there.

4. Check that the Internal Print Server is indicating Ready with no alerts or maintenance required. Take the 
corresponding actions if required.

5. Check the Internal Print Server that there are no messages referring to supplies.

6. Check the Internal Print Server that there are no messages referring to substrate load.

7. Check that the substrate is loaded correctly, the loading table is closed, and the substrate edge holders are 
in place.

8. Check that the cartridges and the waste bottle are correct, empty the waste bottle if needed.
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9. Check that the printhead cleaning waste bottle is correct, empty if needed.

10. Check that e-Cabinet filters are clean and the e-Cabinet is closed.

Check and clean the printheads

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

1. Go to the Internal Print Server and click Printer > Printhead cleaning.

2. Click the Check button to perform routine cleaning automatically.

Clean the scan-axis beam

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

Prepare to clean the rear scan-axis beam

1. Ensure that you have a vacuum cleaner and an absorbent all-purpose cloth (not provided).
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2. Ensure that the printer is not printing.

3. Ensure that all windows, covers, and doors are closed and remain in their original position.

4. Move the carriage to its leftmost position.

5. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

   

Clean the rear scan-axis beam

1. Open the window.
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2. Move the carriage to the IDS side of the printer.

3. Remove the screws indicated below and remove the covers.
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4. Clean the dust from the rear scan-axis beam, using a vacuum cleaner.

Alternatively, use an absorbent cloth, moistened with deionized water, to wipe off the dust. Ensure that the 
dust adheres to the cloth and does not fall into the printer.

5. Use the absorbent cloth, moistened with deionized water, to wipe off any other dirt stuck to the scan-axis 
beam.

Finish off after cleaning the rear scan-axis beam

1. Lower the transparent cover and screw it into place.

2. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.

   

Clean the printhead contacts

WARNING! This operation is limited to trained personnel only!

NOTE: During the installation of the printer, the designated personnel received training for safe operation and 
maintenance of the printer. It is not allowed to use the printer without this training.

WARNING! Read and follow the safety precautions section to make sure you use the equipment safely: see 
Safety precautions on page 3. You are expected to have the appropriate technical training and experience 
necessary to be aware of hazards to which you may be exposed in performing a task, and to take appropriate 
measures to minimize the risks to yourself and to others.
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Crush hazard Risk of trapped fingers Hazardous moving part

For more safety information, see Safety precautions on page 3

Prepare to clean the printhead contacts

1. Ensure that you have the printer cleaning kit, which is provided with your printer.

2. Ensure that the printer is not printing.

3. Identify which printheads need cleaning, usually after the Internal Print Server recommends replacing or 
reseating them.

4. Ensure that all windows, covers, and doors are closed and remain in their original position.

5. Move the printhead carriage to the service position.

6. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

  

7. Open the carriage cover.

Clean the printhead contacts (in the carriage slot)

1. Carefully remove the printheads that may need cleaning from the carriage and protect them using their 
orange sealing caps.

CAUTION: Ensure that each printhead uses its own color cap.
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TIP: Remember which printhead came from which slot; the printer will report an error if you later replace 
a printhead in the wrong slot.

2. Illuminate the printhead slot in the carriage and check the electrical connections to the printhead for dirt.

TIP: Placing some white paper behind the electrical connections will improve contrast and may help you 
to check for dirt.

3. Clean the dirty connections gently but thoroughly using a lint-free cloth. A piece of paper or cloth can be 
used to collect the dirt.

IMPORTANT: Clean in a vertical movement, horizontal movement could damage the pins.
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4. Remove the piece of paper or cloth to prevent the dirt from spreading.

5. Illuminate the printhead slot again to check that the electrical connections are now clean and undamaged.

Clean the printhead contacts (on the printhead)

1. Use an appropriate wipe that doesn’t lose fibers to carefully clean the EE connectors.

2. Attention: Only apply vertical movements because the EE connectors can be damaged if cleaned in other 
directions.

3. Take special care to clean the bottom part of the printhead pocket

4. Remove the printhead cap and locate the contacts.
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5. Clean the contacts.

CAUTION: Do not use the printhead interconnect wiper to clean the nozzles!

Finish off cleaning the printhead contacts

1. Wait until the contacts are dry.

2. Put back the printheads, each in the same slot from which it came.

3. Close the carriage cover.

4. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.

   

Clean the carriage rails manually

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3
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NOTE: Perform this procedure only if the automatic cleaning procedure fails.

Prepare to clean the carriage rails manually

1. Ensure that the printer is not printing.

2. You are recommended to wear gloves.

3. Ensure that all windows, covers, and doors are closed and remain in their original position.

4. Move the carriage beam to its highest position.

5. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

   

6. Open the front door.

Clean the carriage rails manually

1. Standing at the front of the printer, clean the front rail using a lint-free cloth dampened with distilled water. 
See General cleaning instructions on page 12.

2. Close the front door.
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3. Go to the rear of the printer and open the loading table.

4. Standing at the rear of the printer, clean the rear rail in the same way. You can access the rail from below, 
through the gap between the platen and the beam.

CAUTION: Be careful not to stain the encoder strip. Keep the cloth well away from the encoder housing.

5. Ensure that the cleaned parts are completely dry and all vapor has completely evaporated.

6. Close the loading table.

Finish off cleaning the carriage rails manually

1. Ensure that all windows, covers, and doors are closed and remain in their original position.

2. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.

   

Check and clean dirt from scan axis and mechanical transmissions

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard Moving fan blades

For more safety information, see Safety precautions on page 3

Process

1. Switch off the printer.

2. Open the window.
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3. Clean the scan axis rails with a wipe. Take special care to clean the sides.

4. Lubricate the 2 rods with a few drops of oil.

5. Run the scan axis length diagnostic test.

Replace a pinchwheel submodule

Prepare to replace a pinchwheel submodule

▲ Ensure that you have the pinchwheel assembly, which is included in the basic uptime kit.

Replace a pinchwheel submodule

1. Open the loading table.
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2. Locate the pinchwheeel submodule that needs replacement.

3. Remove the screws shown below.

4. Remove the pinchwheel cover.
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5. Remove the screws that attach the pinchwheel submodule.

6. Remove the broken submodule.

7. Place the new submodule and attach the screws.

8. Place the cover and insert the screws.

9. Close the loading table.

Replace a primer and latch

Crush hazard Risk of trapped fingers Hazardous moving part

For more safety information, see Safety precautions on page 3

Prepare to replace a primer

1. Ensure that you have the primer and latch kit, which is included in the basic uptime kit.

2. Ensure that the printer is not printing.

3. Ensure that all windows, covers, and doors are closed and remain in their original position.
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4. Move the carriage to the service position.

5. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

  

6. Open the carriage cover.

Replace a primer and latch

1. Disconnect the two primer cable connectors at the back of the printhead that needs the primer replaced.

2. Release the handle. It is not usually necessary to remove the printhead.

3. Loosen the T10 screw (do not remove the screw, just loosen it) and release the sheet metal tab.
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4. Remove the latch.

5. Stick the corresponding printhead color label on the latch. Be careful with the orientation.

6. Install the new latch with primer. Do not close the handle yet.

7. Close the sheet metal tab and tighten the T10 screw.
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8. Close the handle.

9. Connect the two primer cable connectors.

Finish off replacing a primer

1. Close the carriage cover.

2. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.
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3. Run a diagnostic test to check that the new primer is working correctly, and calibrate it.

4. Dispose of the old primer.

Replace the aerosol fan module (trained expert users only)

Crush hazard Risk of trapped fingers Hazardous moving part

For more safety information, see Safety precautions on page 3

Prepare to replace the aerosol fans module

1. Ensure that you have the aerosol fan module, which is included in the basic uptime kit.

2. Ensure that the printer is not printing.

3. Ensure that all windows, covers, and doors are closed and remain in their original position.

4. Move the carriage to the service position.

5. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

  

6. Open the carriage cover.

Replace the aerosol fan module

1. Open the aerosol fan cover, as if you were going to replace the filters. See Replace the aerosol filters 
on page 87.
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2. Remove the two screws that attach the cover, and remove the cover.
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3. Disconnect the aerosol fan cable connector.

4. Remove the main cable harness from the cover slot.

5. Close the cover.
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6. Remove the nuts from the hinges. You must hold the nuts to prevent them from falling and get lost inside 
the carriage.

7. Remove the aerosol fan module and insert the new one.

8. Put the hinges back in place, put back the nuts and tighten them.

9. Open the new aerosol fan cover.

10. Remove the two screws that attach the new fan cover, and remove the cover.

11. Connect the aerosol fan cable connectors.

IMPORTANT: Make sure the fan cable is correctly connected.

12. Route the main cable harness and insert the grommet in the cover slot. Make sure the cables are not tight 
inside the cover.

13. Install the aerosol fan cover and attach the two screws.

14. Close the cover.

Finish off replacing the aerosol fan module

1. Close the carriage cover.
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CAUTION: Do not leave anything in the way of the carriage.

2. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.

   

3. Run a diagnostic test to check that the aerosol fans are working correctly.

4. Dispose of the old aerosol module fans.

Replace an intermediate tank (trained users only)

Risk of trapped fingers Hazardous moving part

For more safety information, see Safety precautions on page 3

You will need to replace an intermediate tank if the bag breaks.

1. Ensure that you have the intermediate tank kit, which is included in the basic uptime kit.

2. Ensure that the printer is not printing.

3. In Print Care, go to the diagnostics menu and run the diagnostic 22018: Intermediate tanks replacement.

4. Follow the steps explained in the diagnostic and replace the color indicated in the alert.

Replace an e-cabinet fuse

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

CAUTION: Do not attempt to replace fuses other than those in this specific area of the e-cabinet. These are the 
only ones you are allowed to replace. Call your service representative in all other cases.
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Prepare to replace an e-cabinet fuse

1. Ensure that you have the e-cabinet PCA fuses kit, which is included in the basic uptime kit.

2. Check the Print Care error message log to find out which fuse needs to be replaced.

3. Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 139.

   

Replace an e-cabinet fuse

1. Ensure that the printer is not printing.

2. Remove the screws shown below, then remove the rear right cover.
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3. Locate the e-cabinet fuses.

4. Locate the failing fuse identified by the Print Care error message logs.

5. Pull out the fuse and insert a new one. Ensure that the new fuse matches the old one in size, rating, and 
color.

6. Run a diagnostic test to check that the new fuse is working correctly.

CAUTION: Fire risk! A blown fuse may indicate malfunctioning electrical circuits within the system. If a 
fuse trips repeatedly, call your service representative and do not attempt to replace the fuse with one with 
a higher current rating.

7. Dispose of the old fuse.

8. Put back the rear right cover and screw it into place.

9. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.
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Replace a spindle valve

Risk of trapped fingers

For more safety information, see Safety precautions on page 3

Prepare to replace a spindle valve

1. Ensure that you have the spindle air valve, which is included in the basic uptime kit.

2. Ensure that you have an 11 mm (7/16 inch) tube wrench key and the pneumatic gun.

3. Ensure that the printer is not printing.

4. Press the valve to deflate the spindle.

Replace a spindle valve

1. Remove the spindle valve with the tube wrench key.

2. Insert the new valve and tighten it. The valve must be well seated in position and firm, but do not force it 
with the key.

Finish off replacing a spindle valve

▲ Test the new valve by inflating and deflating the spindle.

Replace the pinch clamp
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Crush hazard Risk of trapped fingers Hazardous moving part Risk of cutting fingers

For more safety information, see Safety precautions on page 3

Removal

1. Ensure that the printer is not printing.

2. Turn off the printer and the power-enable switch.

   

3. Locate the pinch clamp to be replaced and open it.

4. Remove the four T-30 screws and the pinch clamp.

Installation

1. Install the new pinch clamp and attach it with the screws.

2. Perform the safety interlock diagnostic (51001).

Replace spindle gear and end cap

Risk of trapped fingers

For more safety information, see Safety precautions on page 3

IMPORTANT: Check the gears to install in each spindle, as not all can be used in any of them.

Removal

1. Remove the spindle from the printer.
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2. Place the gearwheel side in an elevated position.

3. Remove the C-clip.

4. Remove the end cap. If necessary, you can use the gear extractor to remove the end cap.
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5. Remove the gearwheel, using the gear extractor.

Installation

1. If necessary, use sandpaper for 5 minutes to increase the diameter where the gear slides in. The same 
could be done for the end cap.

One small piece of sandpaper is provided with the upgrade kit. If it is not enough, use some similar 
sandpaper.

2. In some cases, the black gear may not be well positioned: the axis on which the gear slides can have slack. 
When placing the gear, it is important that there is no slack, or it will not be possible to place the C-clip. The 
two axis positions are shown below, with the gear in two different positions:

There may be up to 2 mm of slack when moving the gear left and right.

A small steel cylinder is provided in the kit:
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a. Move the gear as far to the left as it will go.

b. Place the cylinder provided with the kit as shown in the picture below, and hold it in place.

CAUTION: Be careful not to trap your fingers.

c. Hit the right end of the cylinder with a hammer (not provided) to force the gear onto the axis.
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If necessary, try again after using the sandpaper.

3. Insert the end cap. Use sandpaper if necessary.

You can also use a flat screwdriver to fix the shaft in place (as shown), and hit the end cap with a nylon 
hammer.
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4. Insert the C-clip.

5. Put the spindle back into the printer.

Replace the drying fan and resistor module

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

Preparation

1. Move the carriage beam to the loading position.

2. Turn off the printer and the power-enable switch.

3. Open the loading table.

Removal

1. Remove the seven cover screws.
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2. Remove the cover.

3. Remove another screw.

4. Disconnect and unroute the cables (from the motor cable tie where marked).

NOTE: The red cable goes through the left cable tie and is connected to the left connector. The colored 
cable passes through the right cable tie and is connected to the middle connector. The thinnest cable goes 
through the right cable tie and is connected to the right connector.
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5. Remove the fan.

6. Remove the heater.

Installation

1. Put the heater in place with its pins.
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2. Put the fan in place with its pins.

IMPORTANT: The fan cable must go in with the hook facing to the left.

3. Insert and tighten one screw.

4. Reconnect the cables.

5. Reattach the cover with its seven screws.

Conclusion

1. Close the loading table.

2. Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 140.
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Replace the spectrophotometer shutter

Crush hazard Risk of trapped fingers Hazardous moving part Electric shock hazard

For more safety information, see Safety precautions on page 3

Removal

1. Turn off the printer and the power-enable switch.

2. Remove two cover screws from the front left cover.

3. Remove the front left cover.

4. Locate the spectophotometer shutter.
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5. Unplug the power cable.

6. Remove one screw and keep it for the new spectrophotometer.

7. Remove the spectrophotometer shutter.

Installation

1. Locate the new spectrophotometer shutter in the appropriate kit.
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2. Place it where the old one was installed and attach it with the screw.

3. Plug in the cover cable.

4. Reinstall the front left cover.

5. Turn on the power-enable switch and the printer.
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13 Troubleshoot substrate issues

● Loading issues

● Printing issues

● Print length issues
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Loading issues

The substrate cannot be loaded successfully

● A substrate cannot be loaded unless all printer subsystems (such as the ink system) are ready.

● Check that the spindle is correctly inflated.

● Try using the Internal Print Server to advance the substrate at least 3 m (10 ft), then move it back and try 
to load it again. If it will not load, perhaps the substrate is not attached to the input core: try a different roll.

● If the Internal Print Server displays a message 'The carriage beam height is not suitable for loading 
substrate', call your service representative (see HP Customer Care Centers on page 268).

The substrate has jammed

If the printer reports a substrate jam, follow these steps.

1. Press an emergency stop button as quickly as possible to minimize damage to the printheads.

NOTE: The printer may shut itself down automatically.

2. Wait about 10 minutes for the printer to cool down.

3. Open the front door.

4. Remove all substrate and pieces of substrate from the printing zone and from any other parts of the 
printer into which they may have fallen. Make sure that nothing remains on the substrate path. If you are 
unable to remove all obstructions, call your service representative (see HP Customer Care Centers 
on page 268).

5. Use Print Care to start the printer in service mode.

6. Use the Print Care diagnostic menu to raise the carriage beam, and check underneath for any pieces of 
substrate.

7. Use the same menu to lower the carriage beam to its normal position.
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8. Before restarting the printer, check that all circuit breakers are on and all emergency stop buttons 
released.

9. Use Print Care to restart the printer in normal mode.

10. Reload the substrate.

The substrate is not attached to the core and/or spindle

If the printer detects a lack of tension during the substrate check after loading, it will ask you to confirm the 
winding direction.

If the roll is not firmly attached during printing, you may see banding on your prints, or hear metallic noises.

If you see an error message numbered 41.00.00.62 or 41.00.01.62 while printing, it means that the substrate 
may have become detached from the spindle, or the core is slipping on the spindle. This could mean that you 
have reached the end of the roll, or the spindle is not correctly inflated. The substrate is automatically unloaded 
when this error occurs.

You should respond to this error in the following ways:

● Check whether you have reached the end of a roll.

● Check that the spindle is correctly inflated.

● Check that the inner diameter of each substrate core is not too large for the spindle.

If the roll is not firmly attached to the input core, proceed as follows.

1. Unload the roll from the input spindle and load it onto the output spindle. Take care to avoid telescoping.

2. Raise the pinches and, using the Internal Print Server, raise the carriage beam to its maximum height.

3. Unload substrate from the roll and pass it backwards through the printer towards the input spindle. Attach 
it to the empty core on the input spindle, securing it with adhesive tape. Wrap a couple of turns of substrate 
around the input core. Take care to align the substrate with the output roll.

4. Lower the pinchwheels.

5. Go to the Internal Print Server and click Substrate Load/Unload, then select the printer configuration and 
click Load.

6. Select the correct substrate in the Internal Print Server.

7. Click Move substrate in the Internal Print Server, then Back, and wait until all the roll has been wound onto 
the input spindle.

8. You may decide to cancel rewinding when the substrate is detached from the output roll. Then attach it to 
the output core to print immediately, or rewind it completely onto the input core if you want to remove the 
roll.

The substrate is not flat

If the substrate does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see 
defects in the printed image, such as vertical stripes. This can happen when you use thin substrate that becomes 
saturated with ink; it can also be caused by the combination of heat and vacuum pressure that is applied to the 
substrate.

242 Chapter 13   Troubleshoot substrate issues ENWW



1. Check that the substrate type you have loaded corresponds to the substrate type selected in the Internal 
Print Server and in your software.

2. If you are using a paper-based substrate, try changing to a thicker substrate, or reduce the amount of ink.

Printing issues

A spindle latch suddenly opens during printer operation

If a spindle latch is not closed before starting the substrate load, or it is opened by someone after the spindle 
was already moving or while the substrate was under tension, the spindle can move out of place. Closing the 
latch in those conditions can cause an incomplete latch engagement, and then at some point the latch may 
spontaneously open completely.

The best solution is to eliminate substrate tension, avoid spindle movement, and then close the latch properly. 
To do this, return to the substrate load/unload menu, ensure that the spindle is properly in place (in case of 
doubt, extract it a bit and then push it back fully inside again), then close the latch (the blue part should now go 
down completely).

The substrate advances with a loud continuous sound of vibration

A loud continuous sound of vibration during the substrate advance can be caused in the following ways:

● The input spindle is not applying tension.

● Wrong tension or vacuum settings result in an incorrect balance of forces on the main roller.

If you hear this sound, here are some suggestions:

1. Check that the substrate you are using is the same as the one you have selected in the Internal Print Server.

2. Check that you are using the generic substrate presets for the category. The use of incorrect values may 
result in incorrect substrate behavior.

NOTE: Only substrates with high friction along the platen or substrates that easily wrinkle with 
temperature need high output tension values. Check that your output tension is recommended for your 
substrate.

3. Check that there is no telescoping of the input roll.
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4. Reload the substrate and try to minimize skew while loading. Check that you using the correct loading 
procedure.

5. Increase the input tension in steps of +5 N/m from the recommended setting for each category until you 
eliminate the issue.

There is skew or telescoping on the output spindle

Extreme skew (approximately 10 mm peak to peak) and telescoping in the output spindle while it winds can be 
caused in three main ways:

● The substrate has not been correctly loaded and aligned during the loading procedure.

● The roll loaded on the input spindle is skewed, and this skew is transferred to the output spindle.

● The roll loaded on the input spindle has been wound with different tensions at its two ends.

Printing on rolls that are not wound accurately during manufacturing may lead to wrinkles and skew 
problems and, generally, this problem can be identified easily because you can see a loss of tension at one 
side of the substrate between the input roll and the main roller. In that case, see the relevant information 
provided in the section There are wrinkles and ink smears on the substrate on page 244.

TIP: When suffering from extreme skew that tends to increase (normally with highly temperature-sensitive 
substrates), try to use a thicker core that is not deformed by the rubber traction grooves on the spindle when 
inflated. Then follow the guidelines below for reducing skew.

Generally, the main contributor to skew is an imprecise substrate load, and the effects of that are worse with 
wide rolls. However, if you have some skew or telescoping but this does not affect your print quality, and does 
not generate wrinkles in the substrate (see There are wrinkles and ink smears on the substrate on page 244), 
there is no need to take any action. However, you are recommended to reload the substrate in order to eliminate 
any potential problem.

Some substrate rolls already come with skew; in that case the recommendations are as follows:

1. Try to load the substrate following the correct procedure, taking as a reference of the roll’s width the 
average between peaks of skew.

2. Start with the recommended configuration for each substrate, and increase vacuum and tension step by 
step, in steps of 5 mmH2O for vacuum and 5 N·m for tension.

There are wrinkles and ink smears on the substrate

Wrinkles in the substrate indicate that the substrate settings that control the substrate shape are not optimized. 
This can cause various printing defects:

● Colored bands in area fills in the vicinity of the wrinkles

● Ink smears if the printhead touches the substrate

● Cockle

● A substrate crash if the printhead's movement over the substrate is impeded

There are various reasons why wrinkles and other consequent effects could appear while printing:

● Incorrect loading of the substrate

● Incorrect routing of the substrate through the printer
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● Incorrectly positioned edge holders

● Drying temperature too high for the substrate

● Differential expansion of the substrate due to variations in temperature

● Insufficient tension settings

● Non-uniform tension across the substrate when loading

● The roll loaded on the input spindle has been wound with different tensions at its two ends.

NOTE: When printing with rolls that have not been precisely wound with the same tension along their width 
during manufacturing, you may notice that, while printing, one of the sides of the substrate between the input 
spindle and the main roller loses all tension. This may cause wrinkles on the platen or telescoping on the output 
spindle.

If your prints suffer from any of the defects caused by wrinkles, here are some suggestions.

1. Check that the substrate you are using is the same type as the one you have selected in the Internal Print 
Server.

2. Check that you are using the generic substrate preset for the substrate category. The use of incorrect 
values may cause incorrect substrate behavior.

3. Check that there is no telescoping of the input roll.

4. Reload the substrate and try to minimize skew while loading. Check that you are loading the substrate 
using the correct procedure.

5. If you have experienced a substrate crash because the lateral edge of the substrate in the print zone is not 
flat enough, and is raised or even partially cut because you are not using edge holders, then you are 
recommended to use them.

NOTE: If you are already using edge holders, check that they are correctly positioned (see The substrate 
edge holders on page 43).

6. Start with the recommended configuration for each substrate, and increase vacuum and tension step by 
step, in steps of 5 mmH2O for vacuum and 5 N·m for tension.

TIP: If you have suffered a substrate crash, try starting with step iv and moving backwards up the table 
until you find settings that work.
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7. Try increasing the drying airflow to help the substrate to dry faster.

8. Try raising the carriage beam slightly, so that the printhead is not so close to the substrate.

For information on how to adjust printer settings, see Edit a substrate preset on page 56.

There are ink marks on the substrate

This problem can occur if any component in contact with the substrate is dirty. Check the pinchwheels, bottom 
plate, print platen, vapors extraction channel / output cover, and roller, and clean them if necessary.

If the ink marks occur at the sides of the substrate and not in the center, and you are using the substrate edge 
holders, check that they are correctly placed and clean.

The substrate sticks to the platen

When the substrate sticks to the platen, the most likely causes are excessive heat applied by the drying system, 
excessive vacuum, or a dirty platen, which increases friction and can impede the substrate advance. In the latter 
case, the substrate may rise up in a bubble or wave before reaching the platen.

Here are some suggested ways to correct the problem:

1. Check that the substrate you are using is the same type as the one you have selected in the Internal Print 
Server.

2. Check that you are printing on the correct side of the substrate.

3. Check that you are using the generic substrate preset for the substrate category. The use of incorrect 
values could cause incorrect substrate behavior.

4. Reload the substrate and try to minimize skew while loading. Check that you are loading the substrate 
using the correct procedure.

5. Start with the recommended configuration for each substrate, and increase vacuum and tension step by 
step, in steps of 5 mmH2O for vacuum and 5 N·m for tension.

There are physical marks on the substrate

This only can occur when substrates sensitive to permanent deformation are used. These marks are usually 
seen in isolated areas and mainly caused by substrate tension.

Here are some suggested ways to correct the problem:

1. Check that the substrate you are using is the same type as the one you have selected in the Internal Print 
Server.

2. Check that you are using the generic substrate preset for the substrate category. The use of incorrect 
values could cause incorrect substrate behavior.

3. Reload the substrate and try to minimize skew while loading. Check that you are loading the substrate 
using the correct procedure.

4. Start with the recommended configuration for each substrate, and reduce vacuum and tension step by 
step, in steps of 5 mmH2O for vacuum and 5 N·m for tension.
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There are drops of ink on the substrate

NOTE: In the above example, the distance between the drops is about 1 cm (0.4 in).

1. If you are using the substrate edge holders, clean them.

2. Clean the sides of the printheads and the sides of the printhead slots.

3. Clean the electrical connections to the printheads. See The Internal Print Server recommends replacing or 
reseating a printhead on page 259.

Print length issues

The print is shorter than expected

Some substrates naturally contract when they are printed on and cured, this can mean the total length of the 
print is shorter than expected. If this is the case, you can expand the length of the print from the RIP, which will 
compensate for the contraction of the substrate. Alternatively, change to a less thermal-dependent substrate to 
reduce the contraction.

How to achieve better consistency between jobs of the same length

The printer has been designed to maximize consistency in the length of the printed substrate. However, there 
are external variables that can contribute to variability: substrate variations and enviromental conditions.

1. Select a substrate which is less susceptible to expansion when being printed on. Most paper-based 
substrates have a tendency to expand.

● If you need to print on a substrate susceptible to expansion:

– Ensure that the density of ink is similar between each tile (if not, the tile with less ink might be 
shorter).

– If possible, decrease the heating temperature.

– Reduce the ink restrictions as much as possible.

● Make sure that the roll is left within the room where the printer is located for at least 24 hours, this is 
to ensure the complete roll has the same temperature as the printer.

2. Do not touch the print adjustments (no change of substrate advance calibration) between tiles.

3. Print all the tiles at once.
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● Do not split the jobs at different times (1 tile one day, and the 2nd tile the 2nd day)

● Do not change the print mode or the substrate width between tiles.

To print the tiles all at once, we recommend the following:

a. Create the tiles from the Internal Print Server.

b. If you are creating the tiles from the RIP, ensure that you send all the tiles within the same jobs sent 
to the printer/Internal Print Server.

The objective is to make sure that there is no pause between the tiles. When using the Queue mode in the 
Internal Print Server, there is still a small time between jobs, which could add more variability between the 
lengths of the tiles.

4. In order to make sure that even the first tile has less difference in length compared with the other ones, 
add a top margin of 50 cm.

In case you have to reprint one tile, in order to ensure the length will be as close as the previous jobs:

● Make sure that the substrate and also the ambient temperature of the printer are the same as when 
the previous job was printed.

● Add a top margin of 50 cm.

But in any case, when having to reprint a tile later, there is a higher probability that the length will be 
different from the other tile length. The total length repeatability depends on the substrate, the changes in 
environmental conditions, and the contents of each job (mainly when the substrate is reacting differently 
depending on the ink density).
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14 Troubleshoot print-quality issues

● General advice

● What can affect print quality

● Print-quality troubleshooting
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General advice
Your printer has been designed and qualified to the highest standards to provide the optimal compromise 
between print quality and productivity. Prints for outdoor use can accommodate more visible defects as they are 
viewed from a long distance. For shorter distances, as in indoor advertising, defects need to be less visible.

In general, follow these recommendations:

● Avoid touching the substrate while printing is in progress.

● Judge the print quality after the print has been completely processed. In some cases, defects seen while 
printing disappear after the image is calendered.

● Check that the environmental conditions (room temperature and humidity) are in the recommended range. 
See Environmental specifications on page 273.

Before troubleshooting, check the following points:

● To achieve the best performance from your printer, use only genuine HP supplies and accessories, whose 
reliability and performance have been thoroughly tested to give trouble-free performance and best-quality 
prints.

● Check that the substrate type selected in the Internal Print Server is the same as the substrate type loaded 
into the printer.

CAUTION: If you have the wrong substrate type selected, you could experience poor print quality and 
incorrect colors, and perhaps even damage to the printheads.

● Check that you are printing on the right side of the substrate.

● Check that you are using in the RIP software the correct substrate preset, which includes the ICC profile for 
your substrate and print mode.

● Check whether there are any outstanding printer alerts in the Internal Print Server. React to the alert as 
instructed in this guide.

In particular:

● Make sure the substrate is flat and has no wrinkles. See Troubleshoot substrate issues on page 240.

● Check that the substrate has no skew or telescoping. Check that you are loading the substrate using the 
correct process. See Load a roll into the printer on page 47.

● For color consistency issues, check that the color calibration was performed when the substrate was added 
to the Internal Print Server. See Use a new substrate on page 55.

● Make sure it has also been performed in the current conditions, especially considering substrate batch and 
printheads. See Color calibration on page 101.

What can affect print quality

Print mode

The choice of the print mode defines the number of passes with which the job is printed and the quantity of ink 
that is used for printing. Thus, it can naturally affect overall print quality. For instance, reducing the number of 
passes reduces the time that the substrate spends in the print zone, so it decreases the drying time, which can 
cause various effects such as bleeding; and increasing the ink quantity can cause coalescence.
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Handling the print modes is explained in Create and manage print jobs on page 64. It is also possible to design 
customized print modes for cloned substrates, as explained in Handle the substrate on page 36.

Nozzle health

Bad printhead health (clogged nozzles) can cause various defects, such as horizontal banding.

See Check and clean the printheads on page 204. The check-and-clean process will check the printheads, 
recover the ones with clogged nozzles if possible, and replace the nozzles that are still clogged with healthy 
ones for printing.

Substrate settings

Substrate settings contain the system print parameters used by the printer for a given substrate. These 
parameters include: input and output tension, vacuum, drying temperature, and drying pressure. All these 
parameters can have a significant impact on print quality. For instance, insufficient drying temperature can cause 
bleeding.

Generic substrates have predefined substrate settings that are not editable. But it is possible to clone generic 
substrates and change the settings of the cloned substrates, as explained in Edit a substrate preset on page 56.

Substrate advance

Wrong or inconsistent substrate advance can be the root cause of various print-quality defects, in particular 
horizontal banding.

You can run the Pixart diagnostic test from the Print Care window, which will tell you whether the substrate-
advance sensor is working correctly or not (dirty or damaged).

If the sensor is dirty, see Clean the substrate-advance sensor on page 145. This should be done weekly in any 
case, as a part of routine maintenance.

Even if the sensor is working correctly, the substrate may not be navigable, meaning that the sensor cannot see 
it properly (as in the case of transparent substrates or substrates with a very smooth backing layer). In such 
cases, the sensor disables itself automatically, and HP recommends an alternative method: see Substrate-
advance calibration on page 107.

Printhead alignment

The concept and purpose of printhead alignment are explained in Printer calibration on page 96. Many print-
quality defects may be due to printhead misalignment. For instance, grain can be caused by wrong bidirectional 
alignment in the scan-axis direction. Also, horizontal banding can be caused by color misalignment in the print-
axis direction.

To check the alignment, see Printhead alignment diagnostics plot on page 100.

Print-quality troubleshooting
Here is a list of the most common defects. For each of these defects, there are several potential root causes, 
which can be checked and solved by one or several of the methods mentioned above.

 Banding Grain Color Ink migration Bleeding
Edge roughness, 

text quality

Passes X X   X X
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 Banding Grain Color Ink migration Bleeding
Edge roughness, 

text quality

Ink   X X   

Alignment X X X   X

Substrate advance X X    X

Substrate settings X X  X X X

Color calibration   X    

Nozzle health X      

Banding

Horizontal thin lines

These are thin lines across the entire print, at regular intervals, most easily seen in solid fills.

Likely causes

● Misalignment between colors. See Printhead alignment on page 251.

● Inaccurate substrate advance. Under-advancing causes dark lines, over-advancing causes light lines. See 
Substrate advance on page 251.

● Clogged nozzles can cause light lines. See Nozzle health on page 251.

Horizontal dark/light zone banding
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These are periodic horizontal bands formed of a light band and a consecutive darker band, most easily seen in 
solid fills (such as light purple or gray).

Likely causes

● Bidirectional or color misalignment. See Printhead alignment on page 251.

● Coalescence, due to an excess of ink. Change to more passes with lower ink density. See Print mode 
on page 250.

● Inaccurate substrate advance (under-advancing). See Substrate advance on page 251.

● Insufficient drying. See Substrate settings on page 251.

Aeroworms

Aeroworms consist of thin bands with a higher density than the surrounding area. They are about 6 cm long and 
have a horizontal tendency, but they curve like worms. They are not continuous across the substrate, and seem 
to appear at random.

Likely causes

● Print mode: Increase the number of passes or reduce the ink density. See Print mode on page 250.

● Check that the aerosol filters are not saturated or broken. See Replace the aerosol filters on page 87.

Vertical banding
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Likely causes

● Misalignment can cause vertical microbanding. See Printhead alignment on page 251.

● If suction is too high, the substrate can be deformed by the platen. Decrease the vacuum setting. See 
Substrate settings on page 251.

Color

Misalignment

Colors appear misaligned. Typically, lines and text are most affected by this issue.

Likely causes

● Misalignment between colors. See Printhead alignment on page 251.

Accuracy

Ideally, the colors that you see on the screen should match the colors on the print. In practice, you may find that 
the colors are not sufficiently accurate.

Likely causes

● Color calibration provides consistent colors, but consistent colors are not necessarily accurate. However, if 
the combination of substrate and printheads has not been calibrated recently (or ever), that is a possible 
source of color inaccuracy. You can eliminate the possibility by performing a color calibration. See Color 
calibration on page 101.

● If you are using the wrong ICC profile, your colors are likely to be inaccurate. Check which profile you are 
using. If necessary, you can make your own ICC profile for the printer, printheads, print modes, and 
substrate that you are using. See Print mode on page 250 and Substrate settings on page 251.

● Ink density affects color saturation. If the color saturation of your print seems wrong, try changing the ink 
density in the substrate preset; you may need to change the number of passes at the same time. See 
Substrate settings on page 251.

Grain

The print shows a higher level of grain than expected, either throughout the print or in some specific areas. The 
examples below show the typical grainy morphology in textile and paper samples.
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Textile Paper

Likely causes

● Bidirectional or color misalignment. See Printhead alignment on page 251.

● Inaccurate substrate advance. See Substrate advance on page 251.

● Coalescence due to insufficient drying:

– Change to more passes with lower ink density. See Print mode on page 250.

– Insufficient drying. See Substrate settings on page 251.

● If you see patches of high grain in some local areas of the print, this could be caused by wrinkles in the 
substrate. See There are wrinkles and ink smears on the substrate on page 244.

Bleeding

Sometimes a small color migration may be observed at the border between different colors (bleeding). It may 
also happen at the border between a color and blank substrate (no ink), reducing the sharpness of the border.
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Likely causes

● Change to more passes with lower ink density. See Print mode on page 250.

● Insufficient drying. See Substrate settings on page 251.

Edge roughness, text quality

The edges of objects may appear rough or blurred; this is especially noticeable in text. Examples of edge 
roughness in textile and paper samples are displayed below.

Textile Paper

Likely causes

● Change to more passes with lower ink density. See Print mode on page 250.

● Insufficient drying. See Substrate settings on page 251.

● Bidirectional misalignment. See Printhead alignment on page 251.

● Inaccurate substrate advance. See Substrate advance on page 251.

Ink migration

The ink does not completely dry when printing direct-to-fabric applications. When rolling the substrate after 
printing, ink is transferred to the wrong side of the printed substrate.

Likely causes

● Insufficient drying. See Substrate settings on page 251.

● Change to more passes with lower ink density. See Print mode on page 250.
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15 Troubleshoot ink cartridge and printhead 
issues

● Ink cartridges

● Printheads

● Printhead cleaning roll errors
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Ink cartridges

Cannot insert an ink cartridge

1. Check that the cartridge (type and capacity) is the correct one for the printer. See http://www.hp.com for 
the latest information on printer supplies.

2. Use the correct procedure to change ink cartridges, through the Internal Print Server. See Remove an ink 
cartridge on page 78.

3. Check that there is no obstruction in the ink cartridge connector.

4. Check that the ink cartridge is of the correct color. A connector will refuse to connect to a cartridge of the 
wrong color.

5. Check that the ink cartridge is correctly oriented (compare with the others).

The Internal Print Server does not recognize an ink cartridge

1. Ensure that you have inserted the cartridge correctly and fully. You should hear a click.

2. Ensure that the tabs on each side of the cartridge connector are opened but in place, showing a successful 
connection.

3. If the problem persists, check the ink cartridge connector (see Bent ink cartridge connector on page 258).

4. If the problem still persists, call your service representative (see HP Customer Care Centers on page 268).

The Internal Print Server recommends replacing or reseating an ink cartridge

1. Disconnect the ink cartridge.

2. Reconnect the ink cartridge and check the Internal Print Server message.

3. If the problem persists, check the ink cartridge connector (see Bent ink cartridge connector on page 258).

4. If the problem persists, insert a new ink cartridge.

5. If the problem still persists, call your service representative (see HP Customer Care Centers on page 268).

Bent ink cartridge connector

You may find that the ink cartridge connectors have become bent while the cartridge was disconnected (see 
Remove an ink cartridge on page 78). This means that they cannot connect properly, and you will see a reseat 
message.

To correct this problem, use pliers to straighten the connectors so that they will fit into their slots.

Printheads

Cannot insert a printhead

1. Check that you are inserting the printhead into the correct slot.

2. Use the correct procedure to change printheads, through the Internal Print Server. See Remove a printhead 
on page 80 and Insert a printhead on page 82.
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3. Check that there is no obstruction in the printhead slot.

4. Check that the printhead is correctly oriented (compare with the others).

The Internal Print Server recommends replacing or reseating a printhead

General recommendations

1. Remove the printhead.

2. Reinsert the printhead into the carriage and check the Internal Print Server message.

3. If the problem persists, check the printhead contacts for dirt or aerosol and clean them if necessary. See 
Clean the printhead contacts on page 207.

4. Find more troubleshooting information in the following sections, Problem due to overheating on page 259
and Problem due to the primer system on page 259.

5. If the problem persists, insert a new printhead.

6. If no printhead works in that slot, call your service representative (see HP Customer Care Centers 
on page 268).

Problem due to overheating

A printhead may overheat for several reasons:

● The room temperature may be too high.

● The printhead may be suffering from blocked nozzles. You may be able to cure this problem by cleaning 
the printheads (see Check and clean the printheads on page 84).

● The printhead may be faulty, in which case it should be replaced.

Problem due to the primer system

Primers are important to the printheads’ nozzle health. When there is a problem with a primer, the Internal Print 
Server displays the following messages.

During a printhead replacement

● A reseat message for a particular printhead

● A printhead replacement incomplete message

● A numerical error code starting with 46 (46.0X.0Y:ZZ)

During a printhead servicing routine

● A reseat message for a particular printhead

● A numerical error code starting with 46 (46.0X.0Y:ZZ)

The message 46.05.0Y:06 – Primer 0Y leakage detected indicates that one of the primer systems leaks. The 
number 0Y, where Y ranges from 1 to 7, indicates which primer is leaking.

You are recommended to:

● Run the primer diagnostic test from the Print Care window to confirm the cause of the error.

ENWW Printheads 259



● Reseat the printhead. Make sure to push the primer into position before securing the latch. While running 
the test, you will already have done it at least once.

● Check that the O-rings in the primer ports are not broken or damaged. Replace the primer if any O-ring is 
missing or dented.

● Replace the primer. See Replace a primer and latch on page 216.

● Grease the printhead primers. See Grease the printhead primers on page 181.

If none of these actions resolve the problem, call your service representative.

If you see the message 46.01.0Y:YY, run the primer diagnostic test from the Print Care window to confirm the 
cause of the error.

If the test instructs you to replace the primer, replace it. See Replace a primer and latch on page 216. Otherwise, 
call your service representative with the test results at hand.

Printhead health troubleshooting

There are two diagnostics to check the status of the printheads: the printhead status plot and the drop detector 
diagnostics in Print Care. Always use both, as they provide complementary information.

Printhead status plot

To print the printhead status plot, go to the Internal Print Server, click Printer > Printhead cleaning and click the 
Print button.
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The following image is printed.

▲ The image below shows plainly which nozzles in each printhead are printing and not printing.

For reference, each one of the 5 areas (square in the picture and 1 to 5) of each color corresponds to 
approximately 1000 nozzles.

Drop-detector diagnostics

Execute the drop-detector diagnostics from the Print Care window. This will identify blocked nozzles in each 
printhead.

Decision table

The following table summarizes the data that can be seen in each diagnostic, the possible causes, and the 
decisions.

Mid-tones (section 1) Nozzle health (section 2) Drop detector Possible cause Action

No banding < 300 blocked (all colors) < 300 blocked (all colors) Other Continue banding 
troubleshooting.

Banding in all colors < 300 blocked (all colors) < 300 blocked (all colors) Substrate advance, or 
other

Check the substrate-
advance sensor.

Continue banding 
troubleshooting.
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Mid-tones (section 1) Nozzle health (section 2) Drop detector Possible cause Action

Banding in one color < 300 blocked (that color) < 300 blocked (that color) Other Continue banding 
troubleshooting.

> 300 blocked > 300 blocked Printhead failure Hard-clean the 
printhead, twice if 
necessary.

Replace the printhead.

N/A < 300 blocked (at least 
one color)

> 300 blocked (at least 
one color)

Drop detection failure Call your service 
representative.

Hard clean

To perform a hard cleaning routine, go to the Internal Print Server, click Printer > Printhead cleaning, select the 
printhead(s) to clean and click the Hard clean button.

Sometimes, when the printhead is quite damaged, running the hard-clean routine twice helps to recover its 
performance.

New printhead is rejected

If the printer will not accept a new printhead, try the following steps in sequence:

1. Ensure that the printhead was correctly stored in its orange cap.

2. Ensure that the electrical contacts are clean.

3. Run the primer system diagnostic.

4. Assume that the printhead is faulty, and try another one.

5. If no printhead works in that slot, call your service representative.
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Automatic printhead alignment fails

Automatic printhead alignment may fail occasionally. You may see the alert Automatic Printhead Alignment 
cancelled because of scanning errors, which can be caused by different problems:

● The scans of the printed blocks cannot be performed reliably on the current substrate. The scans of the 
patterns maybe unreliable or impossible on substrates that are non-white, transparent, or translucent, or 
have a very rough or punched surface. For these substrates, automatic printhead alignment using the built-
in line sensor may not be possible.

● Some patterns of the automatic printhead alignment plot are defective due to:

– Stains or printhead crash marks on the substrate that can be easily seen by visual inspection of the 
three blocks in the plot. Make sure the substrate has no stains before running automatic printhead 
alignment.

– Printhead crash marks may occur when the substrate is wrinkled. See There are wrinkles and ink 
smears on the substrate on page 244

– Generally poor print quality due to clogged nozzles. See Check and clean the printheads on page 84.

● Either the built-in line sensor is not working properly or is not well calibrated. Automatic printhead 
alignment uses the black colorant as reference to align the rest of colorants, therefore the line sensor has a 
specific calibration that saves the proper distance between the line sensor and the black printhead (see 
Print Care diagnostics on page 111). If the LsToK (line sensor to black) calibration is not done, it can be seen 
by a visual inspection of the plot. In this case, the black patch is overlapping the spitbars of the first block of 
patterns, shown here:

If the problem persists, call your service representative (see HP Customer Care Centers on page 268)

Printhead cleaning roll errors
You should not touch the printhead cleaning roll except when you need to replace it.

When the printhead cleaning roll reaches its end, it should be replaced. Always do this by following the Internal 
Print Server wizard. See Replace the printhead cleaning roll, filters, and spittoon on page 85.

Any handling of the roll may prevent the printer from keeping track of roll usage, in which case you may see 
spurious error messages, and a printing job may be cancelled unnecessarily.
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16 Troubleshoot other issues

● The printer does not start

● The printer does not print

● The printer cannot be restarted from the Internal Print Server

● The printer seems slow

● Request to reinitialize the carriage

● The Internal Print Server cannot detect the printer

● Print Care spontaneously restarts

● Color calibration fails
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The printer does not start
1. Check that the power supply to the printer is working.

2. Check that the main power switch and PC switch are both on.

3. Check that the main power lights are on and the circuit breakers are all up.

4. Check that the IPS is working with no alerts showing.

5. Try turning the main switch off (not the PC switch) and turning it on again after 10 seconds.

6. If any of the circuit breakers trip (from up to down) while the printer is operating, switch off the printer and 
call your service representative (see HP Customer Care Centers on page 268).

The printer does not print
If all is in order (substrate loaded, all ink components installed, and no file errors), there are still reasons why a 
file you have sent from your computer may not start printing when expected:

● You may have an electrical power problem. If there is no activity at all from the printer, nor from its built-in 
computer, check that the power cables are connected correctly and that there is power available at the 
source.

● You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or 
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this 
case, turn off the printer, wait until the electromagnetic environment has returned to normal, then turn it 
on again. If you still experience problems, call your service representative (see HP Customer Care Centers 
on page 268).

The printer cannot be restarted from the Internal Print Server
In rare cases, the printer may be unresponsive to the Shutdown and Wake up buttons. If this happens, turn off 
the main switch, then turn it on again after 10 seconds and restart the built-in computer.

The printer seems slow
You may experience a temporary delay while the printer's drying module is warming up.

In some circumstances, the printer will deliberately print more slowly than usual to prevent the printheads from 
overheating. There are several possible reasons why a printhead may start to overheat:

● The room temperature is too high.

● The printhead is suffering from blocked nozzles (see Check and clean the printheads on page 84).

● The printhead is faulty and should be replaced.

Request to reinitialize the carriage
In some cases you may be asked to reinitialize the carriage. This operation restarts some mechanical 
subsystems, avoiding the need to restart the whole printer.
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The Internal Print Server cannot detect the printer
If the Internal Print Server cannot establish communication with the printer, without apparent reason of after 
modifying Windows properties, follow these steps:

1. Use the Wake up button in the Tools menu to try to reactivate the printer.

2. Turn off the printer’s main switch, then turn it on again after 10 seconds and restart the built-in computer.

3. Check the cable connecting the built-in computer to the printer.

4. Check that the Internal Print Server is correctly set up.

5. Contact your service representative.

Print Care spontaneously restarts
The Print Care software may restart itself when it detects that the printer’s firmware or the Internal Print Server 
or some of their components have been updated, so this can happen from time to time.

Color calibration fails
Automatic color calibration may fail occasionally. You may see the alert Color calibration cancelled because of 
scanning errors, which can be caused by various different problems:

● Reflective color measurements of the printed target cannot be performed reliably on the current substrate. 
Reflective color measurement can be unreliable or impossible on substrates that are non-white, 
transparent or translucent, very glossy, or have a very rough or punched surface. For these substrates, 
automated color calibration using the embedded spectrophotometer may not be possible.

● Some of the color measurements of the color calibration test chart are defective due to:

– Stains or printhead crash marks on the substrate, that can be easily seen by visual inspection of the 
printed chart. Make sure the substrate has no stains before running color calibration. Printhead crash 
marks may occur when the substrate is wrinkled. See There are wrinkles and ink smears on the 
substrate on page 244.

– Wrinkles or bubbles in the substrate, even when there has been no printhead crash.

– Generally poor print quality (such as banding). See Troubleshoot print-quality issues on page 249.

● Either the embedded spectrophotometer or the line sensor is not working properly. If the problem persists, 
call your service representative (see HP Customer Care Centers on page 268).
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17 When you need help

HP Support is available, use the Remote Support HP option, in the IPS Help menu to connect. Call your remote 
support assistant and follow his instructions. Enter the 6 digit code when provided by the operator to allow 
remote connection: Webcam streaming is now possible. The call can include chat, remote desktop access, and 
the sharing of files, images, and video.

NOTE: Remote support may not be available if you are not directly supported by HP or if you have not accepted 
the Data Transfer Agreement. To enable HP Support, go to the Internal Print Server, click Tools > Preferences > 
Remote assistance, and ensure that the Enable Remote Assistance checkbox is ticked.

HP Proactive Support
HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and 
resolving printer issues before they become problems for you. HP's Proactive Support tool is designed to help 
businesses of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of your 
printing environment—with a clear focus on maximizing the value of your investment, increasing printer uptime 
and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems before 
they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and firmware 
updates.
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You can enable Proactive Support in the Internal Print Server by clicking Tools > Proactive Support, where you 
can specify the frequency of connections between your computer and HP's Web server, and the frequency of 
diagnostic checks. You can also choose to run the diagnostic checks at any time.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem and 
recommend a solution. In some cases, the solution may be applied automatically; in other cases, you may be 
asked to perform some procedure to solve the problem.

HP Customer Care
HP Customer Care offers award-winning support to ensure you get the most from your printer, providing 
comprehensive, proven support expertise and new technologies to give you unique end-to-end support. 
Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, 
phone and Web support, software updates and self-maintenance services. To find out more about HP Customer 
Care, visit us at:

http://www.hp.com/go/graphic-arts/

or call us on the telephone (see HP Customer Care Centers on page 268). To register your warranty:

http://register.hp.com/

HP Customer Care Centers

Help is available to you by telephone. For the right telephone numbers in your location, see 
http://www.hp.com/go/StitchS1000126in/support.

What to do before you call

● Review the troubleshooting suggestions in this guide.

● Review your RIP's documentation, if relevant.

● Ensure that you have the following information available:

– The printer you are using: the product number and the serial number, found on the label on the door 
of the electrical compartment

– If there is an error code in the Internal Print Server window, note it down; see Printer messages 
on page 274

– The printer's Service ID

– The RIP you are using, and its version number

– The software application you are using, and its version number

– If you have a problem directly related to an ink supply component (printhead, ink cartridge), take note 
of the product part number and warranty end date.

– The text displayed by the Internal Print Server when you click Help > About

Service information
The printer can produce on request a list of many aspects of its current status, some of which may be useful to a 
service engineer trying to fix a problem. There are two different ways to request this list:
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● In the Internal Print Server, click Information > Service information.

● From any computer with Internet access, enter the URL of your printer into a Web browser, followed 
by /hp/device/webAccess/allServicePlot.htm. For instance, if the URL of your printer is 
http://123.123.123.123, enter http://123.123.123.123/hp/device/webAccess/
allServicePlot.htm.

You can request the whole list, which takes a significant time to generate; or you can request specific parts of it. 
If in doubt, you are recommended to request the whole list (click All pages).

If you need to send the list by e-mail, you can save the page as a file from your Web browser, and later send the 
file.
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18 Printer specifications

● Functional specifications

● Physical specifications

● Memory specifications for the Internal Print Server computer

● Power specifications

● Air supply requirements (pneumatic spindle)

● Ecological specifications

● Environmental specifications

● Acoustic specifications
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Functional specifications

Ink supplies

Printheads Cyan and black, yellow and magenta

Ink cartridges Cyan, magenta, yellow, black

Substrate sizes

Minimum Maximum

Roll width 635 mm (25 in) 3.20 m (126 in)

Roll diameter 80 mm (3.15 in)

(core diameter)

350 mm (13.8 in)

Roll weight 300 kg (661 lb)

NOTE: Narrow substrates can be damaged during printing if they are very weak.

Substrate stretchability

Knitted fabric Woven fabric

Winding direction 5% 5%

Cross-winding direction 10% 10%

Diagonal winding 20% 10%

Passes, resolutions, and speeds

Passes Ink density

Resolution (ppi) Printing speed (m²/h) Printing speed (ft²/h)

Rendering Printing 3.2 m roll 126 inch roll

1 ≤ 30% 300 × 300 600 × 1200 390 4197

2 ≤ 50% 300 × 300 220 2368

3 ≤ 70% 300 × 300 160 1722

4 ≤ 100% 300 × 300 130 1400

6 ≤ 150% 300 × 300 100 1076

Physical specifications

Weight 1300 kg (2866 lb)

Width 5.74 m (226 in)
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Depth 1.38 m (54.3 in)

Height 1.67 m (65.7 in)

Memory specifications for the Internal Print Server computer

Memory (DRAM) supplied 8 GB

Hard disk 500 GB

Power specifications
The drying components are powered with a three-phase line that requires a power distribution unit (PDU).

Mains power, input rated current  

3-phase (line-to-line voltage)1 200–240 V AC, 50/60 Hz, 32 A max

3-phase (line-to-line voltage)1 380–415 V AC, 50/60Hz, 23 A max

Input voltage tolerance2 ±10%

PC power (optional), input rated current  

1-phase1 100–127 V AC, 50/60Hz, 10 max

1-phase1 200–240 V AC, 50/60Hz, 10 max

Input voltage tolerance2 ±10%

1 Site voltage must be within the specified range.
2 HP printers are tested to withstand ±10% input voltage fluctuations, and disturbances such as surge transients, voltage sag, voltage 

dropout, and so on. Contact your service representative if you would like more information on this subject.

Air supply requirements (pneumatic spindle)

Air pressure supply

The pneumatic spindle requires an air compressor or a pressurized air line, not supplied with the printer.

TIP: You are recommended to use a pressure gauge that indicates the pressure in bars.

Air pressure 5.5 bar (80 psi)

Minimum airflow Recommendation: 30 l/min

Lubricator Not recommended

Air filter (recommended) Recommendation: 5 µm, auto-drain, 99.97% coalescing efficiency

Regulator (required) Regulator with pressure gauge
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Pneumatic connector

The printer comes with an air gun that you must attach to your air supply. In order to connect your air supply to 
the air gun, you must meet the following requirements:

● 9.84 mm (0.25 in) female connector, BSP or NPT thread

● Tape to secure the connection and prevent air leaks

Ecological specifications
For the up-to-date ecological specifications of your printer, go to http://www.hp.com/ and search for “ecological 
specifications”.

Environmental specifications

 Temperature range Humidity range Temperature gradient

Operating for optimal print 
quality

20 to 25°C (68 to 77°F) 30 to 60% relative humidity 10°C/h (18°F/h) or less

Operating for standard printing 15 to 30°C (59 to 86°F) 20 to 70% relative humidity 10°C/h (18°F/h) or less

Not operating, in transport or 
storage, ink in tubes

5 to 35°C (41 to 95°F) 90% relative humidity at 55°C 
(131°F)

10°C/h (18°F/h) or less

Not operating, in transport or 
storage, no ink in tubes *

–10 to 55°C (26 to 131°F) 90% relative humidity at 55°C 
(131°F)

10°C/h (18°F/h) or less

* If the printer is going to be kept at a temperature of less than 5°C, call your service representative to empty the 
ink from the tubes.

Maximum operating altitude: 3000 m (10000 ft)

The printer should not be exposed to direct sunlight or any other strong light source, and it should not be used in 
a dusty environment.

Acoustic specifications
Maximum sound pressure levels at bystander position according to ISO 11202:

Idle sound pressure level at bystander position 58 dB(A)

Operating sound pressure level at bystander position 68 dB(A)

ENWW Ecological specifications 273

http://www.hp.com/


A Printer messages

Occasionally you may see messages such as the following in the Internal Print Server window.

There are two types: text messages, which are more informative, and messages containing numerical codes, 
which mean that the printer has detected a problem or malfunction.

When one of these messages appears, follow any instructions provided by the printer, and consult the tables 
below. If you feel in doubt about the correct response, or if you have followed the recommendation but the 
problem persists, call your service representative. See HP Customer Care Centers on page 268.

Text messages

Message Recommendation

{Color} cartridge has expired You are advised to replace the ink cartridge. See Remove an ink 
cartridge on page 78.

{Color} cartridge is altered You are advised to replace the ink cartridge. See Remove an ink 
cartridge on page 78.

{Color} cartridge is low on inkIt is recommended to use the exhaust 
system independently on the application. However, for specific 
applications where the ink collector is needed, the connection of the 
exhaust system is mandatory. In addition, HP recommends to 
conduct the exhaust air outside of the room.

Be ready to replace the ink cartridge soon.

{Color} cartridge is missing Install the correct ink cartridge. See Insert an ink cartridge 
on page 78.

{Color} cartridge is non-HP ink You are recommended to install an HP ink cartridge for best 
performance.

{Color} cartridge is out of ink Replace the ink cartridge. See Remove an ink cartridge on page 78.

{Color} printhead is missing Install the correct printhead. See Insert a printhead on page 82.

{Color} printhead out of warranty The printhead’s warranty has ended, because of the length of time 
it has been in operation, because of the volume of ink used, or 
because non-HP ink has been used in the system. See the limited 
warranty document.

An error has occurred in printhead detection Remove the printhead, clean any ink from the electrical connectors 
on the printhead (do not try to clean the nozzles), and reinsert the 
printhead. See The Internal Print Server recommends replacing or 
reseating a printhead on page 259.

Checking file system After a dirty power off, the printer performs a file system check, 
which will take some minutes.

Checking printer The printer is completing checks and cool-down cycle after finishing 
a job.
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Text messages (continued)

Message Recommendation

Clean drop detector spittoon You are advised to clean the ink deposits.

Cleaner roll jam. Go to the Internal Print Server and select the Ink System menu, 
then Check cleaner roll. Pull out the printhead cleaning roll 
assembly, raise the pinchwheels, wind the roll forward manually, 
then lower the pinchwheels and push the assembly back into the 
printer.

Color calibration cancelled because of scanning errors The color calibration chart could not be scanned successfully with 
the current substrate. See Color calibration fails on page 266.

FW upgrade post actions The firmware update is being performed.

Initializing The Internal Print Server is connecting to the printer.

Initializing, please wait The Internal Print Server is starting the printer.

Ink drying The printer is drying the last passes of a job after printing it.

Ink system not ready to print Wait a while. If the printer does not recover, restart it.

Job canceled due to lack of data received from the IPS If the problem persists, check the configuration of the Internal Print 
Server computer.

Line sensor calib. error: substrate too small Load a larger substrate.

Low cleaner roll Be ready to replace the printhead cleaning roll soon.

Lower lever Lower the substrate pressure handles.

Maintenance #N advised. Please contact HP You are advised to contact your service representative. See 
HP Customer Care Centers on page 268.

No substrate loaded Load substrate.

Offline The printer is shut down or not detected.

Please close safety sensor An open safety circuit has been detected, and should be closed in 
order to continue working.

Please turn emergency stop buttons to release them. An emergency button has been pressed, and must be released to 
continue working.

Preparing to print The printer is performing checks and warm-up prior to printing.

Printer cannot carry on printing Check that the three-phase power supply is working and that the 
ambient temperature is within the normal range. This problem can 
also be caused by holes in the substrate, by reflective or 
transparent substrates, or by a dirty or faulty temperature sensor.

Printer cannot cool down If the ambient temperature is within the normal range, this problem 
may be caused by removing the substrate too quickly after printing. 
Try leaving the substrate in the printer until temperatures settle 
down after printing.

Printer cannot warm up Check that the three-phase power supply is working. This problem 
can also be caused by holes in the substrate, by reflective or 
transparent substrates, or by a dirty or faulty temperature sensor.

Printheads not aligned Align the printheads. See Align the printheads on page 97.

Printhead replacement incomplete The printhead replacement process was unsuccessful. See The 
Internal Print Server recommends replacing or reseating a 
printhead on page 259.
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Text messages (continued)

Message Recommendation

Printing The printer is printing.

Ready The printer is ready to receive and print a job.

Remove {color} printhead Remove the printhead. See Remove a printhead on page 80.

Replace {color} cartridge Replace the ink cartridge. See The Internal Print Server 
recommends replacing or reseating an ink cartridge on page 258.

Replace {color} printhead Replace the printhead. See The Internal Print Server recommends 
replacing or reseating a printhead on page 259.

Replace aerosol filter You are advised to replace both aerosol filters. See Replace the 
aerosol filters on page 87.

Reseat {color} cartridge Reseat the ink cartridge. See The Internal Print Server recommends 
replacing or reseating an ink cartridge on page 258.

Reseat {color} printhead Reseat the printhead. See The Internal Print Server recommends 
replacing or reseating a printhead on page 259.

Select substrate name in the IPS Select the name of the loaded substrate in the Internal Print Server.

Starting up The printer is being detected while starting up.

Substrate jam: remove substrate See The substrate has jammed on page 241.

Substrate may be detached from the rear spindle or slippage 
detected. Substrate will be unloaded.

See The substrate is not attached to the core and/or spindle 
on page 242.

System error The printer has a system error. In the alert window, you should see 
the numerical code of the system error.

System in sleep mode The printer is in sleep mode.

The front cover is open. Close the front cover to continue printing. If 
the problem persists, run a diagnostic to identify the issue.

Proceed as described in the message.

The loading table is not closed. Close the loading table to continue 
printing. If the problem persists, run a diagnostic to identify the 
issue.

Proceed as described in the message.

The main window is open. Close the window to continue printing. If 
the problem persists, run a diagnostic to identify the issue.

Proceed as described in the message.

Very low cleaner roll Be ready to replace the printhead cleaning roll very soon.

Visually check printer for readiness, then press the blinking rearm 
button to provide full power.

Press the blue, blinking button to finish the printer’s start-up 
procedure.

Numerical error codes

Error code Recommendation

10.04.XX:YY Problem with e-cabinet fuses. The message in the IPS will indicate which fuse is causing the issue in 
order to replace it. Diagnostic E-cabinet state can be used to confirm that the issue is solved.

10.06.09:40 The emergency stops and/or safety relay have been activated. Check that the emergency stops are not 
activated. If the problem persists, run a diagnostic to identify the issue.

22.02.0X:06 Intermediate tank broken bag detected. Proceed with the intermediate tank maintenance procedure 
(see the Print Care wizard: “Replace an intermediate tank”).
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Numerical error codes (continued)

Error code Recommendation

22.02.0X:07 Intermediate tank end of life reached. Proceed with the intermediate tank maintenance procedure (see 
the Print Care wizard: “Replace an intermediate tank”).

22.02.01:74 Intermediate tank empty. Proceed with the intermediate tank maintenance procedure (see the Print 
Care wizard: “Replace an intermediate tank”). If during the replacement you detect that there is still ink 
in the replaced Intermediate tank, call your support representative.

46.05.0X:06 Primer X leakage. Reset primer latch and/or check o-rings. If problem persists, call your support 
representative.

47.01.06:52 Printhead cleaning roll pinch unlocked. Ensure that the pinch system of the printhead cleaning roll 
assembly is properly closed, and that there is no slippage between the core of the printhead cleaning 
roller and its motor.

58.02.00:02 Spectrophotometer shutter door open/close check fail. Run the Color sensor check diagnostic and 
check at the IDS side of the printer that the shutter is opening and closing properly. If the door is 
opening and closing but the printer does not detect it, clean the spectrophotometer. If the door is not 
opening and closing, install a new shutter mechanism (see Replace the spectrophotometer shutter 
on page 237). If the problem persists, call your support representative.

58.03.00:84 Spectrophotometer calibration failure. Run the Color sensor check diagnostic. If there is an issue 
related to the spectrophotometer shutter, replace it (see Replace the spectrophotometer shutter 
on page 237). Otherwise clean the spectrophotometer. If the problem persists, call your support 
representative.

86.01.00:01 Carriage movement failure. Ensure that maintenance routines are up to date, then perform Reinitialize 
carriage from the Internal Print Server. Also perform the carriage-rail cleaning process (see Clean and 
lubricate the scan axis and mechanical transmissions on page 176).

NOTE: The above table includes the most significant numerical codes. If you receive an error code that is not in 
the table, follow the instructions in the message.
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B Summary of common sublimation problems

This is a table of common sublimation problems and the parameters that can be changed in order to solve the 
problem. Some possible side-effects are also shown. For a more detailed treatment of any particular problem, 
see the relevant chapter in this guide.

Problem Symptom Cause Solution

Ghosting A faint image on a printed sheet in a 
place not intended

Motion of paper during sublimation Increase pressure or apply more 
tension to the paper.

Yellowness Textile becomes yellowish Temperature too high Use lower temperature for this 
material.

Stickiness Support paper or transfer paper 
stuck over the textile

Coating of textile and paper not 
compatible

Use correct paper and textile 
configuration.

Worming Vertical marks with lower gamut or 
white marks

Wrinkles on transfer paper, textile, 
or support paper

Ensure good positioning of paper 
and textile, apply correct tension. 
Use sticky paper.

Image deformation Image smaller than expected Temperature shrinkage Calculate shrinkage and print larger 
image.

Bleed through Side-to-side color differences Too low residential time or 
temperature for this material

Improve calender condition, raise 
residential time, and increase 
temperature.

Pinholes White point on image Dust over paper or textile Ensure clean environment.

Cloudiness Text quality with smaller definition Residential time too high Increase pressure or decrease 
residential time.

Low color saturation Image with less gamut than 
expected

Bad calendering conditions Look for best calender configuration 
for this material.

278 Appendix B   Summary of common sublimation problems ENWW



Glossary

Aerosol filter
The printheads produce many fine droplets of ink, most of which are placed accurately on the substrate. However, a small 
proportion of these droplets escape sideways; the two aerosol filters are placed on either side of the printhead carriage to 
intercept them.

Bleeding
A print-quality defect that occurs when the ink spreads on the substrate across areas of different colors.

Carriage beam
The beam supporting the printhead carriage as it moves back and forth across the printer.

Coalescence
A print-quality defect that looks like a higher level of whiter grain.

Cockle
A substrate condition in which it is not lying perfectly flat, but rises and falls slightly in shallow waves.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited 
color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same 
color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a 
particular set of RGB numbers results in different colors on different monitors.

CSR
Customer replaceable parts.

Drying
The heat applied in the printing zone removes water and fixes the image to the substrate.

ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of 
clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of 
the main hazards to the electronics products. Therefore, to prevent damage some precautions are needed when setting up 
the product, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device or render 
it unusable. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed 
grounded part of the product (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink 
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cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted 
area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low 
humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

I/O
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

Ink density
The relative amount of ink that is deposited on the substrate per unit of area.

Ink deposit
The printheads sometimes expel a small amount of ink into the ink deposits in order to check the status of each nozzle.

Ink limits
A means of specifying the maximum amount of ink of all colors in total that can be laid down onto a given substrate.

Ink restrictions
A means of specifying the maximum amount of each color of ink that can be laid down onto a given substrate.

IP address
A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers separated by dots.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the substrate.

Passes
The number of passes specifies how many times the printheads will print over the same area of substrate.

Platen
The flat surface within the printer over which the substrate passes while it is being printed on.

Printhead
A removable printer component that takes ink of a particular color or colors from the corresponding ink cartridge(s) and 
deposits it on the substrate, through a cluster of nozzles.

Printhead cleaning roll
A roll of absorbent material used to clean surplus ink from the printheads after each pass over the substrate.

Spindle
A rod that supports a roll of substrate while it is being used for printing.
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Substrate
A thin, flat material made to be printed on.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

Tension
Tension is applied at the input and the output side of the printer. It needs to be evenly distributed along the whole width of 
the substrate, thus substrate loading is a critical operation.

Vacuum pressure
The vacuum applied to the substrate in the printing zone helps to hold the substrate down on the print platen, keeping the 
distance to the printheads constant.
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Index

A
acoustic specifications 273
add a print job 65
aerosol extractor filters

replace 195
aerosol fan module

replace 220
aerosol filter

about 77
aerosol filters

clean 147
replace 87

air supply requirements 272
alerts

errors 26
alerts, warnings 26
automatic tracking 107

B
banding problems 107
broken bag 224

C
carriage

reinitialize 265
carriage beam position 63
carriage bottom

clean 152
carriage cooling fan

clean 166
carriage oil felts/wicks

replace 186
carriage rails

clean manually 211
caution 8
cleaning blade

replace 199
cleaning instructions, general 12
color calibration 101

color consistency 40
color consistency between printers

103
color emulation 103
color profile 105
components of printer 14
crop 70
Customer Care 268

D
delete a print job 70
diffuser

clean 183
disposal instructions 12
documentation 2
drive roller

clean 175
drop detector capping station

clean 154
drop-detector rods

clean 178
drop-detector strip

clean 185
dryer fan filter

clean left 167
clean right 158
replace left 193
replace right 192

drying fan resistor module
replace 233

drying fans
clean 183

E
e-box fan filter

clean 156
replace 190

e-cabinet fan filters
clean 160
replace 188

e-cabinet fuse
replace 224

ecological specifications 273
edge holders 43
electromagnetic disturbances 265
emergency stop buttons 11
environmental specifications 273
error messages 274

F
features of printer 2
firmware update 27
functional specifications 271

H
hard disk specification 272
HP Customer Care 268
HP Proactive Support 267

I
image composition 71
ink cartridge

about 76
bent connector 258
cannot insert 258
insert 78
maintain 80
not recognized 258
remove 78
reseat 258
specification 271
status 80

ink deposits
about 77

ink-collector ribs
clean 149
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intermediate tank
replace 224

intermediate tanks
replace 187

Internal Print Server
language 22
preferences 22
start 21
units of measurement 22
upgrade 27

introduction jdf 30

L
labels, warning 9
light

output platen 52
load substrate

cannot load 241
load substrate into printer 47
load substrate onto the spindle 45

M
maintenance kits 128
maintenance off/on 139
maintenance tools 131
maintenance with Print Care 136
maintenance without Print Care 137
mechanical transmissions

clean 176
memory specifications 272
move the printer 18
multiple exports

export 53

N
nesting 71

O
on-the-fly adjustment 57
output platen light 52

P
physical specifications 271
pinch clamp

replace 227
pinchwheel submodule

replace 214
pinchwheels

clean 175
porosity check 37
power specifications 272

prepare to print 42
primer latch

replace 216
print adjustment 57
Print Care restarts 266
print jobs 64
print queue 69
print zone

clean 143
print-quality problems

general 250
printer

check and clean 143
move 18
status beacon 19

printer cleaning kit 130
printer does not print 265
printer does not restart 265
printer does not start 265
printer maintenance kit 130
printer not detected 266
printer on/off 17

first time 17
printer software 16
printer status 26
printer status beacon 19
printer's main components 14
printer's main features 2
printhead

about 76
align 97
cannot insert 258
check and clean 84
insert 82
maintain 84
remove 80
reseat 259
specification 271

printhead alignment diagnostics 
plot 100

printhead alignment; fails 263
printhead cleaning roll

about 77
errors 263
replace 90

printhead cleaning waste bottle
empty 169

printhead contacts
clean 207

printhead primers
greese 181

printhead rejected 262
printing resolutions 271
printing speeds 271
Proactive Support 267

R
Raster Image Processor 16
rear scan-axis beam

clean 204
RIP 16

adding jobs from 65
roll-to-roll configuration 47
rotate a print job 69

S
safe mode 85
safety labels 9
safety precautions 3
sax chain

clean impelling dust 182
scan axis

check clean 213
scan axis, clean 176
scan-axis encoder

clean 178
service information print 268
service station cap

replace 194
slow printing 265
software 16
specifications

acoustic 273
air supply 272
ecological 273
environmental 273
functional 271
hard disk 272
ink supplies 271
memory 272
physical 271
power 272
printing resolutions 271
printing speeds 271
substrate size 271

spectophotometer
replace 237

spindle gear and end cap
replace 228
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spindle latch opens 243
spindle valve

replace 227
spittoon

about 77
replace 89

substrate
advance calibration 107
cannot load 241
configurations 41
create preset 55
detached from core 242
drops of ink 247
edit preset 56
ink marks 246
jammed 241
load into printer 47
load onto the spindle 45
maintain 39
new 55
not flat 242
online manager 60
physical marks 246
preset 53
remove preset 60
roll to roll 47
shrinkage 247
sizes (max and min) 271
skewed 244
sticks to platen 246
supported HP 38
supported types 37
telescoping 244
tips 39
unload 51
variable shrinkage 247
vibration noise 243
view information 51
wrinkles 244

substrate drive transmission, clean
169, 174

substrate edge holders 43
support services

HP Customer Care 268
HP Proactive Support 267

T
telephone support 268
thunderstorm 265

U
unload substrate 51

V
vapors extraction channel / output 

cover, clean 161

W
warning 8
warning labels 9
welcome to your printer 2
working jdf 30
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